# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>8</td>
</tr>
<tr>
<td>About Parallels Desktop</td>
<td>9</td>
</tr>
<tr>
<td>About This Guide</td>
<td>10</td>
</tr>
<tr>
<td>Organization of this Guide</td>
<td>11</td>
</tr>
<tr>
<td>Documentation Conventions</td>
<td>11</td>
</tr>
<tr>
<td>Getting Help</td>
<td>13</td>
</tr>
<tr>
<td>Feedback</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Virtual Machine Technology Basics</strong></td>
<td>14</td>
</tr>
<tr>
<td>Virtual Machine Technology Overview</td>
<td>14</td>
</tr>
<tr>
<td>Parallels Virtual Machine</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Installing Parallels Desktop</strong></td>
<td>17</td>
</tr>
<tr>
<td>System Requirements</td>
<td>17</td>
</tr>
<tr>
<td>Installing Parallels Desktop</td>
<td>18</td>
</tr>
<tr>
<td>Activating Parallels Desktop</td>
<td>20</td>
</tr>
<tr>
<td>Registering Parallels Desktop</td>
<td>22</td>
</tr>
<tr>
<td>Upgrading to Parallels Desktop 4</td>
<td>24</td>
</tr>
<tr>
<td>Updating Parallels Desktop</td>
<td>25</td>
</tr>
<tr>
<td>Automatic Updating</td>
<td>26</td>
</tr>
<tr>
<td>Manual Updating</td>
<td>27</td>
</tr>
<tr>
<td>Removing Parallels Desktop</td>
<td>28</td>
</tr>
<tr>
<td>Removing Parallels Desktop Without Installation Disc</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Principles of Working With Parallels Desktop</strong></td>
<td>30</td>
</tr>
<tr>
<td>Starting Parallels Desktop</td>
<td>30</td>
</tr>
<tr>
<td>The Welcome Window</td>
<td>31</td>
</tr>
<tr>
<td>New Virtual Machine Assistant</td>
<td>33</td>
</tr>
<tr>
<td>Interface Basics</td>
<td>33</td>
</tr>
<tr>
<td>Parallels Virtual Machines Dialog</td>
<td>34</td>
</tr>
<tr>
<td>Virtual Machine Window</td>
<td>36</td>
</tr>
<tr>
<td>Menus</td>
<td>39</td>
</tr>
<tr>
<td>Status Bar</td>
<td>39</td>
</tr>
<tr>
<td>Customizing Toolbar</td>
<td>41</td>
</tr>
<tr>
<td>Configuring Parallels Desktop Preferences</td>
<td>41</td>
</tr>
<tr>
<td>General Preferences</td>
<td>42</td>
</tr>
<tr>
<td>Keyboard and Mouse Preferences</td>
<td>43</td>
</tr>
<tr>
<td>Appearance Preferences</td>
<td>47</td>
</tr>
<tr>
<td>Memory Preferences</td>
<td>49</td>
</tr>
<tr>
<td>Network Preferences</td>
<td>50</td>
</tr>
<tr>
<td>USB Preferences</td>
<td>53</td>
</tr>
<tr>
<td>Speech Preferences</td>
<td>55</td>
</tr>
<tr>
<td>iPhone Preferences</td>
<td>57</td>
</tr>
<tr>
<td>Update Preferences</td>
<td>58</td>
</tr>
<tr>
<td>Feedback Preferences</td>
<td>59</td>
</tr>
</tbody>
</table>
Setting Up a Virtual Machine

Overview .......................................................... 61
Supported Guest Operating Systems ........................................ 64
Typical Configurations ................................................. 66
Creating a Virtual Machine .............................................. 67
  New Virtual Machine Assistant ............................... 68
  Default Installation Mode ...................................... 70
  Express Windows Installation ................................. 74
  Typical Installation Mode ...................................... 77
  Custom Installation Mode ....................................... 79
Adding an Existing Virtual Machine ................................. 84
Installing a Guest Operating System ............................... 85
Migrating Data to a New Virtual Machine ....................... 87
Installing Parallels Tools ............................................. 88
  Parallels Tools Overview ...................................... 89
  Installing Parallels Tools in a Windows guest OS ......... 92
  Installing Parallels Tools in a Linux guest OS .......... 94
  Installing Parallels Tools in Mac OS X ..................... 97
  Installing Parallels Tools in OS/2 and eComStation Guest OSs ................................. 98
  Updating Parallels Tools ...................................... 100
  Removing Parallels Tools ..................................... 102
Installing Applications .............................................. 103
  Parallels Tools Overview ...................................... 104
  Installing Parallels Tools in a Windows guest OS ......... 105
  Installing Parallels Tools in a Linux guest OS .......... 108
  Installing Parallels Tools in Mac OS X ..................... 109
  Installing Parallels Tools in OS/2 and eComStation Guest OSs ................................. 111
  Updating Parallels Tools ...................................... 112
  Removing Parallels Tools ..................................... 113
Working in a Virtual Machine .................................... 114
  Setting Up Parallels Internet Security ...................... 115
  Using Safe Mode ............................................... 116
  Using Keyboard Shortcuts in a Virtual Machine ........... 117
  Installing Applications in a Virtual Machine ............... 118
  Making Guest OS Screenshots .................................. 119
  Setting Up a Printer in Virtual Machine ..................... 120
  Sharing a Mac Printer ......................................... 121
  Setting Up a USB Printer ...................................... 122
  Setting Up a Printer via Bonjour ............................ 123
  Setting Up a Network Printer ................................. 124
Troubleshooting and Limitations

Getting Technical Support ................................................................. 262
Reporting a Problem to Parallels Team .................................................. 263
Checking the Build Number ................................................................. 264
Using the F8 Key in Windows Virtual Machines on Mac OS X .................. 265
Upgrading or Installing Parallels Tools in Text Mode in a Linux Guest OS........ 266
Installing the GCC package and kernel sources in Linux .......................... 267
Setting Up Shared Folders in Linux Virtual Machines ............................ 268
Configuring Network in Linux ............................................................. 269
Suspending a Boot Camp Virtual Machine ............................................. 270
Problems With Setting Up Network ....................................................... 270
Problems With Antivirus Software ....................................................... 271

Glossary

Index
Parallels Desktop® enables you to use the hardware resources of your Intel-based Mac more efficiently by sharing them between multiple virtual machines running on it.

This chapter provides general information about Parallels Desktop for Mac and this guide.

In This Chapter

- About Parallels Desktop................................................................. 9
- About This Guide........................................................................... 10
- Getting Help.................................................................................... 13
- Feedback ....................................................................................... 13
Parallels Desktop® is a virtualization solution that enables you to create virtual machines on Macintosh computers with Intel® processors (1.66 GHz and faster). You can install a Windows, Linux, Mac OS X, or another operating system in each of your virtual machines, and work with them and their applications side by side with your Mac OS X applications.

Built on Parallels’ award-winning hypervisor-based virtualization technology, Parallels Desktop enables you to:

- create powerful and easy to use virtual machines
- use 32-bit and 64-bit operating systems inside your virtual machines
- use Windows and Linux applications side by side with your Mac OS X applications, without need to restart your Mac
- coherently work with the files and applications of your Mac and virtual machine
- create Parallels virtual machines from physical computers and third-party virtual machines

To enhance your experience of running more than one operating system on your Macintosh computer, Parallels Desktop for Mac includes several utilities: Parallels Transporter® (p. 248), Parallels Explorer® (p. 250), Parallels Image Tool (p. 254), and Parallels Compressor® (p. 251).
About This Guide

This Guide is aimed at a wide range of users who want to use Parallels Desktop to create, configure and run Parallels virtual machines.

Abbreviations used in the text

In the present guide the following abbreviations are used:

- **OS** is used instead of *operating system* in long sentences where using it will not change the meaning of the sentence.
- **VM** is used instead of *virtual machine* in long sentences where using it will not change the meaning of the sentence.

Definitions

*Primary operating system* (primary OS): In this Guide, this term is used to refer to the operating system that controls the I/O devices of the computer and that is loaded when the physical computer is turned on, that is, Mac OS X.

*Guest operating system* (guest OS): The term is used to refer to an operating system that is installed in the virtual machine.

Help Usage Tips

Use the icons in the upper part of the help window to:

- go to the online documentation page
- watch an online video tutorial
- contact the Parallels support team

To print a help page, click on the Print icon 📨. If this doesn't work, right-click the Print icon and choose Print Frame.
Organization of this Guide

This guide is organized into the following chapters:

- **Introduction** (p. 8) (you are reading it now). Provides basic information about the product and this guide.
- **Installing Parallels Desktop** (p. 17). Provides instructions on product installation.
- **Principles of Working With Parallels Desktop** (p. 30). Provides basic information on how to work with Parallels Desktop.
- **Setting up a Virtual Machine** (p. 61). Provides instructions on creating a new virtual machine and adding an existing one.
- **Working in a Virtual Machine** (p. 104). Provides basic information on how to work with virtual machines.
- **Integrating Mac OS X and Your Virtual Machine** (p. 128). Provides information on how to enhance the integration between Mac OS X and your virtual machine.
- **Configuring the Virtual Machine** (p. 146). Provides information on how to change the virtual machine configuration.
- **Managing Virtual Machines** (p. 215). Provides basic information on how to manage your virtual machines.
- **Working With Snapshots** (p. 234). Provides information on how to make and use snapshots.
- **Using Parallels Add-ons** (p. 248). Provides information on how and when you can use Parallels Transporter, Parallels Explorer, Parallels Compressor, and Parallels Image Tool.
- **Troubleshooting and Limitations** (p. 262). Provides the solutions for some of the known issues.

Documentation Conventions

Before you start using this guide, it is important to understand the documentation conventions used in it.

The table below presents the existing formatting conventions.

<table>
<thead>
<tr>
<th>Formatting convention</th>
<th>Type of Information</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Bold</td>
<td>Items you must select, such as menu options, command buttons, or items in a list.</td>
<td>Go to the Resources tab.</td>
</tr>
<tr>
<td></td>
<td>Titles of chapters, sections, and subsections.</td>
<td>Read the Basic Administration chapter.</td>
</tr>
</tbody>
</table>
**Italics**  
Used to emphasize the importance of a point, to introduce a term or to designate a command line placeholder, which is to be replaced with a real name or value.

These are the so-called *EZ templates*.

To destroy a Container, type `vzctl destroy ctid`.

<table>
<thead>
<tr>
<th><strong>Monospace</strong></th>
<th>The names of commands, files, and directories.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preformatted</strong></td>
<td>On-screen computer output in your command-line sessions; source code in XML, C++, or other programming languages.</td>
</tr>
</tbody>
</table>

Use `vzctl start` to start a Container.

Saved parameters for Container 101

<table>
<thead>
<tr>
<th><strong>Monospace Bold</strong></th>
<th>What you type, as contrasted with on-screen computer output.</th>
</tr>
</thead>
</table>

`# rpm -V virtuozzo-release`

<table>
<thead>
<tr>
<th><strong>Key+Key</strong></th>
<th>Key combinations for which the user must press and hold down one key and then press another.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+P, Alt+F4</td>
<td></td>
</tr>
</tbody>
</table>

Besides the formatting conventions, you should also know about the document organization convention applied to Parallels documents: chapters in all guides are divided into sections, which, in their turn, are subdivided into subsections. For example, **About This Guide** is a section, and **Documentation Conventions** is a subsection.
Getting Help

Parallels Desktop offers several options for accessing necessary information:

- **Parallels Desktop Help.** This document contains extensive information about the product, its usage and troubleshooting. To open Parallels Desktop Help, choose **Parallels Desktop Help** from the Parallels Desktop **Help** menu.

- **Context-sensitive help.** You can open a help page for the active window by pressing F1.

- **Online documentation** (http://www.parallels.com/products/workstation/wst4_extreme_docs-en_US). The PDF documentation for Parallels Desktop and other Parallels products, such as Parallels Transporter, Parallels Image Tool, and Parallels Explorer. To open the online documentation page, choose **Online Documentation** from the Parallels Desktop **Help** menu.

- **Parallels Command Line Reference Guide.** This document contains information on using the `prlctl` command line utility designed to manage Parallels Desktop and its virtual machines from a terminal. To access the document, go to the Online documentation (http://www.parallels.com/products/workstation/wst4_extreme_docs-en_US) page on our website.

- **Parallels API references and the SDK programmer’s guide.** These guides are aimed at IT-professionals mainly and can be found on the Online documentation (http://www.parallels.com/products/workstation/wst4_extreme_docs-en_US) page on our website.

- **Parallels website** (http://www.parallels.com). Explore the Support web page that includes product help files and the FAQ section.

- **Parallels Knowledge Base** (http://kb.parallels.com/). This online resource comprizes valuable articles about using Parallels Desktop and other Parallels products.

Feedback

If you spot a typo in this guide, or if you have thought of a way to make this guide better, we would love to hear from you!

The ideal place for your comments and suggestions is the Parallels documentation feedback page (http://www.parallels.com/en/support/usersdoc/).
Virtual Machine Technology Basics

This chapter provides a brief description of Parallels virtual machines, their specifications, and the underlying technologies.

In This Chapter

Virtual Machine Technology Overview ................................................................................ 14
Parallels Virtual Machine ................................................................................................. 15

Virtual Machine Technology Overview

The Parallels Desktop software is based on the virtual machine technology that allows you to share the hardware resources of the physical computer between the primary operating system (the operating system installed on this physical computer) and multiple virtual machines running on this computer.

The virtual machine technology can be successfully used on computers that support the Intel virtualization technology (Intel VT-x). This technology allows Parallels Desktop to emulate virtual processors inside virtual machines.

Intel VT-x implemented in the architecture of the new Intel processors is specially developed for platforms running multiple operating systems. VT-x processors allow more precise emulation of virtual processors. To learn more about Intel virtualization technology, visit the Intel website.
# Parallels Virtual Machine

Taking the best from the virtual machine and Intel virtualization technologies, Parallels Desktop enables you to create virtual machines with a variety of virtual hardware devices.

A Parallels virtual machine works like a stand-alone computer with the following hardware:

<table>
<thead>
<tr>
<th>Component</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Up to 4-core Intel/AMD CPU (Intel Celeron or AMD Duron for legacy OS compatibility)</td>
</tr>
<tr>
<td>Motherboard</td>
<td>Intel i965 chipset based motherboard</td>
</tr>
<tr>
<td>RAM</td>
<td>Up to 8 GB of RAM</td>
</tr>
<tr>
<td>Video Adapter</td>
<td>VGA and SVGA with VESA 3.0 compatible Video Adapter</td>
</tr>
<tr>
<td>Video RAM</td>
<td>Up to 256 MB of Video RAM</td>
</tr>
<tr>
<td>Floppy Disk Drive</td>
<td>1.44 MB Floppy Disk Drive mapped to an image file or to a physical floppy drive.</td>
</tr>
<tr>
<td>IDE Devices</td>
<td>Up to 4 IDE devices</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>Hard Disk Drive mapped to an image file (up to 2 TB each)</td>
</tr>
<tr>
<td>CD/DVD-ROM Drive</td>
<td>CD/DVD-ROM drive mapped to a physical drive or to an image file</td>
</tr>
<tr>
<td>SCSI Devices</td>
<td>Up to 15 SCSI devices</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>Hard Disk Drive mapped to an image file (up to 2 TB each)</td>
</tr>
<tr>
<td>Generic SCSI Device</td>
<td>Generic SCSI device</td>
</tr>
<tr>
<td>Network Interfaces</td>
<td>Up to 16 Network interfaces: including Ethernet virtual network card compatible with RTL8029</td>
</tr>
<tr>
<td>Serial (COM) Ports</td>
<td>Up to 4 Serial (COM) ports, mapped to a socket or to an output file</td>
</tr>
<tr>
<td>Parallel (LPT) Ports</td>
<td>Up to 3 Parallel (LPT) ports, mapped to output file, to a real port, or to a printer</td>
</tr>
<tr>
<td>Sound Card</td>
<td>AC’97-compatible Sound Card, sound recording support</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Generic PC keyboard</td>
</tr>
<tr>
<td>Mouse</td>
<td>PS/2 wheel mouse</td>
</tr>
</tbody>
</table>
Each virtual machine is stored in Mac OS X as a bundle of files (.pvm) that contains the virtual machine configuration file (.pvs), the virtual hard disk file (.hdd), and other files of the virtual machine.

A virtual machine may have the following files:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pvm</td>
<td>A bundle that contains the virtual machine files.</td>
</tr>
<tr>
<td>.pvs</td>
<td>A virtual machine configuration file. It defines hardware and resources configuration of a virtual machine. The configuration file is generated when the virtual machine is created.</td>
</tr>
<tr>
<td>.sav</td>
<td>A file created when the virtual machine is suspended. It contains the state of the virtual machine and its applications for the moment the suspend was invoked.</td>
</tr>
<tr>
<td>.mem</td>
<td>A file containing memory dump for the suspended virtual machine. For a running virtual machine, it is a temporary virtual memory file.</td>
</tr>
<tr>
<td>.hdd</td>
<td>A bundle of files that represents a virtual hard disk of a Parallels virtual machine. When you create a virtual machine, you can create it with a new virtual hard disk or use an existing one.</td>
</tr>
<tr>
<td>.iso</td>
<td>An image file of a CD or DVD disc. Virtual machines treat ISO images as real CD/DVD discs.</td>
</tr>
<tr>
<td>.fdd</td>
<td>A floppy disk image file. Virtual machines treat FDD images as real diskettes. If you install a Windows guest OS in the Express Windows installation mode, Parallels Desktop creates the unattended.fdd floppy disk image file and places it to the virtual machine folder. The file is required for Windows Server 2003, Windows XP, and Windows Vista installation.</td>
</tr>
<tr>
<td>.txt</td>
<td>Output files for serial and parallel ports. The output .txt files are generated when a serial or parallel port connected to an output file is added to the virtual machine configuration.</td>
</tr>
</tbody>
</table>

For a virtual machine that has any of Windows OSs installed (starting from Windows 2000), the following subfolders are created automatically in the virtual machine folder:

- The Windows Applications folder. This folder contains aliases for the Windows applications installed in the virtual machine. Aliases are used for supporting the file extensions transparency.
- The Windows Disks folder. This folder contains aliases for the Windows disks available in the virtual machine.
CHAPTER 3

Installing Parallels Desktop

This chapter describes the system requirements and provides the information on how to install Parallels Desktop on your Macintosh computer and how to activate it.

In This Chapter

System Requirements ............................................................................................................ 17
Installing Parallels Desktop................................................................................................... 18
Activating Parallels Desktop................................................................................................. 20
Registering Parallels Desktop............................................................................................... 22
Upgrading to Parallels Desktop 4 ......................................................................................... 24
Updating Parallels Desktop................................................................................................... 25
Removing Parallels Desktop................................................................................................. 28

System Requirements

Before installing Parallels Desktop, make sure that your computer meets the hardware and software requirements listed below.

Hardware Requirements

- Any Macintosh computer with an Intel processor (1.66 GHz or greater). To run 64-bit operating systems in virtual machines, an Intel Core 2 or later processor is required.
- Minimum 1 GB of memory, 2 GB of memory is recommended.

Note: Your Mac must have enough memory to run Mac OS X and your Mac applications, plus the memory required for the virtual machine's operating system and the applications installed in it.

- About 300 MB of disk space on the boot volume for the program installation.
- About 15 GB of disk space for each virtual machine.

Software Requirements

- Mac OS X Leopard v10.5.2 or later
- Mac OS X Tiger v10.4.11 or later

To get information about your Mac OS X version, type of processor, and amount of memory, choose About This Mac from the Apple menu.
Installing Parallels Desktop

If you purchased Parallels Desktop from the Parallels online store, download the latest build from Parallels Download Center (http://www.parallels.com/en/download/). When the download is complete, open the Parallels Desktop DMG package file. To start the installation, double-click Install.

If you purchased a boxed copy of Parallels Desktop, insert the Parallels Desktop installation disk into the optical drive of your Mac. Open the Parallels Desktop DMG package and double-click Install Parallels Desktop.

1 Parallels Desktop will connect to the Parallels update server and check for available updates. If there is a newer version of Parallels Desktop available, you will be offered to install the most recent version of Parallels Desktop. If you do not want to install the most recent version, you may choose to install the version from the installation media.

- If you click Install current, Parallels Desktop will be installed from the installation media.
- If you click Download and install new version, the latest version of Parallels Desktop will be downloaded and installed on your Mac.

If there is no update available or your Mac is not connected to the internet, Parallels Desktop will be installed from the current installation source.

2 In the Welcome window, click Continue.

3 In the Important Information window, read the product Read Me file. Click Print to print the document or Save to save it for future reading. When finished, click Continue.
4 In the **Software License Agreement** window, carefully read the license agreement. We recommend to print the license agreement for your records using the **Print** button or to save it for future reading using the **Save** button. When you are ready, click **Continue**.

In the pop-up dialog, click **Agree** if you agree with the terms and conditions of the license agreement.

5 In the **Customer Experience Program** window, read about the Parallels Customer Experience Program and click **Continue**.

In the pop-up dialog, click **Yes** if you want to participate in the program. If you don't want to participate, click **No**.

**Note:** If you choose not to participate, you may join the program later using the **Feedback** pane (p. 59) of Parallels Desktop **Preferences**.

6 In the **Select a Destination** window, select the hard disk where to install Parallels Desktop. You can install Parallels Desktop only on the boot volume, that is the hard disk where Mac OS X is installed. Other disks, if any, are unavailable for selection. Click **Continue**.

**Note:** If you have only one volume on your Mac, this step is omitted.
7 Click Install to start the Parallels Desktop installation.
8 Enter your password when prompted and click OK.
9 The installation progress is shown in the Installing Parallels Desktop window.
10 The Installer informs you that the installation was successful. To complete the installation, click Close.

After the installation, you can launch Parallels Desktop from the Applications folder on your Mac. The Parallels Desktop add-ons like Parallels Transporter (p. 248), Parallels Explorer (p. 250), and Parallels Image Tool (p. 254) are available from the/Applications/Parallels/ folder.

Activating Parallels Desktop

To fully run Parallels Desktop, you should activate it with an activation key. If you purchased a boxed version of the program, you can find the activation key printed on the installation CD sleeve. If you purchased the program online, the activation key was sent to your e-mail. If you downloaded a copy of Parallels Desktop to evaluate it before buying, you can get a trial activation key valid for a certain period of time.

After you activate your copy of Parallels Desktop, you can run virtual machines, install operating systems and various applications in them.

If you upgraded Parallels Desktop to version 4 from the previous version, you need an upgrade activation key to activate Parallels Desktop 4. For detailed information, see Upgrading to Parallels Desktop 4 (p. 24).

Activating Your Copy of Parallels Desktop

To activate Parallels Desktop:

1 Choose Activate Product from the Help menu.
2 In the Activate Product dialog, specify your name and your company name in the Name and Organization fields (optional) and type the activation key into the Product Key field. Click OK when finished.
Now that your copy of Parallels Desktop is activated, you can create virtual machines, install operating systems in them, and work with the virtual machines' applications side by side with the applications of your Mac.

**Getting a Trial Activation Key**

After you download Parallels Desktop from Parallels Download Center and install it, follow the steps below:

1. Choose **Activate Product** from the **Help** menu.
2. In the **Activate Product** dialog, click the **free trial activation key** link.
3. In the **User Registration Form** dialog, specify your e-mail address and your name. The **Company name** field is optional.
4. You can provide additional information using the **Optional Information** tab.
5. Click the **Register** button to send this information to Parallels.

A free trial activation key will be sent immediately to the e-mail address you provided.

If you want to register online at the Parallels website, click the **Register online** button. You will receive a free trial activation key by e-mail after you fill out and submit the online form.

When your free trial activation key expires, you will need to get a permanent activation key.

**Getting a Permanent Activation Key**

To purchase an activation key:

1. Choose **Activate Product** from the **Help** menu.
2. In the **Activate Product** dialog, click the **Purchase a permanent activation key** link to open Parallels Online Store (http://www.parallels.com/en/buyonline) where you can purchase an activation key.
Installing Parallels Desktop

Registering Parallels Desktop

After you have activated your copy of Parallels Desktop with a permanent activation key, you will be asked to register it.

We strongly recommend you to register your copy of Parallels Desktop. With registration, you will be able to:

- download and install the latest Parallels Desktop updates
- create a backup copy of the product key on the Parallels web server and restore it at any time
- contact the Parallels support team
- stay informed about Parallels news and announcements

All these services, including the product key backup, are free of charge for the registered users of Parallels Desktop.

If you do not want to register now, choose Don't register. To initiate the registration procedure later, select Register Product from the Help menu.

The registration procedure

1. In the registration dialog, enter your name and e-mail in the corresponding fields and specify where you are going to use Parallels Desktop.
2 If you choose **At work** from the **For use** list, you will be asked to specify some additional information. Parallels needs this information to know our customers better in order to provide them with the best software and service.

3 To register Parallels Desktop, click **OK**. If you don't want to register your copy of Parallels Desktop, click **Don't register**.
Upgrading to Parallels Desktop 4

To upgrade Parallels Desktop to version 4, you should purchase the Parallels Desktop upgrade from Parallels Online Store (http://www.parallels.com/en/buyonline). An upgrade activation key will be sent immediately to the e-mail address you provided.

Generally, the upgrading procedure for Parallels Desktop is the same as for its installation. See Installing Parallels Desktop (p. 18).

You don't have to remove the previous version of Parallels Desktop before the upgrade: the installer will remove it automatically before installing Parallels Desktop 4.

Using an Upgrade Activation Key

After you have installed Parallels Desktop 4, you should activate it with an upgrade activation key. To launch the activation process, choose Activate Product from the Help menu and enter your upgrade activation key and the required information in the Activate Product dialog. If you purchased your upgrade activation key for Parallels Desktop 4, you may need to confirm that you have a valid permanent key for the previous version:

- If you activated the previous version of Parallels Desktop 3.0 with a permanent key, you will need to enter the upgrade key only.
- If you activated Parallels Desktop 3.0 with a trial activation key, you will be prompted to enter both keys: the key you used with the previous version and the upgrade key for the 4 version.
- If you purchased Parallels Desktop 3.0 but haven't installed it on your Mac, you will need to install only Parallels Desktop 4 and activate it using two keys: the upgrade activation key and a permanent key for the previous version.

Converting Your Virtual Machines to the New Format

Parallels Desktop 4 uses a new format of virtual machines. When you start a virtual machine created in the previous version, you will be asked to convert it to the new format. When prompted to convert the virtual machine to the new format, choose one of the following:

- Click Convert to start the process. This operation is irreversible. If you choose this option, you will not be able to convert the virtual machine back to the old format.
- Click Backup & Convert to start the process. In this case, the virtual machine will be backed up and then converted to the new format. If you need to start this virtual machine in Parallels Desktop 3.0, you will be able to restore it from the backup.

Note: You can find the backup folder with the virtual machine files in the following location: /<Home folder>/Documents/Parallels/.

Upgrading the Virtual Machine Configuration and Updating Parallels Tools

The upgrading procedure starts and runs automatically after the virtual machine conversion. During the upgrade, the virtual machine configuration and Parallels Tools are processed. The virtual machine can be used in Parallels Desktop 4 only after it is upgraded.
Note: In Linux virtual machines, X Server may fail to start after the upgrade, which means that you may need to upgrade Parallels Tools manually in text mode (p. 266).

If you encounter any problems during the upgrade, visit the upgrade troubleshooting page (http://www.parallels.com/support/desktop/troubleshooter/upgrade/) or use the online Troubleshooting guide available through Help > Troubleshooting Guide.

### Updating Parallels Desktop

Parallels Desktop includes an updating feature that helps you keep your Parallels Desktop installation up-to-date. You can use the update feature only if your computer is connected to the Internet.

Update checks can be performed either automatically or manually.

- We recommend that you turn on automatic updating to be notified when an update is available. Parallels Desktop will regularly check for updates available and inform you about them.
- In addition to automatic updating, you can start the updating manually at any time.

Note: Before updating, you will be asked to quit Parallels Desktop. If you have any virtual machines running or paused, suspend or shut them down. When you start or resume your virtual machines after the update, reinstall Parallels Tools.
**Automatic Updating**

To use the automatic updating feature, your Mac computer should have a stable Internet connection.

Parallels Desktop enables you to set up an automatic check for updates and determine the frequency for this checking.

To set up automatic update checking:

1. Launch Parallels Desktop.
2. In the Parallels Desktop menu select Preferences and go to the Update pane.
3. In the Update pane, you can define the necessary settings. To set up automatic checking for new versions, just select the Check for updates option and define the checking frequency. The system can search for new updates once a day, once a week, or once a month. With these options set, Parallels Desktop will access the Parallels update server and notify you when an update is available. If you do not need automatic checking, you can easily turn it off by clearing the Check for updates check box.

Checking for new updates may take some time and if you do not want to have the process window on top of your desktop, you can hide it to the background. To do that, enable the Check in background option.

Select the Download updates automatically option if you want all new available updates to be downloaded at once without showing you the Download dialog.

From the Update pane, you can also perform a manual instant search for updates. To do that, just click the Check Now button. The updates available for your version of Parallels Desktop will be displayed in the Download dialog. Choose the update(s) you want to install and click the Download button. If your version of Parallels Desktop is up to date, you will see the corresponding message.
4 When you finish, click **OK** to save the changes and close the dialog.

**Manual Updating**

Parallels Desktop also enables you to check for updates manually whenever you want.

To check for updates manually:

1 Launch Parallels Desktop.

2 From the **Help** menu, choose **Check for Updates**. The program will immediately start the search for updates.

   While the updater accesses the Parallels update server and compares the available updates with the installed version, you can hide this window, by selecting **Check in background**.

3 If there is one or more updates available, they will be listed in the **Parallels Update** window. Select the update to install and click **Install**.

   You can also download the update by clicking the **Download** button. To change the download folder, type the path into the **Download folder** field or use the **Choose** button to locate the folder.

   **Note:** You can install the downloaded update later by locating it in Finder and launching the installer.

4 Specify your user name and password to start the installation and click **OK**.

5 Follow the Parallels Desktop installer's instructions to install the update.

   **Note:** If the installer displays a list of conflicting applications, quit these applications to be able to proceed with the installation.

6 When the update is installed, click **Close** to quit the installer.
Removing Parallels Desktop

To remove Parallels Desktop:

1. Locate and open the DMG installation image file that you used to install Parallels Desktop. Click **Uninstall Parallels Desktop**.

2. In the **Welcome** dialog, click **Continue**.

3. In the **Select components to uninstall** window, select the components you want to remove and click **Uninstall**.
   - **Parallels Desktop**. Selecting this option removes Parallels Desktop from your computer.
   - **Application Settings**. Selecting this option removes the Parallels Desktop settings, network settings, and the list of registered virtual machines from your computer.

**Note**: The operation of removing Parallels Desktop doesn't remove the virtual machines and their files from your Mac.

In the next dialog, confirm your choice of the components to be uninstalled by clicking **Uninstall**.

4. Enter your password when prompted and click **OK**.

5. The uninstaller removes Parallels Desktop from your Mac.

6. When the removing is complete, click **Close** to quit the uninstaller.
Removing Parallels Desktop Without Installation Disc

Parallels Desktop can be removed without the installation disc via Uninstaller.sh located in the Library/Parallels/Parallels Service/Contents/Resources directory. To locate it, in a terminal, enter:

```
# ls /Library/Parallels/Parallels\ Service.app/Contents/Resources
```

<table>
<thead>
<tr>
<th>ParallelsDispatcherService</th>
<th>libprl_sdk.dylib</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uninstaller.sh</td>
<td>libprl_sdk_py.dylib</td>
</tr>
<tr>
<td>VM Samples</td>
<td>uninstaller_messages.strings</td>
</tr>
<tr>
<td>com.parallels.vm.prl_naptd.plist</td>
<td></td>
</tr>
</tbody>
</table>

The syntax of Uninstaller.sh is:

```
./Uninstaller.sh selection
```

Where selection can be one of the following:

- `server`: Removes Parallels Server.
- `desktop`: Removes Parallels Desktop.
- `vitools`: Removes Parallels Transporter, Parallels Explorer, Parallels ImageTool.
- `sdk`: Removes Parallels Server SDK.
- `gtools`: Removes Parallels Tools for Mac OS X.

You can also pass to Uninstaller.sh one of the following options:

- `--help`: Displays the usage information on Uninstaller.sh.
- `--remove-configs`: Removes the product configuration files.

In this example, Parallels Desktop is removed from the computer using Uninstaller.sh:

```
# cd /Library/Parallels/Parallels\ Service.app/Contents/Resources
# ./Uninstaller.sh desktop
[UN_PERCENT]:4[UN_OP]:Stopping Parallels Desktop [UN_MSG]:Stopping Dispatcher
launchctl stop "com.parallels.desktop.launchdaemon"
...
[UN_PERCENT]:100[UN_OP]:Uninstall successfull[UN_MSG]:Parallels Desktop Removed
```
CHAPTER 4

Principles of Working With Parallels Desktop

Before you start to work with Parallels Desktop and create virtual machines, you can learn the basic information about using it. This chapter provides essential information about starting Parallels Desktop, using its interface elements, and configuring its preferences.

In This Chapter

Starting Parallels Desktop ..................................................................................................... 30  
Interface Basics ..................................................................................................................... 33  
Configuring Parallels Desktop Preferences ........................................................................... 41

Starting Parallels Desktop

To start Parallels Desktop, open the Applications folder in Finder and double-click Parallels Desktop.
When you start Parallels Desktop, its icon appears in the Dock.

To add the Parallels Desktop icon to the Dock:

- If Parallels Desktop is currently open, right-click its icon in the Dock and choose **Keep in Dock** from the shortcut menu, or
- Open the **Applications** folder in Finder and drag the Parallels Desktop icon to the Dock.

When you launch the program for the first time, you will see the welcome window that will help you start working in Parallels Desktop.

If you configured Parallels Desktop not to show the welcome window, when you open Parallels Desktop, you will see Virtual Machines Directory (p. 34) listing the virtual machines registered in Parallels Desktop.

### The Welcome Window

When you start Parallels Desktop for the first time, the **Welcome to Parallels Desktop 4** window appears. This window provides you with a fast access to the most common Parallels Desktop dialogs and assistants, which is especially useful when making your first steps in Parallels Desktop.

Later on, if you do not want to see this window again, just disable the **Show at startup** check-box at the left bottom corner of the screen. Next time you start Parallels Desktop, you will see the Parallels Virtual Machines dialog (p. 34) if you have one or more virtual machines registered in Parallels Desktop or New Virtual Machine Assistant (p. 67) if you have no virtual machines registered.

**Note:** If you have disabled the Welcome screen, you will not be able to restore it in future.
From the **Welcome** screen, you can navigate between the following options:

- **View tutorial.** This option allows you to view the Parallels Desktop brief tutorials from the Parallels website.

- **Run Windows on your Mac.** This option allows you to launch New Virtual Machine Assistant (p. 67) to create a virtual machine with the needed Windows, Linux or Mac OS X operating system.

  **Note:** If you just close the assistant without completing the creation, you will return to the Welcome screen.

- **Import virtual machines.** This option allows you to choose the virtual machine you want to open in Parallels Desktop.

  If you choose a Parallels virtual machine, the guest OS window (p. 36) appears.

  If you choose a third-party virtual machine, Parallels Transporter, a built-in Parallels Desktop application, appears. With this application, you can convert a third-party virtual machine into the Parallels format of virtual machines and use it with Parallels Desktop. For more information, see the **Migrating to a New Virtual Machine** section (p. 87) or refer to **Parallels Transporter User's Guide**.

- **Start using Parallels Desktop.** This option allows you to open the Parallels Virtual Machines dialog (p. 34) and choose between the virtual machines in the list. This window appears only if you have two or more virtual machines registered in this list. If you have only one virtual machine registered, the virtual machine main window (p. 36) will appear. If you have no virtual machines registered, then you can start your work in Parallels Desktop with creating a new virtual machine in New Virtual Machine Assistant (p. 67).
New Virtual Machine Assistant

If you have no virtual machines, you can start your work in Parallels Desktop with creating a new virtual machine in New Virtual Machine Assistant.

The assistant offers several installation modes. You can choose the mode that better fits your needs or your experience with Parallels Desktop. Regardless of what method you select, you will be able to change the configuration of your virtual machine later using the Virtual Machine Configuration dialog (p. 146).

To create a new virtual machine:

1. Start Parallels Desktop and launch New Virtual Machine Assistant by clicking **New Virtual Machine** in the **File** menu or choosing **Virtual Machines Directory** from the **Window** menu and clicking the button in the bottom part of the window.

2. In the **Introduction** window, click **Continue** to proceed with the virtual machine creation.

3. In the **Operating System Detection** window, if you specify the source of installation files, the wizard will try to automatically determine the type and version of your operating system. Thus, you choose the Default installation mode. (p. 70)

   If you click **Skip** in the **Operating System Detection** window, you will be able to choose between the other installation modes in the next window:
   - Express Windows installation (p. 74)
   - Typical installation (p. 77)
   - Custom installation (p. 79)

Interface Basics

This chapter provides a basic description of the Parallels Desktop interface elements and their functionality.
Parallels Virtual Machines Dialog

The Parallels Virtual Machines dialog (or Virtual Machine List) lists the virtual machines that are already registered in Parallels Desktop.

**Note:** If you have no virtual machines registered in Parallels Desktop, the virtual machine list doesn't open.

To open the Parallels Virtual Machines dialog:

- Choose Virtual Machines Directory from the Window menu.
- Right-click the Parallels Desktop icon in the Dock, and choose Virtual Machine List from the shortcut menu.
- Click Start using Parallels Desktop option on the Welcome screen (p. 31).
- The dialog appears whenever you start Parallels Desktop, if you disabled the Welcome screen.

**Note:** To disable the Welcome screen, just clear the Show at startup option on this screen.
The Parallels Virtual Machines dialog contains the following items:

- A list of the registered virtual machines. The virtual machines are listed by their names, not pathnames. Click the virtual machine name to open it in a virtual machine window. The names of the open virtual machines are grayed out and cannot be selected.

- The Create a virtual machine button. Click it to start New Virtual Machine Assistant (p. 67).

- The Open a virtual machine button. Click it to open a virtual machine that is not in the list (it can be stored on your Mac, on an external USB storage, or on the network).

- The Download Parallels Virtual Appliances button. Click it to go to the web page of Parallels Virtual Appliances Directory (http://ptn.parallels.com/en/ptn/dir), choose a virtual appliance, and download it. Parallels Virtual Appliances are ready-to-use virtual machines, that have an operating system installed. Some of the virtual appliances may be configured to serve a certain application.

- The Favorite Applications button. Click it to view all your favorite applications available through the virtual machines in the list.

- The Virtual machines button. If you are viewing your favorite applications, click this button to return to the list of virtual machines.

The Expand button. Click this button to the right of the virtual machine's name to see the favorite applications available through this virtual machine.

You can use a set of commands for managing a virtual machine if you right-click it in the list. You can choose between the following operations:

- Start. Starts the virtual machine and initiates the operating system booting.

- Configure. Opens the Virtual Machine Configuration dialog (p. 146). Use it for editing the virtual machine's configuration.

- Show in Finder. Opens a Finder window showing you the location of the virtual machine.

If you right-click a virtual machine template (p. 222), the set of commands will slightly differ. The Start option is not available because you cannot launch a template, but you can choose the Convert to Virtual Machine or Deploy to Virtual Machine options.
Virtual Machine Window

When you choose a virtual machine from the Parallels Virtual Machines dialog (p. 34), the virtual machine window appears. If you start this virtual machine, the virtual machine window changes to the guest OS window that acts as the virtual machine's display. If you have a guest operating system installed, you will see the booting process in the window. The toolbar buttons and many of the menu commands become enabled. You can resize the virtual machine window as you would do with any other application window by dragging its right corner. Its resolution is being changed automatically in Windows (starting from Windows 2000) and in most Linux operating systems.

The virtual machine window consists of three parts:

- **Toolbar** - comprises buttons that can be used to manage the virtual machine and its appearance.
- **Virtual Machine Screen** - acts as the virtual machine's screen.
- **Status bar** - contains icons for the virtual machine's devices and displays their status. The status bar is available only when the virtual machine is running and can be used to control the virtual machine's devices. For more information, see the Status Bar section (p. 39).

When a guest operating system is running, you can switch between several display modes of the guest OS window. For detailed information on the view modes, see Changing the View Mode (p. 109).

**Toolbar**

The Parallels Desktop toolbar has buttons for the most frequent commands used to start, stop, and otherwise manage a virtual machine and its window appearance.

Most of the toolbar buttons become enabled only when you start the virtual machine. If you click a toolbar button, it becomes visibly pressed.
The default toolbar buttons:

**Start.** Use this button to start the virtual machine if it is stopped, paused or suspended.

**Stop.** Use this button to stop the virtual machine in cases when the machine does not run properly and prevents you from shutting it down.

*Note:* If you click this button when the virtual machine is running, you may lose all the unsaved data. To turn off the virtual machine, use the shutdown procedure specified for the guest OS installed in it. You can also add the **Shut Down** button to the toolbar.

**Suspend.** Use this button to put your virtual machine into the sleep mode for a certain period of time. If you need to restart the host computer, you may temporarily suspend your virtual machines and easily resume them after the restart.

**Configure.** Use this button to open the Virtual Machine Configuration dialog.

**Full Screen.** Use this button to switch the virtual machine to the Full Screen mode. To return back to the Window mode, press Alt+Enter. The key combination for switching to the Full Screen mode and back can be changed in the Preferences dialog available from the Parallels Desktop menu.

**Coherence.** Use this button to switch the virtual machine to the Coherence mode.

You can easily add other buttons to the toolbar: just right-click the toolbar, choose Customize Toolbar (p. 41) from the shortcut menu, and drag the items you need to the toolbar. If you often work with snapshots, you can drag any of the three snapshot buttons to the toolbar as well:

**Pause.** Use this button to pause the virtual machine. Use this button when you need to instantly release the primary OS resources used by this virtual machine.

**Restart.** Use this button to restart the fully loaded guest operating system. This button is available only for Windows virtual machines if Parallels Tools are installed. To view the list of Windows guest operating systems supporting Parallels Tools, refer to the Parallels Tools Overview subsection (p. 89).

**Safe Mode.** Use this button to run the virtual machine in Safe Mode.

**Take Snapshot.** Use this button to create a snapshot for the virtual machine.
Revert to Snapshot. Use this button to roll back the changes made to the virtual machine since the moment the last snapshot was made.

Snapshot Manager. Use this button to open Snapshot Manager. For more information, refer to the Working with Snapshots section (p. 234).

You can also manage a virtual machine by using the Parallels Desktop menus. For more information about the menu options, see the Menus section (p. 39).

Summary Pane

The Summary pane contains the name of the virtual machine and the operating system installed in it.

Status Bar

The status bar becomes active, when you start a virtual machine. It displays the virtual machine devices icons. You can easily connect or disconnect the devices using the icons on this bar: right-click the device icon and choose the necessary option from the shortcut menu.

For more information on the status bar functionality, refer to the Status Bar section (p. 39).
The Parallels Desktop menus contain all the controls available for Parallels Desktop and its virtual machines. The menus are displayed on the Mac OS X menubar.

There are the following menus:

- The **Parallels Desktop** menu displays the About Parallels Desktop dialog and lets you set Preferences (p. 41).
- The **File** menu lets you create a new virtual machine or delete one of the already existing virtual machines. The Import command allows you to open virtual machines that are not registered in Parallels Desktop. The Run Parallels Transporter command allows you to migrate the information from other computers or virtual machines with the help of Parallels Transporter.
- The **View** menu includes commands for switching between different view modes: the Full Screen, Coherence, Modality, or Window mode. You also can customize how you view the toolbar.
- The **Virtual Machine** menu allows to manage the virtual machine, edit the virtual machine configuration, clone the virtual machine and convert it to a template, make screenshots of the virtual machine screen and install Parallels Tools in the virtual machine.
- The **Devices** menu is available only when the virtual machine is running. It allows you to configure certain devices and shared folders at runtime.
- The **Window** menu allows you to choose the application window you want to appear on top. This menu simplifies the navigation between the virtual machines.
- The **Applications** menu enables you to manage certain elements of the Windows desktop, manage your shared Windows and Mac applications (p. 137), and configure the file extension associations with SmartSelect (p. 141). To view and access this menu, you must install Parallels Tools.

  **Note:** The Applications menu is available only for Windows 2000/XP/2003/Vista guest OSs.

- The **Help** menu opens Parallels Desktop Help Center, lets you activate the product, check for updates, and report problems.

**Parallels Desktop Shortcut Menu**

Parallels Desktop icon placed in the Dock has a shortcut menu with a number of commands for smooth work with the virtual machine. Just right-click the Parallels Desktop icon to open this menu.

**Status Bar**

The status bar displays the devices information when the virtual machine is running. It displays the devices icons and tooltips for the devices currently pointed by the pointer or other messages.
The following devices have the icons on the status bar:

- keyboard
- floppy disk drive
- CD/DVD-ROM
- hard disk
- network adapter
- sound card
- USB controller
- shared folders
- serial port
- parallel port

If you see the icon in the status bar, it means that Parallels Tools are installed in your virtual machine.

If a device can be connected or disconnected at runtime (actually, most of the devices can be), this can be done using the device's shortcut menu. Click the device icon to display its shortcut menu and select the command. The picture below shows the shortcut menu for the CD/DVD-ROM drive.

You can also connect CD/DVD discs or images of discs to the virtual machine's CD/DVD-ROM drive or connect a floppy image to its floppy drive in the following way: drag the required image file over the CD/DVD-ROM drive icon on the Parallels Desktop status bar. For more information, please refer to the Changing Configuration at Runtime section (p. 126).
Customizing Toolbar

To change the appearance of the toolbar items, right-click the toolbar and use the shortcut menu commands:

- **Icon & Text.** Use this command if you want the toolbar to display both the button icons and their names.
- **Icon only.** Use this command if you want the toolbar to display only the button icons.
- **Text only.** Use this command if you want the toolbar to display only the button names.
- **Use Small Size.** Use this command if you want the tool bar buttons to appear in a smaller size.
- **Customize Toolbar.** This command opens the toolbar settings pane. See the description below.

To customize the set of buttons on the toolbar and their appearance, right-click the toolbar and choose **Customize Toolbar** from the shortcut menu. This will open the toolbar settings pane. You can use this pane to:

- add new buttons to the toolbar by dragging them from the settings pane to the toolbar
- remove buttons from the toolbar by dragging them from the toolbar to the settings pane
- add separators to the toolbar by dragging them from the settings pane to the toolbar
- add spaces to the toolbar by dragging them from the settings pane to the toolbar
- change the current toolbar buttons set to the default one by dragging it to the toolbar
- select the toolbar buttons view mode in the **Show** list

To apply the changes you have made to the toolbar settings pane, click **Done.**

Configuring Parallels Desktop Preferences

This section provides the information on how to configure the Parallels Desktop settings using the **Preferences** dialog. You can open this dialog by choosing **Preferences** from the **Parallels Desktop** menu.
General Preferences

In the General pane of Parallels Desktop Preferences, you can do the following:

- change the default location for storing the folders with the files of virtual machines
- restore hidden messages

Note: The settings available in this pane can be configured individually for each user of the physical computer.
Changing the default folder for virtual machines

The **Default folder for virtual machines** field displays the default location where Parallels Desktop stores the files and folders of all virtual machines you create on your Mac. You can change the default location by typing the path to another folder in this field or clicking the **Choose** button and navigating to the necessary folder. After changing the default location, all newly created virtual machines will be saved to the folder specified in the **Default folder for virtual machines** field. However, this does not affect the files of virtual machines that already exist: their files will remain in the original default folder.

**Resetting hidden messages**

A number of Parallels Desktop dialogs and assistant windows are provided with the **Do not show this message again** option. If you select this option, the corresponding dialog will not appear next time you perform the same operation. Using the **Reset Hidden Messages** button, you can reset all dialogs and assistant windows with this option selected so that they are displayed again each time you initiate the corresponding operation.

**Restoring default settings**

The **Restore Defaults** button enables you to restore the default settings for all options available in this pane.

**Keyboard and Mouse Preferences**

In the **Keyboard & Mouse** pane of Parallels Desktop Preferences, you can set keyboard shortcuts for certain commands.

**Note:** The keyboard shortcuts can be configured individually for each user of your Mac.
Configuring Keyboard Shortcuts

To configure the shortcuts used to perform certain actions, use the **Double-click the shortcuts below for editing** list. Using this list, you can remap the Mac OS X shortcuts to Windows shortcuts that perform similar actions in Parallels Desktop virtual machines.

The shortcuts are divided into two groups: shortcuts for managing the Parallels Desktop software and shortcuts for working in virtual machines. Shortcuts for Parallels Desktop cannot be added or removed, while the shortcuts for virtual machines can be added using the **Add** button and removed using the **Remove** button.

To add a shortcut, click the **Add** button and specify the rule for translating the key combination.

- In the **From** field, use the buttons to add modifier keys to the Mac keyboard shortcut and enter the required key into the empty field.
- In the **To** field, specify the PC keyboard shortcut to translate the Mac shortcut to. You can use the buttons for modifier keys, and type the key into the empty field or select the necessary PC keyboard key using the arrow button.

![Shortcut Configuration Example](image)
To configure a shortcut remapping rule, double-click it and edit by entering the new key combination.

**Important:** There are Mac shortcuts that do not have similar shortcuts in Windows, for example, you can use the F11 key or Fn+F11 combination to see your Mac OS desktop with Expose, but in Windows there's no keys or key combinations that enable you to perform the same action, because there is no Expose in Windows.

The **Enable Mac OS X system shortcuts** checkbox, which is selected by default, allows you to use the default (F9/F10/F11/F12) and custom shortcuts for Mac OS X during your work with virtual machines in Parallels Desktop.

**Using profiles**

By default, Parallels Desktop contains four profiles that represent sets of key combinations typical for the following OSs:

- Windows
- Linux
- Mac OS X
- Generic (for other guest OSs)

When you create or register a virtual machine, one of these profiles, depending on the guest operating system, will be assigned to the machine by default. To view the default sets of shortcuts for each of the profiles, refer to Key Profiles.

**Emulating a mouse right-click**

To emulate a mouse right-click for a mouse that does not have the right key, go to the **Mouse** tab of the **Keyboard & Mouse** pane and choose one of the following:

- Select the **To right-click** check box and specify the key combination that will be used to emulate a mouse right-click in the virtual machine, or
- Select the **Click and hold the mouse button** check box and configure the time interval when this option will come into effect by moving the slider in the necessary direction between **Short Delay** and **Long Delay**.
To submit the changes, click **OK**, otherwise, click **Cancel**.

**Restore Defaults**

The **Restore Defaults** button enables you to restore the default settings for all options available in the **Keyboard & Mouse** pane.
Appearance Preferences

In the Appearance pane of Parallels Desktop Preferences, you can choose the appearance of the Parallels Desktop icon and define the animation for actions you perform in Parallels Desktop.

**Note:** The options on this tab can be configured individually for each user of your Mac.
Dock icon

This option defines what type of icon will appear in the Dock when Parallels Desktop is open. The following types of icons are available:

- **Parallels Desktop.** The standard Parallels Desktop icon appears in the Dock
- **Start Menu.** If you choose this type of icon, the Windows *Start Menu* icon will appear when your virtual machine is in Coherence. In all other modes, the standard icon will be used.
- **Live Screenshot.** If you choose this type, the Dock icon will appear as a live screenshot of the virtual machine window.

**Note:** Irrespective of the Dock icon appearance, clicking this icon in the Coherence mode invokes the Windows *Start* menu.

Transition to full screen

This option allows you to set the desired type of animation effect (or none) on switching a Parallels virtual machine to full screen and back. You can choose one of the following effects: *Disabled, Fade, Zoom, Reveal, Slide, Warp, Cube, Switch, or Flip.*

Animate

This group of options defines the animation behaviour when you perform certain actions in Parallels Desktop:

- **Transition to Coherence.** Select this option to animate the transition to the Coherence mode and back to the Window mode. Clear this check box if you do not want any animation on switching to the Coherence mode.
- **Transition to Modality.** Select this option to animate the transition to the Modality mode and back to the Window mode. Clear this check box if you do not want any animation on switching to the Modality mode.
- **Suspending and resuming.** Select this option to animate the operations of suspending and resuming virtual machines. Clear the check box if you do not want any animation when performing these operations.
- **Actions with snapshots.** Select this option to animate the actions you perform with snapshots. Clear the check box if you do not want any animation when performing these operations.
- **Closing the windows.** Select this option to animate the operation of closing the virtual machine window. Clear the check box if you do not want any animation when performing this operation.

Window animation speed

Set the speed of the animation using the slider. All animations set on the tab will be affected.

Restore Defaults

The *Restore Defaults* button enables you to restore the default settings for all options available in the *Appearance* pane.
Memory Preferences

The Memory pane of Parallels Desktop Preferences allows you to adjust the maximum amount of physical memory (RAM) that the system will reserve for all virtual machines running on your Mac.

By default, the Automatically option is selected. In this case, the total amount of RAM to be allocated to all running virtual machines is automatically calculated by the system based on the following main factors:

- the total amount of memory installed on your Macintosh computer and
- the amount of memory required by Mac OS X for its operation.

The allocated amount of memory is shared among all running virtual machines. You can configure the amount of physical memory for a particular virtual machine on the Memory tab in Virtual Machine Configuration (p. 173).

You can redefine the default behaviour and manually set the amount of memory to be reserved for all active virtual machines. To this effect, select the Manually option and specify the needed value by:

- dragging the slider, or
- using the spin box arrows, or
- typing the value directly into the field

Restore Defaults

The Restore Defaults button enables you to restore the default settings for all the options available in the Memory pane.
Network Preferences

The **Network** pane of Parallels Desktop Preferences allows you to configure a number of network-related settings for Parallels Desktop and your virtual machines.

You can configure the range of IP addresses to be assigned to your virtual machines when they are operating in the *shared* and *host-only* networking modes.

To edit the host-only networking settings:

1. Select **Host-only networking** in the **Connection type** list.
2. Select the **Enable DHCP Server** option to enable the Parallels DHCP server. This server will automatically assign IP addresses to your virtual machines operating in the host-only networking mode from the IP addresses range defined in the appropriate fields below this option.
3. If necessary, configure the start and end IP addresses in the **Start address** and **End address** fields and specify the network mask in the **Subnet mask** field.

For more information on configuring the host-only networking parameters, refer to *Host-Only Networking* (p. 195).

To edit the shared networking settings:

1. Select **Shared networking** in the **Connection type** list.
2. Select the **Enable DHCP Server** option to enable the Parallels DHCP server. This server will automatically assign IP addresses to your virtual machines operating in the shared networking mode from the IP addresses range defined in the appropriate fields below this option.
3. If necessary, configure the start and end IP addresses in the **Start address** and **End address** fields and specify the network mask in the **Subnet mask** field.
For more information about configuring shared networking, refer to **Shared Networking** (p. 192).

The **Start address** and **End address** values determine the first and the last IP addresses with the first address usually assigned to the DHCP server itself. The second address is usually given to the host OS. Other addresses are assigned to virtual machines. The scope of IP addresses defined should belong to the same subnet.

**Port Forwarding**

Normally, virtual machines set to operate in the shared networking mode cannot be accessed from external computers. The port forwarding functionality allows computers on your local network and on the Internet to transfer data to any of your virtual machines that use the shared networking mode. The data sent to a specific port on your Mac will be redirected to a specific port of your virtual machine according to a port-forwarding rule.

To add a new port forwarding rule:

1. Click the **Add** button below **Port forwarding list**.
2. In the displayed window, do the following:
   - In the **Port Type** field, specify the port type you want to use for establishing network connections. You can choose between the **TCP** or **UDP** port types.
   - In the **Incoming Port** field, provide the port number on your Mac you want to use for data transfer.
   - In the **IP Address** field, indicate your virtual machine's IP address.
   - In the **Destination Port** field, type the virtual machine's port the data will be transferred to.

![Port Forwarding Interface](image)
3 Click **OK** to add the rule.

When the rule is added, use the following IP address combination for external connections to your virtual machine: `<you Mac's IP address>:<Source port>`.

To edit an existing port forwarding rule, select it in the **Port forwarding list** table, click the **Edit** button, and modify the necessary parameters in the displayed window.

To remove a port forwarding rule, select it in the **Port forwarding list** table and click the **Remove** button.

**Restore Defaults**

The **Restore Defaults** button enables you to restore the default settings for all options available in the **Network** pane.
USB Preferences

In the **USB** pane of Parallels Desktop Preferences, you can specify how to connect USB devices that are plugged into your Mac.
General Behavior

You can choose a general action to perform when a new USB device is plugged into your Mac by choosing one of these options:

- **Connect it to the computer.** If you select this option, the USB device plugged into your Mac will be connected to the primary OS.
- **Connect it to a virtual machine.** If you select this option, the USB device plugged into your Mac will be automatically connected to the virtual machine that is currently running on your Mac. When no virtual machine is running, the USB device will be connected to the primary OS.
- **Ask me what to do.** If you select this option, you will be prompted to choose how to connect the USB device each time a new USB device is plugged into your Mac.

Permanent Assignments

You can also set permanent assignments for certain USB devices. These assignments are displayed in the **Permanent assignments** list.

To add a new assignment:

1. Click the **Add** button below the **Permanent assignments** list.
2. Click the device field in the **USB Device** column to choose a USB device from the list.
3. In the **Connect To** column, double-click the destination field to open the list of available destinations and choose the virtual machine you want to connect this device to. If you want to connect this USB device to the primary OS, choose **Computer**.

**Note:** To be able to use the USB device in a virtual machine, you may need to install the necessary drivers in its guest OS. By default, such drivers can be obtained from the manufacturers of this device.

4. Click **OK** to apply the changes.

**Note:** You can connect up to eight USB 2.0 devices and up to eight USB 1.1 devices to each virtual machine.

You can change an assignment by editing the device and destination in the **USB Device** and **Connect To** fields.

To remove an existing assignment, select it in the **Permanent assignments** list and click the **Remove** button.

For more information about using USB devices in a virtual machine, refer to **Connecting USB Devices to a Virtual Machine** (p. 123).

Restore Defaults

The **Restore Defaults** button enables you to restore the default settings for all options available in the **USB** pane.
## Speech Preferences

The **Speech** pane allows you to use spoken commands for managing the virtual machine behavior. The following spoken commands are available:

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts a virtual machine.</td>
</tr>
<tr>
<td>Suspend</td>
<td>Suspends a virtual machine.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>Shuts down a virtual machine.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses a virtual machine.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops a virtual machine.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets a virtual machine.</td>
</tr>
<tr>
<td>Snapshot</td>
<td>Opens the <strong>Snapshot Manager</strong> window.</td>
</tr>
<tr>
<td>Make Screenshot</td>
<td>Makes a screenshot of the Guest OS window and stores it on the Mac OS X Desktop.</td>
</tr>
<tr>
<td>Make Clip</td>
<td>Makes a clip.</td>
</tr>
<tr>
<td>Switch to Coherence</td>
<td>Switches to the Coherence view mode.</td>
</tr>
<tr>
<td>Switch to Full Screen</td>
<td>Switches to the Full Screen view mode.</td>
</tr>
<tr>
<td>Switch to Window</td>
<td>Switches to the Window view mode.</td>
</tr>
<tr>
<td>Edit Configuration</td>
<td>Opens the <strong>Virtual Machine Configuration</strong> dialog.</td>
</tr>
<tr>
<td>New</td>
<td>Creates a new virtual machine.</td>
</tr>
<tr>
<td>Open</td>
<td>Opens a virtual machine.</td>
</tr>
<tr>
<td>About Parallels Desktop</td>
<td>Opens the About Parallels Desktop menu.</td>
</tr>
<tr>
<td>Install Parallels Tools</td>
<td>Launches the installation of Parallels Tools in the running virtual machine.</td>
</tr>
<tr>
<td>Report a Problem</td>
<td>Opens the <strong>Parallels Problem Report</strong> window.</td>
</tr>
<tr>
<td>Open Directory</td>
<td>Opens an existing virtual machine and registers it in Parallels Desktop.</td>
</tr>
<tr>
<td></td>
<td>Opens the <strong>Parallels Virtual Machines</strong> window.</td>
</tr>
</tbody>
</table>

To enable the speech commands, select the **Enable spoken commands** checkbox that is grayed out by default:
To successfully operate your virtual machine by using the speech commands, please make sure that:

- the virtual machine window is active, and
- the speech settings are properly tuned on the corresponding tab of the Mac OS X System Preferences

If the speech settings are not tuned, you will see the 'To enable this option, you should turn on speakable items in System Preferences' warning message.

To tune the speech settings, click Open System Preferences.

To restore the default settings, click Restore Defaults.

To submit the changes, click OK, otherwise, click Cancel.
iPhone Preferences

In the iPhone pane of Parallels Desktop Preferences, you can allow external connections to Parallels Desktop and its virtual machines from iPhone.

If you want the Parallels Mobile application to display a list of accounts available on your Mac, select Send a list of your Mac's accounts to Parallels Mobile.

For more information about Parallels Mobile and using iPhone to manage your virtual machines, see Managing Virtual Machines From iPhone (p. 229).
Update Preferences

In the Update pane of Parallels Desktop Preferences, you can set preferences for the frequency of the update checks.

Note: The settings available in this pane can be configured individually for each user of the physical computer.
The **Check for updates** section defines the policy for updating the Parallels Desktop software. By default, Parallels Desktop is set to automatically check for available updates once a week, provided that the Parallels Desktop application is launched and your physical computer is connected to the Internet. You can specify another interval for updates checking by selecting the necessary value in the **Check for updates** list. The following options are available:

- **Once a day.** Select this option if you want Parallels Desktop to perform the update check every day.
- **Once a week.** Select this option if you want Parallels Desktop to perform the update check every week.
- **Once a month.** Select this option if you want Parallels Desktop to perform the update check every month.

Checking for new updates may take some time and if you do not want to have the process window on the top of your Desktop, you can hide it to the background. To do that, enable the **Check in background** option.

Select the **Download updates automatically** option if you want all new available updates to be downloaded at once without showing you the **Download** dialog.

You can also manually check for available updates at any time you want by clicking the **Check Now** button:

- If any updates are available for you version of Parallels Desktop, you will see them in the **Download** dialog. Choose the updates you want to install and click the **Download** button.
- If your version of Parallels Desktop is up to date, you will see the corresponding message.

**Feedback Preferences**

Using the **Feedback** pane, you can join the Parallels Customer Experience Program.
If you choose to participate in the program, Parallels will collect information about your host computer and virtual machines configuration. The collected information will help us to make the product better fit your needs.

If you join, only the following types of data will be collected:

- hardware configuration of your Mac;
- software configuration of your Mac and virtual machines (the names and versions of the operating systems and software installed in them);
- configuration files of virtual machines;

Any types of private information like your name, e-mail, address, phone number, and keyboard input will not be collected.

For more details, visit the Customer Experience Program page at the Parallels website (follow the link in the pane).
This chapter describes how to create a new virtual machine and install a guest operating system in it. The chapter includes an overview of the process and complete how-to instructions.

In This Chapter

Overview ............................................................................................................................... 62
Supported Guest Operating Systems .................................................................................. 64
Typical Configurations ....................................................................................................... 66
Creating a Virtual Machine ............................................................................................. 67
Adding an Existing Virtual Machine .................................................................................. 84
Installing a Guest Operating System ................................................................................ 85
Migrating Data to a New Virtual Machine ........................................................................ 87
Installing Parallels Tools .................................................................................................. 88
Downloading Virtual Appliances ....................................................................................... 103
Overview

Generally, the process of creating a virtual machine includes the following steps:

1 **Creating a virtual machine configuration.** It's like building a real computer from different hardware components. This step is performed with the help of New Virtual Machine Assistant (p. 68). In the Default, Express Windows, Typical modes, New Virtual Machine Assistant creates a virtual machine with the configuration typical for the selected guest OS. To create a virtual machine with a configuration other than the typical one, you can choose the Custom mode. For more details about the installation modes, see Default Installation Mode (p. 70), Express Windows Installation Mode (p. 74), Typical Installation Mode (p. 77), and Custom Installation Mode (p. 79).

2 **Installing a guest operating system.** When you have configured the virtual machine's hardware, you need an operating system to control it. To install an operating system in your virtual machine, you should connect the installation CD/DVD disc or its image to the virtual machine's CD/DVD-ROM drive, as you do to install an operating system in a physical computer. For a list of the supported guest operating systems, see Supported Guest Operating Systems (p. 64).

   For Windows 2003, Windows XP, and Windows Vista virtual machines, New Virtual Machine Assistant provides a special Express Windows Installation Mode (p. 74) that automatically installs the selected Windows guest OS in a newly created virtual machine.

3 **Installing Parallels Tools in the guest OS.** Parallels Tools are available for most of the Windows and Linux operating systems (e.g. Windows 2000/2003/XP/Vista, Red Hat Enterprise Linux 4, Red Hat Enterprise Linux 5, and others) and can be easily installed in your virtual machine. For more information, refer to Installing Parallels Tools (p. 88).

After completing these steps, you may proceed with fine tuning of the virtual machine, such as setting up shared folders, adjusting its screen resolution, or installing applications in it.

Typical Configuration

A typical virtual machine has the following basic virtual hardware:

- CPU
- memory
- hard disk drive
- floppy disk drive
- sound device (except FreeBSD and MS-DOS virtual machines)
- CD/DVD-ROM drive
- network adapter
- USB controller (Windows 98/ME/2000/XP/2003/Vista and all of the Linux typical virtual machines)
- serial port (OS/2 virtual machine)
- parallel port connected to the printer set as default in Mac OS (Windows 95/98/ME/NT/XP/2003/Vista virtual machines). If Parallels Desktop detects no printers connected to the Macintosh computer, it doesn't add a parallel port to the virtual machine configuration.
**Note:** When the virtual machine is created, you can add new virtual devices to it, using the Virtual Machine Configuration dialog (p. 146).
Supported Guest Operating Systems

Parallels Desktop officially supports the following 32-bit guest operating systems:

**Mac OS X**
- Mac OS X Leopard Server 10.5.x

**Windows**
- Windows 7 (experimental)
- Windows Server 2008
- Windows Vista® Home, Business, Ultimate, Enterprise SP0, SP1
- Windows Server® 2003 SP2, R2
- Windows XP Professional SP2, SP3, Home Edition SP2, SP3
- Windows 2000 Server SP4, Advanced Server SP4
- Windows NT 4.0 Server SP6, Workstation SP6
- Windows ME
- Windows 98 SE
- Windows 95
- Windows 3.11
- MS-DOS 6.22

**Linux**
- Red Hat® Enterprise Linux 5.x, 4.x
- CentOS Linux 5.x, 4.x
- Red Hat Linux 9
- Fedora™ Linux 10, 9, 8, 7
- Fedora Core 5
- SUSE® Linux Enterprise Server 10 SP2, 9 SP3
- OpenSUSE Linux 11.x, 10.x
- Debian® Linux 5.0, 4.0
- Ubuntu® Linux 8.x, 7.x
- Xandros Business 4.0

**Solaris**
- Solaris® 10, 9

**BSD**
- FreeBSD® 7.x, 6.x

**OS/2**
- OS/2® Warp 4.5
- eComStation™ 1.2

This version of Parallels Desktop also supports the following 64-bit guest operating systems:

**Mac**
- Mac OS X Leopard Server 10.5.x

**Windows**
- Windows 7 (experimental)
- Windows Server 2008
- Windows Vista Home, Business, Ultimate, Enterprise SP0, SP1
- Windows Server 2003 SP2, R2
- Windows XP Professional SP2

**Linux**
- Red Hat Enterprise Linux 5.x
- CentOS Linux 5.0
- Fedora Linux 10, 9, 8
- SUSE Linux Enterprise Server 10 SP2, 9 SP3
- OpenSUSE Linux 11.x, 10.x
- Ubuntu Linux 8.x, 7.x

**Solaris**
- Solaris 10

**BSD**
- FreeBSD 7.0

*Note:* Parallels Desktop does not provide users with OS ISO images or OS installation discs. You should purchase an OS installation disc or an OS ISO image if you do not have any.
Typical Configurations

The amount of memory and the size of hard disks vary for different guest OSs. Refer to the table below to learn the memory and hard disk values that are allocated to a virtual machine depending on the guest operating system that will be installed in it. Virtual hard disks for typical virtual machines are always created in the expanding format (p. 182).

<table>
<thead>
<tr>
<th>Guest systems</th>
<th>Operating</th>
<th>RAM, MB</th>
<th>Video Memory, MB</th>
<th>Hard Disk, MB</th>
<th>Floppy Drive</th>
<th>CD/DVD drive</th>
<th>Network Adapter</th>
<th>Sound Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X</td>
<td></td>
<td>1024</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Windows 7*</td>
<td></td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Windows Server 2008</td>
<td></td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Windows Vista</td>
<td></td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Windows XP</td>
<td></td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Windows 2003</td>
<td></td>
<td>512</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Windows 2000</td>
<td></td>
<td>256</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Other Windows</td>
<td></td>
<td>256</td>
<td>16</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Red Hat Linux</td>
<td></td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>SUSE Linux</td>
<td></td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Debian GNU/Linux</td>
<td></td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Ubuntu Linux</td>
<td></td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Other Linux</td>
<td></td>
<td>512</td>
<td>3</td>
<td>64,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>FreeBSD 6.x</td>
<td></td>
<td>256</td>
<td>16</td>
<td>32,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>FreeBSD 7.x</td>
<td></td>
<td>256</td>
<td>16</td>
<td>32,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Other FreeBSD</td>
<td></td>
<td>256</td>
<td>16</td>
<td>32,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Other Guest OSes</td>
<td></td>
<td>256</td>
<td>16</td>
<td>8,000</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

* - Windows 7 guest OS is supported experimentally.
Creating a Virtual Machine

This section describes how to use the main tool for creating a virtual machine - New Virtual Machine Assistant.

To start New Virtual Machine Assistant, do one of the following:

- Choose **New Virtual Machine** from the **File** menu.
- Choose **Virtual Machines Directory** from the **Window** menu and, in the displayed window, click the **Add** button.
New Virtual Machine Assistant

The assistant offers several installation modes. You can choose the mode that better fits your needs or your experience with Parallels Desktop. Regardless of what method you select, you will be able to change the configuration of your virtual machine later using the Virtual Machine Configuration dialog (p. 146).

Default Installation

This is a basic installation mode used by default for creating virtual machines. Using this mode, you do not have to specify what kind of operating system you wish to install - Parallels Desktop will try to automatically determine the type and version of the operating system. You only have to specify the source of the operating system installation files and where you wish to store the virtual machine files. New Virtual Machine Assistant creates a virtual machine and starts the installation of the guest operating system.

For more information on this installation mode, see Default Installation Mode (p. 70).

Express Windows Installation

This installation mode is available only for the following guest operating systems: Windows 2003, Windows XP, and Windows Vista. New Virtual Machine Assistant not only creates a virtual machine configuration, but also automatically installs the corresponding guest OS in it. It is the easiest way to make a new virtual machine: you only need to insert a Windows 2003, Windows XP, or Windows Vista installation disc or specify the path to its image file, and New Virtual Machine Assistant will do the rest (including the installation of Parallels Tools). In this mode, virtual machines are created with typical configurations (see Typical Configurations (p. 66) for details) and placed to the default folder (see below).

For more information on this installation mode, see Express Windows Installation Mode (p. 74).

Typical Installation

This installation mode is designed for new users and for fast virtual machine creation. You only have to specify the type and version of the guest operating system that you wish to install and where you wish to store the virtual machine files. New Virtual Machine Assistant creates a typical (for the selected guest OS) virtual machine configuration and starts the installation of the guest OS as interactive installation.

For more information on this installation mode, see Typical Installation Mode (p. 77).

Custom Installation

This installation mode is intended for experienced users only. It allows the user to create configurations other than the typical ones. In this mode, the user is prompted to specify such options for the basic hardware as the amount of RAM, the size and format of a virtual hard disk, and networking parameters. Additional devices can be added later, using the Virtual Machine Configuration dialog (p. 146). After New Virtual Machine Assistant creates a virtual machine configuration, it starts installing the guest OS if such an option was selected.

For more information on this installation mode, see Custom Installation Mode (p. 79).
Default Folders for Virtual Machines

By default, Parallels Desktop is configured to create a new virtual machine folder in the home folder of the user who created it:

/Users/<User_Name>/Documents/Parallels/

where <User_Name> stands for the user's home folder.

However, you can select another folder that will be used as the default folder for your virtual machines.

To specify another default destination for saving virtual machines, do the following:

1. Choose Preferences from the Parallels Desktop menu.
2. In the Preferences window, click the General tab, and specify the default destination for new virtual machines in the Default Folder for virtual machines field.

Note: You can also specify a folder for a virtual machine during its creation. An existing virtual machine can also be moved to a different folder after it is created.
Default Installation Mode

Before creating a virtual machine in the Default mode, make sure that you have an operating system installation disc or its image.

**Note:** Parallels Desktop doesn't provide you with the operating system installation discs and their images. You should purchase the installation disk or its image if you do not have any.

To create a new virtual machine:

1. Start Parallels Desktop and launch New Virtual Machine Assistant by choosing New Virtual Machine from the File menu or choosing Virtual Machines Directory from the Window menu and clicking the + button in the displayed window.

2. In the Introduction window, click Continue to proceed with the virtual machine creation.

3. Parallels Desktop will try to automatically determine the type and version of your operating system. In the Operating System Detection window, specify the source of installation files and click Continue. You can specify the following types of installation media:

   - **Real CD/DVD-ROM Drive.** Select this option if you inserted the installation disc into the optical drive of your Mac. Choose the drive you are using from the Drive list.

   - **CD/DVD Image.** Select this option if you are using a CD/DVD disc image connected to the virtual machine's CD/DVD-ROM drive. Type the path to the file in the File field or use the Choose button to locate the file.

**Note:** Parallels Desktop supports the following types of image files: ISO, CUE, CCD, and DMG.
If you click **Skip Detection**, you will be prompted to choose between the _Express Windows_, _Typical_, and _Custom_ modes of creating a virtual machine.

4 In the **Detected System** window, specify the information necessary for the installation of the detected operating system.
If you click the **Advanced** button, you can set the number of CPUs and the amount of RAM of your future virtual machine. Click **Continue**.

5 In the next step, you should define the main parameters for your virtual machine:

- **Name.** Indicate the name to be assigned to the virtual machine. By default, the virtual machine gets the name of the operating system that you selected to be installed in this virtual machine. If a virtual machine with this name already exists, you will be prompted to specify another name. The name must not exceed 50 characters.

- Select the **Enable file sharing** option if you want to have access to your Mac home folder from your Windows virtual machine. In this case the Mac home folder will appear in the My Computer window as an independent folder.

- Select the **Enable user profile sharing** option if you want to access Mac desktop objects from the virtual machine's Windows desktop. With this option enabled, Windows folders and icons will be substituted with Mac desktop folders and icons, thus, allowing you to access them from both desktops.

**Note:**


2. A number of Windows-specific icons (such as the Recycle Bin and Shared Folders icon) always remain on the Windows desktop.

To specify additional settings, expand the **More Options** area.

- **Create icon on Desktop.** Select this option if you want to create an alias for the virtual machine file on the Mac OS X Desktop.

- **Share virtual machine with other Mac users.** Select this option if you want to share this virtual machine with other users of your Mac. In this case the virtual machine file (PVM file) will be saved in the `\Users\Shared` folder on your Mac.

**Note:** If you don't select this option, the virtual machine file will be saved in your home folder: `/<UserName>/Documents/Parallels/`.

This option also allows you to share the following Mac OS X user folders to your Windows virtual machine: Documents, Pictures, and Music.
If you click the **Advanced** button, you can set the number of CPUs and the amount of RAM of your future virtual machine. Click **Create**.

6. After the virtual machine is created, in the **Prepare to Install Operating System** window, click **Start** to begin the installation.

If you decide to install another operating system, you can specify the source of new installation files in the **Boot Options** section:

- **Real CD/DVD-ROM Drive.** Select this option to use a disc inserted into the CD/DVD drive of your Mac. Choose the drive to use from the **Drive** list.

- **CD/DVD Image.** Select this option to use a CD/DVD disc image connected to the virtual machine's CD/DVD drive. Type the path to the file in the **File** field or use the **Choose** button to locate the file.

When the installation is completed, install Parallels Tools if they are available for the guest OS you just installed. Refer to the **Installing Parallels Tools** section (p. 88).
Express Windows Installation

1. Start Parallels Desktop and launch New Virtual Machine Assistant by clicking **New Virtual Machine** from the **File** menu or choosing **Virtual Machines Directory** from the **Window** menu and clicking the **+** button in the displayed window.

2. In the **Introduction** window, click **Continue** to proceed with the virtual machine creation.

3. In the **Operating System Detection** window, click **Skip Detection**.

4. In the **Select Operating System Type and Version** window, select the Windows Server 2003, Windows XP, or Windows Vista guest OS and click **Continue**.

5. In the **Virtual Machine Type** window, select **Express Windows** and click **Continue**.

6. In the **Express Windows Installation** window, specify your user details and the Windows product key necessary for the Windows guest OS installation.

   If you click the **Advanced** button, you can set the number of CPUs and the amount of RAM of your future virtual machine. Click **Continue**.

   **Note:** If you do not enter the Windows product key on this step, you will have to provide it later when the Windows guest OS installation starts.

7. Define the main parameters for your virtual machine:

   - **Name.** Indicate an arbitrary name to be assigned to the virtual machine. By default, the virtual machine gets the same name as the operating system that will be installed inside this VM. If a virtual machine with such a name already exists, you will be prompted to indicate another name. The name must not exceed 50 characters.

   - Select the **Enable file sharing** option if you want to have access to your Mac home folder from your Windows virtual machine. In this case the Mac home folder will appear in the My Computer window as an independent folder.

   - Select the **Enable user profile sharing** option if you want to access Mac desktop objects from the virtual machine's Windows desktop. With this option enabled, Windows folders and icons will be substituted with Mac desktop folders and icons, thus, allowing you to access them from both desktops.

   **Note:** A number of Windows-specific icons (such as the Recycle Bin and Shared Folders icon) always remain on the Windows desktop.

   In the **More Options** section, you can configure the following virtual machine parameters:

   - **Create icon on Desktop.** Select this option if you want to create a shortcut to the virtual machine configuration file on the Mac OS X Desktop.

   - **Share virtual machine with other Mac users.** Select this option if you want to share this virtual machine with other users of your Mac. In this case all virtual machine-related files will be saved in the \Users\Shared folder on your Mac.

   - **Location.** Use the **Choose** button if you want to change the default location of the virtual machine-related files.

   This option also allows you to share the following user folders to Windows: Documents, Pictures, and Music. You can share all these folders or only some of them. To this effect, enable this option and go to the **Shared Profile Options** (p. 161) pane of Virtual Machine Configuration.
If you click the **Advanced** button, you can set the number of CPUs and the amount of RAM of your future virtual machine. Click **Create**.

8 After the virtual machine is created, in the **Prepare to Install Operating System** window, specify the source of installation files and click **Start**. You can use the following types of installation media:

- **Real CD/DVD-ROM Drive**. Select this option to use a disc inserted into the CD/DVD drive of your Mac. Choose the drive to use from the **Drive** list.

- **CD/DVD Image**. Select this option to use a CD/DVD disc image connected to the virtual machine's CD/DVD drive. Type the path to the file in the **File** field or use the **Choose** button to locate the file.

**Note:** Parallels Desktop does not provide users with OS ISO images or OS installation discs. You should purchase an OS installation disc or an OS ISO image if you do not have any.
9 After you click **Start**, New Virtual Machine Assistant will automatically start the new virtual machine and install the guest operating system in it. After the guest OS has been successfully installed, Parallels Desktop installs Parallels Tools.

During the unattended installation, Parallels Desktop creates an administrator account with a blank password. When the guest OS installation is complete, we recommend that you change the password in order to protect the safety of your data.

To change the administrator password in Windows Vista:

1. Click the **Start** menu, then select **Control Panel -> User Accounts and Family Safety -> Change your Windows password**.

To change the administrator password in Windows XP (Professional Edition):

1. Click the **Start** menu, then select **Control Panel -> Administrative Tools -> Computer Management**.

2. In the **Computer Management** window, open **System Tools -> Local Users and Groups -> Users**. Right-click the **Administrator** account and choose **Set Password** from the context menu.

For changing the password in other versions of Windows, refer to the Microsoft Windows Help: **Start -> Help and support**.
Typical Installation Mode

1. Start Parallels Desktop and launch New Virtual Machine Assistant by clicking **New Virtual Machine** on the **File** menu or choosing **Virtual Machines Directory** from the **Window** menu and clicking the `+` button in the displayed window.

2. In the **Introduction** window, click **Continue** to proceed with the virtual machine creation.

3. In the **Operating System Detection** window, click **Skip Detection**.

4. In the **Select Operating System Type and Version** window, select the guest OS you plan to install inside your virtual machine and click **Continue**.

5. In the **Virtual Machine Type** window, select **Typical** and click **Continue**.

6. In the **Name and Location** window, define the main parameters for your virtual machine:
   - **Name**. Indicate an arbitrary name to be assigned to the virtual machine. By default, the virtual machine gets the same name as the operating system that will be installed inside this VM. If a virtual machine with such a name already exists, you will be prompted to indicate another name. The name must not exceed 50 characters.
   - Select the **Enable file sharing** option if you want to have access to your Mac home folder from your Windows virtual machine. In this case the Mac home folder will appear in the My Computer window as an independent folder.
   - Select the **Enable user profile sharing** option if you want to access Mac desktop objects from the virtual machine's Windows desktop. With this option enabled, Windows folders and icons will be substituted with Mac desktop folders and icons, thus, allowing you to access them from both desktops.

   **Note:** A number of Windows-specific icons (such as the Recycle Bin and Shared Folders icon) always remain on the Windows desktop.

In the **More Options** section, you can configure the following virtual machine parameters:

- **Create icon on Desktop**. Select this option if you want to create a shortcut to the virtual machine configuration file on the Mac Desktop.

- **Share virtual machine with other Mac users**. Select this option if you want to share this virtual machine with other users of your Mac. In this case all virtual machine-related files will be saved in the `\Users\Shared` folder on your Mac.

- **Location**. Use the **Choose** button if you want to change the default location of the virtual machine-related files.

   This option also allows you to share the following user folders to Windows: Documents, Pictures, and Music. You can share all these folders or only some of them. To this effect, enable this option and go to the **Shared Profile Options** (p. 161) pane of **Virtual Machine Configuration**.

If you click the **Advanced** button, you can set the number of CPUs and the amount of RAM of your future virtual machine.
After the virtual machine is created, in the **Prepare to Install Operating System** window, specify the source of installation files and click **Start**. You can use the following types of installation media:

- **Real CD/DVD-ROM Drive.** Select this option to use a disc inserted into the CD/DVD drive of the computer. Choose the drive to use from the **Drive** list.

- **CD/DVD Image.** Select this option to use a CD/DVD disc image connected to the virtual machine's CD/DVD drive. Type the path to the file in the **File** field or use the **Choose** button to locate the file.

**Note:** Parallels Desktop does not provide users with OS ISO images or OS installation discs. You should purchase an OS installation disc or an OS ISO image if you do not have any.
Note: If your Mac OS version is Mac OS Leopard, and you want to use the F8 key when installing the Windows guest OS, refer to Using F8 Key in Windows Virtual Machine on Mac OS X (p. 265).

When the installation is complete, install Parallels Tools if they are available for the guest OS you just installed. Refer to the Installing Parallels Tools section (p. 88).

Custom Installation Mode

1 Start Parallels Desktop and launch New Virtual Machine Assistant by clicking New Virtual Machine from the File menu or choosing Virtual Machines Directory from the Window menu and clicking the + button in the displayed window.

2 In the Introduction window, click Continue to proceed with the virtual machine creation.

3 In the Operating System Detection window, click Skip Detection.

4 In the Select Operating System Type and Version window, select the type and version of guest OS you want to install in this virtual machine and click Continue. You can either select an operating system from the list, or select Other in case you cannot find the required one there.

5 In the Virtual Machine Type window, select Custom and click Continue.

6 In the CPU and Memory Options window, specify the number of CPU(s) and the amount of RAM for the virtual machine and click Continue. You may use the slider or arrow buttons to set the value or simply type it into the corresponding field.
7 In the **Hard Disk Options** window, select the type of virtual hard disk you want to use and click **Continue**. You can create a new hard disk image, use an existing one or a Boot Camp partition, or create a virtual machine without any hard disk at all.

In the current version of Parallels Desktop, you can use your Boot Camp Windows Vista (SP1) or Windows XP (SP2 or SP3) partition as a bootable disk or as a data disk in virtual machines. For more information about using Boot Camp partition as a virtual hard disk for a virtual machine, see the **Using the Boot Camp Partition in a Virtual Machine** chapter (p. 240).

![Hard Disk Options window]

8 If you have selected the **No hard disk** option, go to Step 9.

If you chose to create a new virtual hard disk on the previous step, in the **New Virtual Hard Disk** window, specify the size and type for the disk and click **Continue**. If you have chosen to use an existing image file, in the **Existing Virtual Hard Disk** window, specify the hard disk image to be connected, its interface type and position. Click **Continue**.

![New Virtual Hard Disk window]
9 In the **Networking Type** window, select the type of networking you want to use in the virtual machine and click **Continue**.

- **Shared Networking**. If you select this option, the virtual machine will use the host computer's network connections and will be visible only for the host computer and other virtual machines registered on this server.
- **Bridged Networking**. If you select this option, the virtual machine will be visible on the network as a separate computer.
- **Host-Only Networking**. If you select this option, the virtual machine will access only the host computer and the virtual machines running on it.
- **No Networking**. If you select this option, the virtual machine will have no network adapter.

**Note**: You may reconfigure the networking settings after the virtual machine is created, using the Virtual Machine Configuration dialog (p. 146).

If you selected **Bridged Networking**, on the next step you will need to select the network adapter to be used by the virtual machine:

- **Default Adapter**. Select this option to use the adapter specified as default in the primary OS.
- **Parallels Shared Networking Adapter**. Select this option to use Parallels Shared Networking adapter installed together with Parallels Desktop.
- **Parallels Host-Only Networking Adapter**. Select this option to use Parallels Host-Only Networking adapter installed together with Parallels Desktop.

The host computer network adapters included in this list are also available for selecting. Select the **Connected** option if you want the virtual machine to start up with this network adapter connected.

10 In the **Optimization Options** window, select the optimization mode you prefer and click **Continue**. The available options are:

- **Virtual machine (Recommended)**. Select this option to allocate more host computer resources to the virtual machine and its applications.
- **Mac**. Select this option to allocate more resources to the host computer and its applications.

11 In the **Name and Location** window, define the main parameters for your virtual machine:

- **Name**. Indicate an arbitrary name to be assigned to the virtual machine. By default, the virtual machine gets the same name as the operating system that will be installed inside this VM. If a virtual machine with such a name already exists, you will be prompted to indicate another name. The name must not exceed 50 characters.

In the **More Options** section, you can configure the following virtual machine parameters:

- **Create icon on Desktop**. Select this option if you want to create a shortcut to the virtual machine configuration file on the Mac desktop.
- **Share virtual machine with other Mac users**. Select this option if you want to share this virtual machine with other users of your Mac. In this case all virtual machine-related files will be saved in the `\Users\Shared` folder on your Mac.
- **Location**. Use the **Choose** button if you want to change the default location of the virtual machine-related files.
- **Enable file sharing.** Select this option if you want to have access to your Mac home folder from your Windows virtual machine. In this case the Mac home folder will appear in the My Computer window as an independent folder.

- **Enable user profile sharing.** Select this option if you want to access Mac desktop objects from the virtual machine's Windows desktop. With this option enabled, Windows folders and icons will be substituted with Mac desktop folders and icons, thus, allowing you to access them from both desktops.

**Note:** A number of Windows-specific icons (such as the Recycle Bin and Shared Folders icon) always remain on the Windows desktop.

This option also allows you to share the following user folders to Windows: Documents, Pictures, and Music. You can share all these folders or only some of them. To this effect, enable this option and go to the **Shared Profile Options** (p. 161) pane of Virtual Machine Configuration.
12 After the virtual machine is created, in the **Prepare to Install Operating System** window, specify the source of installation files and click **Start**. You can use the following types of installation media:

- **Real CD/DVD-ROM Drive.** Select this option to use a disc inserted into the CD/DVD drive of the computer. Choose the drive to use from the **Drive** list.

- **CD/DVD Image.** Select this option to use a CD/DVD disc image connected to the virtual machine's CD/DVD drive. Type the path to the file in the **File** field or use the **Choose** button to locate the file.

**Note:** Parallels Desktop does not provide users with OS ISO images or OS installation discs. You should purchase an OS installation disc or an OS ISO image if you do not have any.

---

**Note:** If your Mac OS X version is Mac OS X Leopard, and you want to use the F8 key when installing the Windows guest OS, refer to **Using F8 Key in Windows Virtual Machine on Mac OS X** (p. 265).

When the installation is complete, install Parallels Tools if they are available for the guest OS you just installed. Refer to the **Installing Parallels Tools** section (p. 88).
Adding an Existing Virtual Machine

If you already have a virtual machine stored on your Mac, but it is missing from Virtual Machines Directory (p. 34), you can easily add it by opening its PVM file in Parallels Desktop.

Parallels Desktop 4 enables you to work with your virtual machines created in Parallels Desktop 3.0 and in other virtualization products, including VMware Fusion, Virtual PC, and VirtualBox. All you need is to convert them to Parallels Desktop 4 format. The converting is performed when you add these virtual machines to Parallels Desktop.

To add a virtual machine that already exists on your Mac:

1 When you opened Parallels Desktop for the first time, you can add an existing Parallels, VMware, Virtual PC, or VirtualBox virtual machine from the welcome window (p. 31) by clicking the Import Virtual Machines button. Afterwards, you will be able to add existing virtual machines from the menu by choosing File > Open or from Virtual Machines Directory by clicking the Open button.

2 In the Finder window, locate the virtual machine's file or folder and double-click it to open.

3 Select the virtual machine configuration file and click Open.
   - Parallels configuration files have a .pvs extension.
   - VMware configuration files have a .vmx extension.
   - Virtual PC configuration files have a .vmc extension.
   - VirtualBox configuration files have an .xml extension.

   **Note:** Parallels Desktop and VMware Fusion virtual machines may be stored in Mac OS X as bundles of files. The configuration file is stored inside the virtual machine bundle.

4 If you selected a Parallels virtual machine, its window will open. The virtual machine will be added to Virtual Machines Directory. If you selected a third-party virtual machine, Parallels Transporter will launch to guide you through the steps of converting this virtual machine to Parallels Desktop 4 format.

If your copy of Parallels Desktop is not activated, you will be prompted to activate it when the virtual machine is added to Parallels Desktop 4. For more information about the activation, see Activating Parallels Desktop.
Installing a Guest Operating System

You can install a guest operating system on a virtual machine from a CD or DVD, or from an image file of such CD/DVD. Some operating systems are available on CD/DVD disc images only.

In some cases, the installation cannot be performed from a real CD/DVD disc because of disc reading problems. In such cases, it is recommended that you try to install the operating system from a CD/DVD disc image of this disc. ISO images of CD/DVD discs can be created using a third party imaging utility.

**Note:** MacBook Air users can install a guest operating system from a CD/DVD disc image only.

In this version, you can also install the guest operating system using a PXE server via network.

Some operating systems are installed only from floppy disks. Most of the Intel-based Macintosh computers do not have floppy drives. Nevertheless, you can install such operating systems using images of installation diskettes or using real floppy disk drives inserted into an external USB floppy disk drive. You can create floppy disk images using third-party applications.

### Installing from a CD/DVD disc or its image

1. Open Parallels Desktop and select the virtual machine in **Virtual Machine Directory**.
2. To connect the installation medium, open Virtual Machine Configuration by:
   - right-clicking the machine and choosing **Configure** from the shortcut menu, or
   - choosing **Configure** from the **Virtual Machine** menu.
3. Select **CD/DVD-ROM** in the sidebar and configure the virtual CD/DVD-ROM drive settings.
   - If you are installing from a real CD/DVD:
     - Select the **Real Device** option and specify the real drive to connect in the **CD/DVD-ROM** list.
     - Insert the CD/DVD disc with the operating system files into the appropriate drive of your computer.
   - If you are installing from an image file:
     - Select the **Image file** option and specify the path to the image file in the **File** field.

   **Note:** You can use ISO, DMG, CUE, and CCD images for installing the guest operating system.

4. Click **OK** in Virtual Machine Configuration to save the changes.

5. Start your virtual machine by clicking **Start** on the toolbar.

The installation will launch soon after the virtual machine is started.
Notes: When installing a Windows guest OS, you may need to press F8 or other functional keys in a virtual machine. If you use MacBook or MacBook Pro keyboard, click inside the virtual machine window to capture the keyboard and mouse input and press Fn+F8 combination instead. You can configure Parallels Desktop to use any other key for performing the same action as F8 does. To release the keyboard and mouse input back to Mac OS X, press Ctrl+Alt. For more information, refer to Keyboard and Mouse Preferences (p. 43) and Capturing and Releasing the Keyboard and the Mouse (p. 108).

Installing from the network

1. Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.

2. Click the Add button in the bottom part of the Virtual Machine Configuration dialog to launch Add Hardware Assistant.

3. Add a network adapter (p. 207) to your virtual machine configuration.

4. Open the Boot Order pane in Virtual Machine Configuration and change the boot sequence to make the virtual network adapter the first device in the sequence. To this effect, select Network Adapter in the list, and use the arrow buttons to move it to the top of the list.

5. Click OK to apply the changes.

6. Start the virtual machine by clicking Start on the toolbar.

Soon after your virtual machine is started, a list of available PXE servers appears.

During the installation, when the guest OS reboots for the first time, or after the installation, return the boot sequence to booting from the hard disk.

Installing from a floppy disk image

1. Select the virtual machine and make sure that it is stopped.

2. To connect the installation medium, open Virtual Machine Configuration by:
   - right-clicking the machine and choosing Configure from the shortcut menu, or
   - choosing Configure from the Virtual Machine menu.

3. Select the Floppy Disk pane in the sidebar and specify the path to the floppy image disk file in the Image File field.

4. Click OK to apply the changes.

5. Start the virtual machine by clicking Start on the toolbar.

The installation will launch soon after the virtual machine is started.

Reinstalling the guest OS

The procedure of reinstalling the guest OS is the same as the procedure of installing the guest OS: provide the installation media or its image, connect it to the virtual machine, and start the virtual machine. The reinstalling will launch soon after the virtual machine is started.
Note: In this version of Parallels Desktop, you can reinstall the guest OS of the same type only. However, you are free to choose the guest OS version.

Keep in mind that in some cases, it is easier just to create a new virtual machine, install the guest OS, and delete the old machine after moving all the necessary data to the new one.

### Migrating Data to a New Virtual Machine

Apart from creating a new virtual machine from scratch with the help of **New Virtual Machine Assistant** (p. 68), you can create it through migration using Parallels Transporter.

Parallels Transporter enables you to migrate selected volumes or the whole of a physical computer or a VMware, Virtual PC, and VirtualBox virtual machine into a Parallels virtual machine or Parallels virtual disk. Depending on what kind of computer you want to migrate, you can choose among several migration scenarios. For the detailed description and functions of these scenarios, refer to **Using Parallels Transporter** (p. 248).

For your convenience, Parallels Transporter has two migration modes: *express* and *advanced*. With the *express* mode, you can easily and quickly migrate the needed computer into a Parallels virtual machine using the predefined settings. Or you may choose the *advanced* mode and define some of the settings during migration, such as the volumes you want to migrate or the type of destination output.

To learn more detailed information about the migration principles and benefits, you can refer either to the **Using Parallels Transporter** (p. 248) section or to **Parallels Transporter User's Guide**.

To create a new virtual machine through migration:

1. Launch Parallels Desktop.
2. From the **File** menu of Parallels Desktop, choose **Run Parallels Transporter**. Parallels Transporter opens.

   **Note:** You can also open Parallels Transporter from the following location: `/Applications/Parallels`.

3. Follow the assistant's instructions. **Parallels Transporter User's Guide** will help you choose the migration scenario and will guide you through the migration assistant.
Parallels Desktop includes a set of specially developed utilities that help you use your virtual machines in the most comfortable and efficient way.

Parallels Tools are located on the disc images that are installed along with Parallels Desktop. There is a separate Parallels Tools disc image for each type of the supported guest operating systems.

- **prl-tools-win.iso** - disc image with Parallels Tools for Windows guest operating systems.
- **prl-tools-lin.iso** - disc image with Parallels Tools for Linux guest operating systems.
- **prl-tools-mac.iso** - disc image with Parallels Tools for Mac OS X Server Leopard.

These disc images can be found in the following location on your Mac: `/Library/Parallels/Tools/`. 
Parallels Tools Overview

Parallels Tools are a suite of special utilities that help you use your virtual machines in the most comfortable and efficient way. With Parallels Tools, you can move the mouse seamlessly outside the guest OS window without pressing any key, change the virtual machine's screen resolution by simply resizing its window, and synchronize your virtual machine's time and date settings with the time settings of the host computer.

Parallels Tools include the utilities listed below. Many of these utilities are available for the most popular Windows, Linux, and Mac OS X operating systems, but some of them are available for the supported Windows and Linux operating systems only. All utilities supported by your guest OS are installed in your virtual machine as a single package when you install Parallels Tools.

Mouse Synchronization Tool
- Windows
- Linux, OS/2
- Mac OS X
Mouse Synchronization Tool captures the mouse input in the virtual machine each time the pointer moves over to the guest OS window and automatically releases the input when the pointer moves out of the guest OS window.

Time Synchronization Tool
- Windows
- Linux, OS/2
- Mac OS X
Time Synchronization Tool enables you to customize your virtual machine and the host computer time settings. With this tool, you can:
  - Automatically synchronize the time settings of your virtual machine with the host computer time settings.
  - Set up and maintain the time difference between your host computer and the guest OS installed in your virtual machine.

Drag-and-Drop Tool
- Windows
Drag-and-Drop Tool supports copying files between the guest operating systems and Mac OS X by the drag-and-drop method.

Clipboard Synchronization Tool
- Windows
Clipboard Synchronization Tool enables you to easily exchange texts between:
  - different virtual machines irrespective of the guest operating systems installed in them.
  - a virtual machine and your Mac.

Dynamic Resolution Tool
- Windows
Dynamic Resolution Tool enables you to work with dynamic resolution. When you resize the guest OS window by dragging its lower right corner, the guest OS window resolution changes automatically.

Shared Folders Tool
- Windows
Shared Folders Tool enables you to share the primary OS folders to access them from the guest OS. With this tool, you can access the host computer shared folders from the virtual machine.

Coherence Tool
- Windows
The Coherence tool hides your Windows virtual machine's window leaving only the virtual machine's applications windows visible side-by-side with your Mac OS X applications. This tool enables you to work in Windows applications coherently with your Mac OS X applications.
<table>
<thead>
<tr>
<th>Tool</th>
<th>Platform(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shared Profile Tool</td>
<td>Windows</td>
<td>Enables you to map some of the folders in your Mac home folder to your user folders in the virtual machine, which allows you to access your Mac home folders right from your virtual machine.</td>
</tr>
<tr>
<td>Shared Applications Tool</td>
<td>Windows</td>
<td>Enables you to specify default applications, including those installed in the virtual machine, for different types of files. With this tool, you can make some types of files open in the Mac OS X applications by default, and others in the Windows applications by default.</td>
</tr>
<tr>
<td>Shared Internet Applications</td>
<td>Windows</td>
<td>Enables you to specify default Internet browsers, including those installed in the virtual machine, for different types of Internet pages. For example, you may set the http pages to open in your default Mac OS X Internet browser, and ftp pages to open in the Internet browser installed in your virtual machine.</td>
</tr>
<tr>
<td>SmartMount</td>
<td>Windows</td>
<td>Enables the automatic detection and mounting of removable devices in your virtual machines.</td>
</tr>
<tr>
<td></td>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mac OS X</td>
<td></td>
</tr>
</tbody>
</table>

Parallels Compressor Windows The Parallels Compressor utility enables you to reduce the size of your virtual machine's hard disk.

After the Parallels Tools installation, the following features are available for settings up in Parallels Desktop:

- Windows Server 2008
- Windows Vista
- Windows XP
- Windows Server 2003
- Windows 2000

**Note:** If Parallels Tools are not installed in the aforementioned Windows guest operating systems, the virtual machines with these guest OSs will not get connected to the network.

Parallels Tools can be installed in the following Windows guest operating systems:

- glibc 2.3.4 and later
- libstdc++ 3.4.6 and later (libstdc++.so.6)
- gcc 3.4.6 and later (including C++ support)
- make 3.80
- X Window System X11R6.7, X11R6.8, X11R6.8.99, X11R7.0, X11R7.1, X11R7.2 (1.3), X11R7.3 (1.4)
- kernel sources or development package

**Note:** Some of Parallels Tools, like Shared Folders Tool and Time Synchronization Tool, may also work in those of the Linux operating systems that do not comply with the requirements listed above.
Parallels Tools can be installed in the following Mac OS X guest operating systems:

- Mac OS X Leopard Server 10.5.x
Installing Parallels Tools in a Windows guest OS

If you created your virtual machine using the Express Windows mode, Parallels Tools were installed automatically after the installation of the Windows guest operating system.

If your virtual machine was created in the Typical or Custom mode, do the following to install Parallels Tools in it:

1. Start the virtual machine and log in to the guest operating system.
2. When the guest OS boots up, connect the Parallels Tools ISO image by choosing the Install Parallels Tools option from the Virtual Machine menu.

   **Note:** If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be installed in your guest operating system. To see the list of guest OSs supported by Parallels Tools, refer to the Parallels Tools Overview section in Parallels Desktop Help available through the Help menu.

3. In the Welcome window, click Install. The wizard will start the automatic installation.
4. When the installation is complete, click Reboot to exit the wizard and restart the virtual machine.

You can also install Parallels Tools manually:

1. Start the virtual machine and log in to the virtual machine guest OS.
2. When the guest OS boots up, connect the Parallels Tools ISO image by right-clicking the CD/DVD-ROM icon in the virtual machine's window status bar and choosing Connect Image.

3. In the Finder window, go to the hard disk folder (normally named "Macintosh HD"), select the /Library/Parallels/Tools/ folder, select the prl-tools-win.iso file, and click Open to connect it to the virtual machine.

   **Note:** If you cannot find the /Library/Parallels/Tools/ folder, make sure that you selected the Library folder at the highest level of Macintosh HD, not in your user home folder.

4. In the virtual machine, open My Computer and double-click the Parallels Tools disc icon to expand its contents.

   **Note:** If the installation wizard does not launch automatically, right-click the disc, choose Open from the shortcut menu, and double-click Setup.exe to launch the installer.

5. Follow the wizard's instructions to complete the installation.

To edit the settings of Parallels Tools installed in your virtual machine, use the Services pane of the Virtual Machine Configuration dialog.

How to check if Parallels Tools are installed
If you are not sure whether Parallels Tools are installed, you can easily check this. Start your virtual machine and look at the status bar of its window: if the tip "Press Ctrl + Alt to release the mouse and keyboard" appears in the status bar of the virtual machine's window, this means that Parallels Tools are not installed. When Parallels Tools are installed, you do not need to press any key to release the mouse and keyboard - they are released automatically.
Installing Parallels Tools in a Linux guest OS

Before installing Parallels Tools in a Linux guest OS, make sure that you have the gcc package and kernel sources installed. If these packages are not installed, the Parallels Tools installer will warn you. The kernel sources package name depends on the type of Linux operating system you use: it can be *kernel-devel*, or *kernel-headers*, or something else. For more information about the kernel sources, refer to the Installing the GCC package and Kernel Sources in Linux (p. 267) section.

*Note:* To install Parallels Tools in your virtual machine, you must have the root privileges.

Installing Parallels Tools in the most recent versions of Linux guest OSs

If you have one of the most recent versions of Linux OSs (Fedora 10) in your virtual machine, the *prl-tools-lin.iso* image file will be mounted automatically after you connect it to the CD/DVD-ROM drive. To install Parallels Tools, do the following:

1. Start the virtual machine.
2. When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels Tools.

*Note:* If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be installed in your guest operating system. To see the list of guest OSs supported by Parallels Tools, refer to the Parallels Tools Overview section in Parallels Desktop User's Guide.

3. The *prl-tools-lin.iso* image file will be connected to the virtual machine's CD/DVD-ROM drive and mounted.

You can connect and mount the Parallels Tools ISO image file manually. Right-click the CD/DVD-ROM icon in the virtual machine's window status bar and choose Connect Image. In the Finder window, go to the hard disk folder (normally named "Macintosh HD"), select the */Library/Parallels/Tools/*/ folder, select the *prl-tools-lin.iso* file, and click Open to connect it to the virtual machine.

4. Start a terminal in your Linux guest OS. Type the following command to gain the root privileges:

   ```
   su
   ```

5. Change the directory to the CD/DVD-ROM directory using

   ```
   cd /media/cdrom/
   ```

   *Note:* In some of the Linux operating systems, the mount point for the virtual CD/DVD-ROM drive may appear as */media/Parallels\ Tools/.*

6. In the CD/DVD-ROM directory, enter the following command to launch Parallels Tools installation:

   ```
   ./install
   ```

7. Follow the Parallels Tools Installer instructions to complete the installation.

8. When the installation of Parallels Tools is complete, restart your virtual machine.

Installing Parallels Tools in other versions of Linux guest OSs
To install Parallels Tools in the older versions of Linux OSs, you have to mount the `prl-tools-lin.iso` image file manually. Do the following:

1. Start the virtual machine.
2. When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels Tools.

   **Note:** If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be installed in your guest operating system. To see the list of guest OSs supported by Parallels Tools, refer to the Parallels Tools Overview section in Parallels Desktop User’s Guide.

   The `prl-tools-lin.iso` image file will be connected to the virtual machine's CD/DVD-ROM drive.

3. Start a terminal in your Linux guest OS. Type the following command to gain the root privileges:

   ```
   su
   ```

4. Check if the Parallels Tools CD image is mounted by entering:

   ```
   mount | grep iso9660
   ```

   - If this command does not return anything, proceed to the next step.
   - If this command returns anything like
     ```
     /dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0),
     ```
     skip the next step and proceed to the following one.
   - If this command returns anything like
     ```
     /dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0)
     ```
     with the noexec option present in parentheses, you need to unmount the disc using the following command and then proceed to the next step:

   ```
   umount /dev/cdrom
   ```

5. To mount the Parallels Tools installation disc image, enter the following:

   ```
   mount -o exec /dev/cdrom /media/cdrom
   ```

   **Note:** `/dev/cdrom` is the virtual machine's CD/DVD-ROM drive and `/media/cdrom` is the mount point for this device. In some of the Linux operating systems the virtual CD/DVD-ROM drive may appear as `/dev/hdb` and the mount point `/mnt/cdrom`. Some Linux OSs do not have the CD/DVD-ROM mount point. In this case, you should create the mount point directory manually.

6. When the installation disc image is mounted, change the directory to the CD/DVD-ROM directory using:

   ```
   cd /media/cdrom/
   ```

7. In the CD/DVD-ROM directory, enter the following to launch Parallels Tools installation:

   ```
   ./install
   ```

   **Note:** You must have the root privileges to run this command.

8. Follow the Parallels Tools Installer instructions to complete the installation.

   When the installation of Parallels Tools is complete, restart your virtual machine.

   **Note:** If X Server fails to start in your virtual machine, you can install Parallels Tools manually in text mode (p. 266).

9. To edit the settings of Parallels Tools installed in your virtual machine, use the Services pane of the Virtual Machine Configuration dialog.
How to check if Parallels Tools are installed

If you are not sure whether Parallels Tools are installed, you can easily check this. Start your virtual machine and look at the status bar of its window: if the tip "Press Ctrl + Alt to release the mouse and keyboard" appears in the status bar of the virtual machine's window, this means that Parallels Tools are not installed. When Parallels Tools are installed, you do not need to press any key to release the mouse and keyboard - they are released automatically.

Troubleshooting

Parallels Tools installer can be blocked by SELinux. To solve this problem:

1. Start a terminal and determine your version of kernel by entering

   ```
   uname -r
   ```

   2.6.18-8.el5 is the version of your kernel.

2. Open the /boot/grub/grub.conf file or /boot/grub/menu.lst (depends on the version of your Linux operating system) and find the entry that corresponds to your version of kernel.

   ```
   title Red Hat Enterprise Linux Server (2.6.18-8.el5)
   root (hd0,0)
   kernel /vmlinuz-2.6.18-8.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet
   initrd /initrd-2.6.18-8.el5.img
   ```

3. Type the following text at the end of the entry:

   ```
   selinux=0
   ```

   and the whole entry will be:

   ```
   kernel /vmlinuz-2.6.18-8.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet
   selinux=0
   ```

4. Save the file and restart the virtual machine.

After the restart, mount the Parallels Tools disc image and try to install Parallels Tools.
Installing Parallels Tools in Mac OS X

To install Parallels Tools in Mac OS X Server Leopard:

1. Start the virtual machine, and log in to the guest OS.

2. When the guest OS boots up, connect and mount the Parallels Tools ISO image file by choosing the Install Parallels Tools option from the Virtual Machine menu.

**Note:** If the Install Parallels Tools option is greyed out, make sure that Parallels Tools support your guest operating system. To view the list of guest OSs which are supported by Parallels Tools, refer to the Parallels Tools Overview subsection of Parallels Desktop User's Guide.

You can connect and mount the Parallels Tools ISO image file manually. Right-click the CD/DVD-ROM icon in the virtual machine's window status bar and choose Connect Image. In the Finder window, go to the hard disk folder (normally named "Macintosh HD"), select the /Library/Parallels/Tools/ folder, select the prl-tools-mac.iso file, and click Open to connect it to the virtual machine.

3. Open the mounted image of the disk and double-click the Guest OS Tools For Mac OS X icon to start the installation.

4. In the Welcome window, click Continue.

5. In the Select a Destination window, specify the location for Parallels Tools. Click Continue.

6. In the Standard Install on "Macintosh HD" window, if you need to set a different location for Parallels Tools, you can do it by clicking Change Install Location. Click Install to continue the installation. Type the password when prompted.

   In the Installation window, you can see the process of Parallels Tools being installed in your virtual machine.

7. When the installation is complete, click Restart to exit the assistant and restart your virtual machine.

To edit the settings of Parallels Tools installed in your virtual machine, use the Services pane of the Virtual Machine Configuration dialog.

How to check if Parallels Tools are installed

If you are not sure whether Parallels Tools are installed, you can easily check this. Start your virtual machine and look at the status bar of its window: if the tip "Press Ctrl + Alt to release the mouse and keyboard" appears in the status bar of the virtual machine's window, this means that Parallels Tools are not installed. When Parallels Tools are installed, you do not need to press any key to release the mouse and keyboard - they are released automatically.
Installing Parallels Tools in OS/2 and eComStation Guest OSs

All of the OS/2 and eComStation tools can be installed from the prl-tools-other.iso CD image. Network drivers can also be installed from the prl-tools-os2.fdd floppy disk image file during the operating system installation. The latter is easier in most cases.

Before starting the installation you should connect the CD-ROM image with Parallels Tools to your virtual machine's CD-ROM drive. Choose Install Parallels Tools from the Virtual Machine menu.

Mouse Synchronization Tool Installation

Mouse Synchronization Tool consists of the mouse driver and video filter.

*Note:* To install Mouse Synchronization Tool, you should have a VESA video driver installed (e.g. SDD or GENGRADD). For instructions on how to install this video driver, refer to the OS/2 documentation.

To install Mouse Synchronization Tool:

1. Click the Drives icon on the system panel. Select the CD-ROM drive and locate the `<CD-ROM drive>\Drivers\Mouse\OS2` directory.

   *Note:* When installing the driver on eComStation 1.2, go to the `<CD-ROM drive>\Drivers\Mouse\ECS12` directory.

2. Launch the `INSTALL.CMD` batch file. `INSTALL.CMD` copies files and makes necessary modifications to the `CONFIG.SYS` file.

3. Restart the guest OS/2 operating system.

Clipboard Synchronization Tool Installation

In OS/2 and eComStation you have to launch Clipboard Synchronization Tool manually. This tool is an ordinary application and should be treated as such. If you want Clipboard Synchronization Tool to start automatically when your guest operating system is started, copy the `PrlClip.exe` tool file to the virtual machine's hard disk and include it into the autostart group (`startup.cmd` file or another file used in the guest operating system for similar purposes).

Clipboard Synchronization Tool is located in the `<CD-ROM drive>\ClipBrd\OS2` directory on the CD image containing Parallels Tools.

Sound Driver Installation

Before installing Sound Driver, make sure you have the multimedia support installed in the OS/2 guest OS.

To install Sound Driver:

1. Click the System Setup icon on the system panel.

2. Select Install/Remove line and then select Multimedia Application Install.
3 In the IBM Multimedia Presentation Manager/2 - Installation window choose the CD-ROM drive, then the `<CD-ROM drive>\Drivers\Sound\OS2` directory. Select the **ALC Codec** feature and click the **Install** button.

4 Restart the OS/2 guest operating system.

**Network Driver Installation**

To install Realtek RTL8029 driver inside the OS/2 Warp version 4.5:

1 Click the **System Setup** icon on the system panel.

2 Click the **MPTS Network Adapters and Protocol Services** icon to open the Multi-Protocol Transport Services window.

3 Click **Configure**.

4 In the window that appears, click **Configure** again.

5 In the **Adapter and Protocol Configuration** window, click the **Other adapters** button below the **Network Adapters** section.

6 In the **Copy Additional Network Adapter Drivers** window specify the path to the Parallels driver on the CD-ROM disc image. The path will be like the one below:

   `<CD-ROM drive>\Drivers\Network\RTL8029\NDIS2OS2`

7 Click **OK**. The Parallels network adapter driver will be copied. After this you can see the name **RTL8029 PCI Ethernet Adapter** included in the **Network Adapters** list. Select this name.

8 Click **Change** in the **Network Adapters** section of the window to replace the current network adapter by the selected one.

9 Click **OK** when the message "Are you sure you want to change this network adapter?" is displayed. After you click OK, the **RTL8029 PCI Ethernet Adapter** appears in the appropriate field of the **Current Configuration** section of the window. Now if you click **Edit** in the **Current Configuration** section of the window, you will see that you do not need to configure any properties for this driver, because it is self-configurable.

10 Click **OK** when finished.

11 Close both the **Configure** and **Multi-Protocol Transport Services** windows.

12 Click **Exit** in the **Update CONFIG.SYS** window.

13 Exit the configuration program and restart the guest OS.
Updating Parallels Tools

The procedure of updating Parallels Tools depends on the guest operating system they are installed in.

In a Windows guest OS

Parallels Desktop automatically checks for new Parallels Tools updates when you start your virtual machine.

If a newer version of Parallels Tools is available, you will see the corresponding message offering you to download and update the tools. Click **Yes** to download Parallels Tools from the Parallels Update server and install them into your virtual machine. Updating will start right after the download finishes and will prompt you to restart the virtual machine when it is complete.

If you do not want to update Parallels Tools or want to do it later, click **No**. You will be able to update them later by using the Update Parallels Tools option from the **Virtual Machine** menu.

**Note:** If you revert to a snapshot that was made when you had an earlier version of Parallels Tools in your virtual machine, you will also be offered to update them.

In a Linux guest OS

In Linux guest operating systems, you should manually check for Parallels Tools updates from time to time.

To update Parallels Tools:

1. Start the virtual machine.
2. To update Parallels Tools, you should mount the `prl-tools-lin.iso` image and launch Parallels Tools Installer. See **Installing Parallels Tools in a Linux Guest OS** (p. 94) for detailed information how you can do it.
3. Follow the Parallels Tools Installer instructions. When prompted to choose the action to perform, select **Update** and press Enter.
4. When the updating is complete, restart your virtual machine.

In Mac OS X Server Leopard

In Mac OS X guest operating systems, you should manually check for Parallels Tools updates from time to time.

To install Parallels Tools

1. Start the virtual machine.
2. When the guest OS boots up, choose **Install Parallels Tools** from the **Virtual Machine** menu of Parallels Desktop.
3. This will connect the `prl-tools-mac.iso` image to your virtual machine's CD/DVD-ROM.
4 Open the Parallels Tools CD-ROM mounted on the virtual machine's desktop and double-click the Install icon.

5 In the Welcome window, click Continue.

6 In the Select a Destination window, specify the disk for Parallels Tools to be installed to and click Continue.

7 In the Standard Install on "Macintosh HD" window, click Install. Specify your name and password when prompted.

When the updating is complete, click Restart to quit the installer and restart your virtual machine.
Removing Parallels Tools

Parallels Tools can be removed through a general procedure of removing applications from the operating system installed in your virtual machine.

Removing from a Windows guest OS
1  Start the virtual machine and log in to the guest OS.
2  From the Windows Start menu, choose Control Panel > Add or Remove Programs. In Windows Vista, choose Control Panel > Programs and Features.
3  Select Parallels Tools in the list and click Remove.
4  When Parallels Tools are removed, restart the guest operating system.

Removing from a Linux guest OS
1  Start the virtual machine.
2  To remove Parallels Tools, you should connect and mount the prl-tools-lin.iso image and launch Parallels Tools Installer. See Installing Parallels Tools in a Linux Guest OS (p. 94) for detailed information how you can do it.
3  Follow the Parallels Tools Installer instructions. When prompted to choose the action to perform, select Remove and press Enter.
4  When Parallels Tools are successfully removed, press Enter to close the window.

Removing from Mac OS X Server Leopard
1  Start the virtual machine, and log in to the guest OS.
2  To remove Parallels Tools, you should connect and mount the prl-tools-mac.iso image and launch Parallels Tools Installer. See Installing Parallels Tools in Mac OS X (p. 97) for detailed information how you can do it.
3  Open the mounted image of the disc and double-click the Uninstall Parallels Tools icon to start the uninstallation.
4  In the Welcome window, click Uninstall. Enter the password when prompted.
5  In the Uninstallation window, you can see the process of Parallels Tools being removed from your virtual machine.
6  In the Uninstallation Completed window, click Restart to finish the uninstallation and quit the assistant.
Setting Up a Virtual Machine

Download Virtual Appliances

If you do not have enough time to create a new virtual machine with the required configuration, you can download a ready-to-use virtual machine with a predefined configuration. Besides the basic configuration, pre-built virtual machines also may have a set of applications installed in the guest OS, so that you do not have to spend time on installing and setting up the required software.

Such pre-built virtual machines with target services and applications installed in the guest OS are called Parallels Virtual Appliances. Virtual appliances are built by the Parallels experts and are available for downloading at the Parallels Technology Network page. You can also access the virtual appliances online storage via the Parallels Desktop menu by choosing Download from the File menu. Parallels Desktop redirects you to the Parallels Technology Network page where you will be able to choose the virtual machines that suit you most.

To start using a virtual appliance, do the following:

1. On the Parallels Technology Network page, click the virtual appliance's title to view configuration details and the guest OS administrative credentials.

2. Download the desired virtual appliance by clicking the GET APP link and choosing the download link with the suitable archive file format.

3. When the virtual appliance file is downloaded, open it and double-click the PVS file to start the virtual machine.
CHAPTER 6

Working in a Virtual Machine

This chapter provides the information on the main operations you can perform in a running virtual machine. These operations include:

- Starting, stopping, and resetting the virtual machine.
- Pausing or suspending the virtual machine.
- Starting the virtual machine in Safe Mode.
- Switching between different view modes.
- Capturing the keyboard and mouse input in and releasing it from the virtual machine.
- Installing different applications in the virtual machine.
- Using Mac keyboard shortcuts in the virtual machine (p. 112).
- Creating aliases for your favorite Windows applications in Max OS X.
- Making images of the whole Mac OS X desktop or any of its parts and have them displayed on top of all windows in the virtual machine.
- Enabling/disabling the 3D graphics support in the virtual machine.
- Connecting USB devices to and disconnecting them from the virtual machine.

In This Chapter

Starting, Stopping and Resetting a Virtual Machine ............................................................. 105
Suspending and Pausing a Virtual Machine ................................................................. 107
Capturing and Releasing the Keyboard and Mouse Input .................................................... 108
Changing the View Mode ..................................................................................................... 109
Using Safe Mode .............................................................................................................. 111
Using Keyboard Shortcuts in a Virtual Machine ................................................................. 112
Installing Applications in a Virtual Machine ................................................................. 113
Setting Up Parallels Internet Security ............................................................................ 114
Placing an Image on Top of the Virtual Machine Window .................................................. 115
Using 3D Graphics Applications ......................................................................................... 116
Making Guest OS Screenshots ......................................................................................... 116
Setting Up a Printer in Virtual Machine ............................................................................ 117
Connecting USB Devices to a Virtual Machine ............................................................... 123
Synchronizing a USB Palm OS Device With the Guest OS ................................................ 125
Changing the Configuration at Runtime ............................................................................. 126
Starting, Stopping and Resetting a Virtual Machine

Starting a Virtual Machine

To start a virtual machine, do one of the following:

- Right-click the virtual machine in the Parallels Virtual Machines dialog and choose the Start option. For detailed information on this dialog, see Parallels Virtual Machines Dialog (p. 34).

- Click the virtual machine in the Parallels Virtual Machines dialog and click the Start button in the Parallels Desktop toolbar.

- Click the virtual machine in the Parallels Virtual Machines dialog and choose Start from the Virtual Machine menu.

After starting the virtual machine, it will boot into the guest operating system installed in this virtual machine. If no guest operating system is installed in the virtual machine, you will see the following message: "No boot device is available...".

Note: You can start virtual machines only if your copy of Parallels Desktop is activated. See the Activating Parallels Desktop section (p. 20) for details.

Stopping a Virtual Machine

To turn off the virtual machine, use the standard shutdown procedure of the guest operating system installed in it or click the Shut Down button in the Parallels Desktop toolbar. If the guest operating system cannot be shut down for some reason or other, you can forcibly stop the virtual machine by doing one of the following:

- clicking the Stop button in the Parallels Desktop toolbar or
- choosing Stop from the Virtual Machine menu.

Warning: If you forcibly stop the virtual machine, you may lose all unsaved data.

Resetting a Virtual Machine

If some program error has caused your virtual machine to hang, you may wish to reset the virtual machine.

To reset the virtual machine, do one of the following:

- Choose Reset from the Virtual Machine menu.

- Click the Reset button in the Parallels Desktop toolbar. If this button is absent from the toolbar, refer to the Customizing Toolbar subsection (p. 41).

- Press Ctrl+Alt+Del while the keyboard input is captured inside a virtual machine window.
**Warning:** If you reset the virtual machine, you may lose all unsaved data.
Suspending and Pausing a Virtual Machine

Starting and shutting down virtual machines may take a considerable amount of time. Instead of performing these operations, you can pause or suspend a virtual machine for the required time and quickly resume it later.

**Suspending a Virtual Machine**

Suspending a virtual machine is similar to putting a real computer into the sleep mode. When you suspend a virtual machine, you save its current state (including the state of all applications and processes running in the virtual machine) to a special file on your Mac. When the suspended virtual machine is resumed, it continues operating at the same point the virtual machine was at the time of its suspending.

Suspending your virtual machine may prove efficient if you need to restart your Mac, but do not want to:
- quit the applications running in the virtual machine
- spend much time on shutting the guest operating system down and then starting it again

To suspend a virtual machine, do one of the following:
- choose **Suspend** from the **Virtual Machine** menu or
- click the **Suspend** button in the Parallels Desktop toolbar.

You can see the progress of saving the virtual machine's state in the **Suspending** window.

**Warning:** If you edit the configuration of a suspended virtual machine, you will not be able to resume this virtual machine.

To resume a suspended virtual machine, click the **Resume** button in the Parallels Desktop toolbar or choose **Resume** from the **Virtual Machine** menu.

**Pausing a Virtual Machine**

Pausing a virtual machine releases the resources, such as RAM and CPU, currently used by this virtual machine. The released resources can then be used by the host computer and its applications or by other virtual machines running on the host computer.

**Note:** Only the amount of RAM used by the guest OS will be released. The memory used by the Parallels Desktop application will still be locked.

To pause a virtual machine, do one of the following:
When a virtual machine is paused, its window is grayed out. To continue running the virtual machine, click the Start button in the Parallels Desktop toolbar or choose Resume from the Virtual Machine menu.

Parallels Desktop is designed to operate like an ordinary computer application. This means that you do not have to change the virtual machine's state from running to paused, suspended, or stopped before putting your Mac to sleep. In sleep mode, your Mac does not allocate any resources to the running applications (including Parallels Desktop and all virtual machines) so that they are stopped automatically. As you start your Mac, all the applications are automatically up and running again.

**Note:** By default, you cannot suspend or pause your Boot Camp virtual machine because this may damage the Boot Camp partition. For detailed information on suspending your Boot Camp virtual machine, see Suspending a Boot Camp Virtual Machine (p. 270).

## Capturing and Releasing the Keyboard and Mouse Input

To start working in your virtual machine, you need first to capture the keyboard and mouse input in the virtual machine. To this effect:

- move the mouse pointer over the virtual machine window and
- click in the window.
- When the keyboard and mouse input is captured in the virtual machine, you cannot move the pointer out of the virtual machine window and all keystrokes and button clicks go to the virtual machine. To release the keyboard and mouse back to the primary OS, press Ctrl+Alt. The keyboard and mouse will be released immediately.

**Note:** The default hot key combinations can be configured on the Keyboard and Mouse pane (p. 43) of the Preferences dialog.

If you want to automatically capture and release the keyboard and mouse input when switching between the primary OS and the virtual machine, you should install Parallels Tools (p. 88) in your virtual machine. After the Parallels Tools installation, you can capture and release the mouse and keyboard input more easily:

- click anywhere in the virtual machine window to capture the input
- click anywhere outside the virtual machine window to release the input.
Changing the View Mode

Parallels Desktop provides a number of view modes to make your work with virtual machines more comfortable and efficient:

- **Window mode.** In this mode the virtual machine screen is displayed as a separate window. This is the default view mode.
- **Full Screen mode.** In this mode the virtual machine screen is expanded to occupy the whole of your physical computer's screen.
- **Coherence mode.** In this mode the virtual machine's desktop is invisible so that you can see the virtual machine's application windows in Mac OS X and work with them side by side with your Mac OS X applications.
- **Modality mode.** In this mode you can view the virtual machine and the programs running inside it in a transparent window while working in Mac OS X. By default, this window appears on top of all opened windows, so you can supervise your virtual machine during your work in Mac OS X.

For switching between these modes, you can use the View menu commands or toolbar buttons.

**Switching to the Full Screen Mode**

You can run a guest operating system in the Full Screen mode when the guest operating system window occupies the whole screen and all Mac OS X and Parallels Desktop controls are hidden. To see the Mac OS X Dock and the Parallels Desktop menus while working in the Full Screen mode, press Ctrl+Alt.

To switch to the Full Screen mode, do one of the following:

- Click the Full Screen button \[\text{Full Screen button}\] in the Parallels Desktop toolbar.
- Choose Full Screen from the View menu.
- Use the appropriate hot key combination (Alt+Enter by default).

**Note:** The default hot key combinations can be configured on the Keyboard and Mouse pane (p. 43) of the Preferences dialog.

You may also choose the type of animation that will be displayed when switching to the Full Screen mode and back. For details, please refer to Appearance Preferences (p. 47).

To return to the Window mode:

- press the appropriate hot key combination (Alt+Enter by default) or
- press Ctrl+Alt to display the Parallels Desktop menus and choose Window from the View menu.

**Switching to the Coherence Mode**

The Coherence mode provides the highest level of integration between Mac OS X and your guest operating system. In this mode, you can have the Mac OS X Dock, Windows taskbar, and any applications running under these operating systems on one desktop. For more information on the Coherence mode, see Working in the Coherence Mode (p. 129).
To switch a running virtual machine to operate in the Coherence mode, do one of the following:

- Click the **Coherence** button in the Parallels Desktop toolbar.
- Choose **Coherence** from the **View** menu.
- Use the appropriate hot key combination (Shift+Ctrl+Alt by default).

**Note:** The default hot key combinations can be configured on the **Keyboard and Mouse** pane (p. 43) of the **Preferences** dialog.

To switch the virtual machine from Coherence to another mode:

- choose the **Window** or **Full Screen** option from the **View** menu or
- use the appropriate hot key combination (Shift+Ctrl+Alt by default).

**Switching to the Modality Mode**

When you switch to Modality, you can resize the virtual machine windows and place them side by side with your Mac's applications. A Modality window can be scaled to any size, and its content will still be active, which allows you to monitor the tasks running inside the virtual machine while you are working on the Mac's side.

To switch a running virtual machine to the Modality mode, do one of the following:

- Choose **Modality** from the **View** menu.
- Click the **Modality** button in the Parallels Desktop toolbar.
- Use the appropriate hot key combination (Ctrl+Alt+Cmd+Enter by default).

**Note:** The default hot key combinations can be configured on the **Keyboard and Mouse** pane (p. 43) of the **Preferences** dialog.

To switch the virtual machine from Modality to another view mode:

- Choose **Window**, **Full Screen**, or **Coherence** from the **View** menu.
- Use the appropriate hot key combination (Ctrl+Alt+Cmd+Enter by default).

When you switch back from Modality to the Window view mode, the toolbar is hidden. If you want to add it back to the virtual machine window, choose **Show Toolbar** from the **View** menu.

To customize the Modality settings, refer to the **Modality** pane (p. 171) of Virtual Machine Configuration.
Using Safe Mode

If you do not want a virtual machine to store the changes you make to it during the working session, you can start this virtual machine in Safe Mode. To be able to start the virtual machine in Safe Mode, you need to add the Safe Mode button to the Parallels Desktop toolbar first. To this effect:

1. Right-click the toolbar in the virtual machine's window and choose Customize Toolbar (p. 41).
2. Drag the Safe Mode button to the toolbar and click Done.

When you have added the Safe Mode button to the toolbar, you can use this button for starting the virtual machine in Safe Mode. When you shut down a virtual machine operating in Safe Mode, you will be asked whether you want to discard the changes made to the virtual machine's hard disk or to apply them:

- If you choose to discard the changes, the virtual machine's hard disk will be left intact and no changes made to it during your work in Safe Mode will be saved.
- If you choose to apply the changes, the virtual hard disk will keep all the changes made to it during your work in Safe Mode. After applying the changes, the virtual machine will not be able to return to the state it had before you started this virtual machine in Safe Mode.

If you want the virtual machine to permanently work in Safe Mode, you can enable the Undo Disks option in the Startup and Shutdown (p. 151) pane of Virtual Machine Configuration (p. 146):

1. Choose Configure from the Virtual Machine menu to open the virtual machine configuration.
2. Click the Startup and Shutdown tab in the left pane of Virtual Machine Configuration.
3. In the Startup and Shutdown pane, select the Enable undo disk option and click OK.

For more information about the Undo Disks option, refer to Startup and Shutdown Settings (p. 151).

Usage Tip

Running the virtual machine in Safe Mode can be useful when testing the behaviour of some applications to make sure that they cannot damage your computer.
Using Keyboard Shortcuts in a Virtual Machine

Parallels Desktop enables you to use Mac keyboard shortcuts in your virtual machine.

If you want to press Ctrl+Alt+Del key combination in a virtual machine, use one of the following techniques:

- Choose Send Keys > Ctrl+Alt+Del from the Virtual Machine menu,
- press Ctrl+Alt+Del while the keyboard input is captured inside a virtual machine window.

Using Keyboard shortcuts in MacBook and MacBook Pro

- To use the F1-F12 keys in your virtual machine, press the Fn+(F1-F12) key combination instead.

For additional information, see also Keyboard and Mouse Preferences (p. 43).
Installing Applications in a Virtual Machine

You can install additional software inside your virtual machine in the same way as you would do on any other real computer:

- using a CD or DVD disc or image file containing the application installation files
- using a real USB drive containing the application installation files
- by installing the necessary application from the network.

If you want to install an application from a real CD/DVD-ROM drive on your Mac, connect it first to the virtual machine and then insert the disc into this drive. For detailed information on how to connect CD/DVD-ROM drives to your virtual machine, refer to Adding a CD/DVD-ROM Drive (p. 204).

If you want to install an application from an existing CD or DVD image file, specify the path to the virtual machine in Virtual Machine Configuration. For detailed information on connecting image files to your virtual machine, refer to Adding a CD/DVD-ROM Drive (p. 204).

If you want to install an application from a USB device, you should first add a USB controller to the virtual machine using Virtual Machine Configuration. For detailed information on how you can do it, refer to Adding a USB Controller (p. 213).

If you want to install an application through the network, first make sure that your virtual machine is connected to it. By default, all virtual machines created in the Express or Typical modes are set to operate in the Shared Networking mode. In this mode, your virtual machine can access the Internet while being invisible to other computers on the network, except your Macintosh computer and the other virtual machines running on it. For more information on connecting virtual machines to the network and available network mode, refer to Networking in a Virtual Machine (p. 192).
Setting Up Parallels Internet Security

Parallels Desktop includes a built-in antivirus application - Parallels Internet Security powered by Kaspersky®. This application can be installed into a Windows virtual machine after the Parallels Tools installation. Parallels Internet Security is provided with a one year free activation key. When the trial period expires, you can purchase a permanent activation key.

**Note:** Parallels Internet Security is available for Windows Vista and Windows XP guest operating systems only.

**Setting up Parallels Internet Security**

In three days after Parallels Tools installation, you will be offered to install Parallels Internet Security. To install Parallels Internet Security, click **Install** and follow the wizard's instructions.

To install Parallels Internet Security manually:

1. Launch Parallels Desktop and start the virtual machine from Virtual Machines Directory.
2. When the virtual machine boots up, make sure that you have Parallels Tools (p. 88) installed. To install them, choose **Install Parallels Tools** from the **Virtual Machine** menu.

   **Note:** If you created your virtual machine using the Express Windows mode, Parallels Tools should have been installed automatically after the installation of the Windows guest operating system.

   The virtual machine will reboot when the installation of Parallels Tools is complete.

3. When you log in after rebooting, choose **Install Parallels Internet Security** from the **Virtual Machine** menu. Parallels Internet Security Installer will launch, offering you to protect your guest operating system by activating Parallels Internet Security. Please take into account that it may take some time the installer to start. After the installer has started, click **Install** to install Parallels Internet Security. The installation is performed in the unattended mode and the software is activated automatically. You can view the operation progress in the progress bar.

4. When the installation is complete, click **Reboot** in the **Install Succeed** window to close the wizard and to restart the virtual machine.

   Now you have a one year antivirus protection in your virtual machine.

**Removing Parallels Internet Security**

If you do not need Parallels Internet Security in your Windows virtual machine, you can quit the installer by clicking the **Cancel** button or, if it is already installed, remove it like any other Windows application using the **Add or Remove Programs** dialog. The free trial period starts from the moment of the first installation, and won't be restarted if you reinstall Parallels Internet Security later.
Placing an Image on Top of the Virtual Machine Window

Parallels Desktop allows you to create images (also called *clips*) of the whole Mac OS X desktop or any of its parts. When taken, these images are automatically placed over your opened virtual machine window and remain visible irrespective of what applications you run or what window you open in your virtual machine. For example, you can create a clip containing some important information and always have this information right before your eyes when working in the virtual machine. You can also take a clip of some part of an application running on your Mac and have it displayed when working with another application in your virtual machine without need to switch between these applications. Using clips may prove especially efficient if you are running your virtual machine in the full screen mode.

To make a clip:

1. Open the virtual machine.
2. Choose **Make Clip** from the **Virtual Machine** menu.
3. Using the left mouse button, select the area you want to capture.
4. When you release the mouse button, the resulting clip will appear on top of all open window. It will remain visible even if you switch your virtual machine to Full Screen.
After the clip has been successfully created, you can manage it as follows:

- Save the clip to your Mac OS X desktop by right-clicking it and choosing **Save on Desktop**.
- Close the clip by clicking the close button in the clip window. If the clip was not saved before, it will be irrevocably removed from your Mac.
- Copy the clip to the clipboard by right-clicking it and choosing **Copy to Clipboard**.
- Change the clip size by dragging the lower right corner of the clip window.
- Allow the clip to be overlaid by applications and windows that you open in your virtual machine by right-clicking it and disabling the **Always on Top** option.

### Using 3D Graphics Applications

With Parallels Desktop, you can run games and applications that require video cards with DirectX or OpenGL support in your Windows virtual machines.

The DirectX9.0 and OpenGL2.1 support can be enabled for virtual machines with Windows 2000, Windows Server 2003, Windows XP, Windows Vista, and Windows Server 2008 guest operating systems that have Parallels Tools installed.

**Enabling DirectX and OpenGL support in a virtual machine**

If your virtual machine does not have Parallels Tools installed:

1. Start the virtual machine and choose **Install Parallels Tools** from the **Virtual Machine** menu to launch the installation.
2. When Parallels Tools are installed, shut down the virtual machine.

To enable DirectX and OpenGL support in the virtual machine configuration:

1. Open the virtual machine and choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
2. In the **Video** pane (the **Hardware** group of settings), select the **Enable 3D acceleration** option.
3. Click **OK** to apply the changes.

**Note:** If the virtual machine is running, the new settings will come into effect after you restart the virtual machine.

### Making Guest OS Screenshots

If you want to make a screenshot of the guest operating system when it is running, choose **Make Screenshot** from the **View** menu. The first screenshot file will be named **Parallels Picture.png** and placed on Mac OS X desktop. The next screenshots will have the same name with an appropriate number added.
Setting Up a Printer in Virtual Machine

There are four basic ways to set up printing in a virtual machine. You can:

- Share any of the printers connected to your Mac computer via a parallels port of your virtual machine (p. 118)
- Set up a USB printer (p. 119)
- Set up a printer via Apple's Bonjour Printer wizard (p. 120)

**Note:** This way is available in Windows guest OSs only.

- Use a network printer (p. 121)
Sharing a Mac Printer

You can share any printer connected to you Mac with your Windows or Linux virtual machine. The printer will be available through the virtual machine's parallel port.

To share your Mac's printer:

1. Launch Parallels Desktop and open the virtual machine.
2. Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual Machine menu. Make sure that the configuration includes a parallel port. If necessary, add it. See Adding a Parallel Port (p. 210).
3. In the Parallel Port pane, make sure that the Enabled option is selected. Select Connected, if you want the printer to be automatically connected on the virtual machine startup.
4. Select the Printer option. You can choose a specific printer from the printers list or use the Default printer option if you want to use the default printer set in the primary OS.
5. Click OK to close Virtual Machine Configuration.
6. Start the virtual machine.

In a Windows guest OS, if you have Parallels Tools installed, the HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS printer is automatically connected to your virtual machine and you can use it at once. In a Linux guest OS or if you do not have Parallels Tools installed in your Windows guest OS, no matter what type of printer you have, install either the HP Color LaserJet 8500 PS, or Apple Color LW 12/660 PS printer driver and then follow the procedure of adding a printer in a guest OS described below.

Warning: Do not install the driver from the installation CD, supplied with your printer, in the virtual machine.

Adding a printer in a Windows guest operating system

To add a printer in a Windows guest OS:

1. Start the Windows virtual machine and log in as administrator.
2. Open the Windows Start menu, select Control Panel.
3. In the Control Panel window, select the Printers and Faxes (or Printers, or Printers and Other Hardware) item.
4. Open the Add Printer wizard:
   - In Windows XP click the Add a printer link.
   - In Windows 95/98/NT/ME/2000/2003 double-click the Add printer icon.
5. In the Add Printer wizard:
   - In Windows Vista:
     - click Add a local printer,
     - select Use an existing port and click Next.
   - In Windows 2000/XP/2003:
     - click Next in the wizard's first dialog,
- in the Local or Network Printer dialog, click Local printer attached to this computer.

- In Windows 98/ME:
  - click Next in the wizard's first dialog,
  - for the How is this printer attached to your computer? select the Local printer option.

- In Windows 95/NT:
  - click Local printer.

6 Continue with the general installation procedure and install either HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS driver.

Adding a printer in a Linux guest operating system

To add a printer in a Linux guest OS:

1 Start the Linux virtual machine and log in as administrator.

2 Open the /etc/printcap/ configuration file and click the Add option.

3 Select the type of printer to add: Local printer. Click Ok.

4 Printtool will attempt to detect any printers which are attached to your parallel port and will show you the results. Click Ok.

5 Specify the details about your printer, such as a name of the printer and its related spool directory, the location of the printer device and other options.

6 The Input Filter contains information about your specific printer and its formatting requirements. To add your printer's information, click Select. The Configure Filter dialog will open.

7 Choose the printer type: choose either HP Color LaserJet 8500 PS or Apple Color LW 12/660 PS driver. You can also set here other printing parameters. Click Ok.

Setting Up a USB Printer

To set up a USB printer:

1 Launch Parallels Desktop and choose the virtual machine.

2 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog. Make sure that the configuration includes a USB controller. If necessary, add it. See the Adding a USB Controller section (p. 213).

3 Open the USB Settings pane and make sure that the Enabled option is selected. Select the Connected if you want the printer to be automatically captured by the virtual machine. Click OK.

4 Start the virtual machine.

5 Plug in the USB printer as a USB device. See the Connecting USB Devices to a Virtual Machine section (p. 123).

6 Install the native driver for the printer in the guest OS.
Setting Up a Printer via Bonjour

You can set up a printer via Bonjour only in Windows guest OSs.

To set up a printer using the Bonjour Printer wizard:

1. Launch Parallels Desktop.
2. Start your Windows virtual machine and log in.
3. In the virtual machine, download the Bonjour for Windows installation package from the Apple site.
4. Install Bonjour for Windows by launching the BonjourSetup.exe file from the folder to which it was downloaded.
5. Start the Bonjour Printer wizard either by clicking its icon on the desktop or by selecting Start -> Programs -> Bonjour -> Bonjour Printer wizard.
6. Follow the installation steps until the Install Bonjour Printer window appears.
7. In the Install Bonjour Printer window, select Generic in the Manufacturer list and then Generic / Postscript in the Model list for any printer model you are going to use.
8. Follow the rest of the installation steps.
Setting Up a Network Printer

You can install a network printer directly into a guest OS.

Before installing a network printer in a guest OS, make sure that:

- Networking in the primary and guest OSs is configured.
- The virtual machine network adapter is connected to the corresponding virtual machine and enabled. To do this:
  - Select **Configure** from the **Virtual Machine** menu.
  - Click the **Network Adapter** item in the left pane.
  - Make sure that the **Enabled** and **Connected** options are selected. If they are cleared, select these options and click OK.
- The user account in the guest OS from which you will setup the printer has permissions to access the network printer.
- You know the printer's IP address.

After that, you can log into your guest OS and install a network printer.

In a Windows Guest Operating System

Before adding a network printer to Windows, download and install an appropriate printer driver.

The procedure of adding a network printer is almost the same for all Windows guest OSs. To add a network printer in Windows XP or Windows Vista:

1. Choose **Control Panel** from the **Start** menu in your guest OS.
2. Click **Printers and Faxes** in Windows XP or **Printers** in Windows Vista.
3. Click the **Add printer** icon.
4. In the **Add Printer** wizard introduction window, click **Next**.
5. In Windows XP, select the **Local printer attached to this computer** option and disable **Automatically detect and install my Plug and Play printer**.
   - In Windows Vista, choose the **Add a Local Printer** option.
6. Select **Create a new port** and specify **Standard TCP/IP port** as the port type.
   - Click **Next**.
7. In the next window, specify the printer's IP address and click **Next**.
8. If prompted to specify additional port information, choose **Standard** and select **Generic Network Card** from the list.
9. In the next window, click **Finish**.
10. In the **Install Printer Software** window, specify the manufacturer of the driver and select the model of the network printer.
    - If the required printer model is not listed, click the **Have Disk** button and specify the path to the `.inf` file in the driver installation folder.
    - When finished, click **Next**.
Follow the wizard's instructions to complete the installation.

**In a Linux or FreeBSD Guest Operating System**

Make sure that the following components are installed in your guest Linux or FreeBSD system:

- Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS site;
- Samba service. Installation instructions can be found at Samba site;
- A Web browser, since we consider controlling CUPS via web interface;

**Note:** To set up a network printer, you should have the **root** privileges.

Before adding a network printer to Linux, download and install an appropriate printer driver.

To add a network printer in a Linux or FreeBSD guest OS:

1. Start your Linux or FreeBSD virtual machine.
   
   In a terminal, type the command:
   
   ```
   /etc/init.d/cups start
   ```
3. Start a web browser and type either the IP address of your virtual machine or `http://127.0.0.1:631`.
4. Click the **Add Printer** button.
5. In the **Add New Printer** window, enter a printer name, location, and description.
6. In the **Device for <Printer Name>** window, select the **Windows Printer via Samba**.
7. In the **Device URI for <Printer Name>** window, specify the path to the network printer in the following format:
   
   ```
   smb://<computer name>/<printer name>
   ```
8. In the **Make/Manufacturer for <Printer Name>** window, select the model of your printer.
9. Enter the **root** password when prompted.
10. CUPS performs installation. If the installation is successful, the "**Printer <name> has been added successfully**" message is displayed.
Connecting USB Devices to a Virtual Machine

Parallels Desktop provides you with the possibility to connect up to eight USB 2.0 and eight USB 1.1 devices to a single virtual machine. This means that you can plug up to eight USB 2.0 devices and eight USB 1.1 devices into your Mac and use them from the virtual machine. To use this feature, you should add a USB controller to the virtual machine configuration (p. 146). If the USB controller is already present in the virtual machine configuration, make sure it is enabled.

By default, when you plug a USB device into your Mac, the New USB Device dialog asks if you want to connect this device to your Mac or to the virtual machine you are currently working with.

- Click **Connect it to the computer** if you want to use this USB device in Mac OS X.
- Click **Connect it to this virtual machine** if you want to use this USB device in the virtual machine you are currently working with.

**Note:** If you select to connect the detected USB device to the virtual machine and then reboot this virtual machine, the New USB Device dialog will not appear again after the reboot. The USB device will still be connected to this virtual machine.

If you want Parallels Desktop to remember your choice, select **Remember this association**. The next time you plug this USB device into your Mac, it will be automatically connected to the destination you specified in this dialog. To change the destination, use USB Preferences in the Preferences dialog (p. 41).
If you do not want Parallels Desktop to display this dialog each time a USB device is plugged into your Mac, configure **USB Preferences** in the **Preferences** dialog (p. 41).

To be able to use the USB device in the virtual machine, you may need to install the necessary drivers in the guest OS. By default, such drivers can be obtained from the manufacturers of this device.

**Note:** If you plug a USB 1.1 device into the USB 2.0 port, the port will be identified as USB 1.1.

---

### Connecting the iSight camera to a Windows virtual machine

If you have the iSight camera built in your Mac, you can use it in your Windows XP or Windows Vista virtual machine. Before connecting the camera, you should install the iSight driver for Windows to your virtual machine. There are different possibilities to install the driver. For example, you can install the iSight driver with the Boot Camp drivers to your virtual machine:

1. Insert the Mac OS X Leopard disc or "Mac OS X Install Disc 1" into your computer.
2. Start your Windows virtual machine.
3. Click the CD/DVD-ROM icon in the virtual machine status bar, select **Real CD/DVD-ROM**, and connect the Mac OS X installation disc.
4. The Boot Camp drivers installer starts. If the installer does not start automatically, browse the Mac OS X disc using Windows Explorer and double-click the *setup.exe* file in the **Boot Camp** folder.
5. Follow the installer instructions. When the installation is finished, restart your virtual machine.

**Note:** The iSight driver for Windows is suitable for built-in cameras only. External cameras are not supported.

To connect the iSight camera, click the USB controller icon in the virtual machine status bar and select the iSight camera in the list.
Synchronizing a USB Palm OS Device With the Guest OS

The process of connecting a USB Palm device to the virtual machine is similar to the process of connecting other USB devices, but for some minor details.

1. When you plug a USB Palm OS device into your Mac, you should click the Synchronize button on the Palm device's screen to make it visible to your Mac.

2. Your Mac will recognize the Palm device and displays a message asking whether you want to connect it directly to the active virtual machine or to use this device with your Mac. To be able to work with the Palm device in the virtual machine, click Connect it to this virtual machine.

If you want Parallels Desktop to remember your choice, select Remember this association. The next time you plug this USB device into your Mac, it will be automatically connected to the destination you specified in this dialog. To change the destination, use USB Preferences (p. 53) in the Preferences dialog available from the Parallels Desktop menu.

3. The Palm device appears in the list of USB devices available for usage in the virtual machine, and the data synchronization process starts.

If you encounter problems when synchronizing the Palm OS device with your virtual machine, click Cancel on the screen of the Palm device to terminate the process and try to start the synchronization again.

Note: It is not recommended to change the USB port for the Palm device or connect other USB devices to your Mac during the synchronization session.
Changing the Configuration at Runtime

Parallels Desktop allows you to connect or disconnect certain devices at runtime or switch some of them for using other media.

Generally, the following virtual devices can be connected or disconnected at runtime:

- Floppy disk drive
- CD/DVD-ROM drives
- Network adapter
- Sound device
- USB device
- Shared folders

Note: Only devices enabled in the virtual machine configuration can be connected or disconnected at runtime.

You can configure any of these devices in one of the following ways:

- Use the necessary command from the Devices menu in the menu bar. This menu is available only when the virtual machine is running.
- Click a device icon on the status bar (p. 39) and choose the command from a device shortcut menu.
  The status bar displays the devices information when the virtual machine is running.
- Drag and drop an image file (*.iso or *.fdd) or a shared folder on the appropriate device icon on the status bar. This option is available only for CD/DVD-ROM drives, floppy drives and shared folder only.

Connecting a CD/DVD-ROM or a Floppy Drive

If you have several CD/DVD-ROM drives connected to your virtual machine, in the Devices menu they are listed in the same order as they were connected. The first CD/DVD-ROM drive will be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on.

Connecting a Network Adapter

You can set up any of the three network modes: Shared Networking, Bridged Networking, or Host-Only Networking.

Connecting a Sound Device

To connect or disconnect a sound device, choose the Activate or Mute options respectively. You can also choose the type of output and input devices.

Connecting a USB Device
Parallels Desktop automatically detects all USB devices plugged into your Mac computer. The devices that are currently connected to the virtual machine appear in the list from the Device menu. You cannot use a USB device in Mac OS X while it is being used by the virtual machine.

**Connecting a Shared Folder**

The Shared Folders options available at runtime are much alike the settings in the Virtual Machine Configuration (p. 146) dialog.

You can

- share all Mac disks or Home Folder only with the guest operating system
- share Windows guest operating system disks with Mac OS X
- add a new shared folder
Parallels Desktop 4 provides a number of features that ensure better integration between Mac OS X and your virtual machine.

The first step in integrating your virtual machine with Mac OS X is the installation of Parallels Tools in your virtual machine. Parallels Tools (p. 88) are a set of utilities that provide basic integration of Mac OS X and the virtual machines. Parallels Tools are available for Windows, Linux, and Mac OS X guest operating systems.

For Windows virtual machines, Parallels Tools also provide a set of advanced integration features that make your work with Mac OS and Windows even more coherent. These include SmartSelect, Coherence, Shared Applications, and other.

In This Chapter

Working in Coherence ................................................................. 129
Sharing Folders and Disks ............................................................ 133
Using Shared Profile ................................................................. 136
Using Shared Applications ......................................................... 137
Sharing Web Applications .......................................................... 140
Using SmartSelect ................................................................. 141
Browsing Virtual Hard Disks in Finder ......................................... 144
Using Spotlight With Virtual Hard Disks .................................... 145
Working in Coherence

Coherence is a visual mode of working with a virtual machine that enables you to:

- Use your Windows applications side by side with your Mac OS X applications.
- Use the Windows taskbar side by side with Mac OS X Dock.
- Move the Windows applications windows from one display to another (if any).

When you switch a running virtual machine with one or more running applications into the Coherence mode, you will see the guest OS applications windows on your Mac OS X desktop along with the Mac OS X applications windows.

By default, both Windows taskbar and Mac OS X Dock are visible, but you may hide the Windows taskbar by choosing Applications > Hide Windows Taskbar. You can use any of the Windows taskbar elements right from Mac OS X Desktop.

When a Windows guest OS application window is active, you can see the Parallels Desktop menus on the Mac OS X menubar.
The current version of Parallels Desktop provides a close integration between guest OS applications and Mac OS X:

- Windows file systems are accessible from Mac OS X and vice versa.
- Transparent file associations in both systems let you open Windows files in Mac OS X applications and Mac OS X files in Windows applications.
- The same default browser and email client can be used in both systems.
- The Dock displays both Windows and Mac OS X applications icons.
- Windows Start menu can be accessed from the Dock.

**Switching to the Coherence Mode**

Only a running virtual machine with Parallels Tools (p. 88) installed can be switched to the Coherence mode.

To switch to the Coherence mode:

- Click the icon on the toolbar, or
- Choose Coherence from the View menu, or
- Press Shift+Ctrl+Alt keys.

**Note:** To exit the Coherence mode, make your Windows guest OS active by clicking anywhere on its toolbar, right-click the Parallels Desktop icon in the Dock, point to the View item, and select the necessary view mode. When the guest OS is active, you can also choose the necessary view mode from the View menu.

You can also configure your virtual machine to always start in Coherence by editing the Startup and Shutdown settings (p. 151) in Virtual Machine Configuration.

**Using Dock in Coherence**

You can open Windows guest OS applications directly from the Dock or Mac OS X Desktop by clicking their icons. As you start a Windows application, its icon appears in the Dock. When the application is closed, or the virtual machine is stopped, the application icon disappears from the Dock.

To keep the icon in the Dock:

1. Right-click the Windows application icon in the Dock.
2. Choose Keep in Dock from the shortcut menu.

You can also create an alias for the Windows application on Mac OS X Desktop by choosing Add to Favorites from the application's shortcut menu.

Clicking a Windows application icon in the Dock or its alias on the desktop starts the virtual machine and the application in it. The virtual machine is automatically switched to Coherence.

**Using Windows Taskbar**
Integrating Mac OS X and Your Virtual Machine

By default, Windows taskbar is present on the Mac OS X desktop when you run the virtual machine in Coherence. If you don't want Windows Taskbar to be displayed when in Coherence, choose Applications > Hide Windows Taskbar.

You can use Windows taskbar to access the Start menu items. If there is no Windows taskbar on the screen, you can access the Windows Start menu by choosing Applications > Start Menu.

If you want the Windows taskbar to relocate in the Coherence mode depending on the position of the Mac OS X Dock, enable Automatically relocate Windows taskbar on the Coherence Settings pane (p. 169). With this option disabled, the Windows taskbar will take its place depending on where it was placed during the previous working session in this mode.

Using Application Switcher

You can switch between any of the running Mac OS X and Windows applications by using Application Switcher.

1 Press Command+Tab on the keyboard, you will see the Application Switcher bar across the desktop with all applications running in both Windows and Mac OS X.

2 Select the application by clicking its icon in the bar.

Using Expose With Your Windows Applications

When working in Coherence, you can use Expose to navigate between the Windows and Mac OS X applications windows opened on your desktop. To activate Expose, press the F9 key (on portable Macintosh computers, use the Fn+F9 key combination instead).

If the F9 key doesn't activate Expose, refer to Mac Help for information about changing the Mac OS X shortcuts.

Sharing your Windows and Mac applications

You can use Mac OS X applications to open the files in your Windows guest OS and vice versa. The list of Parallels Shared Applications is created during Parallels Tools installation. The list includes your Mac OS X applications and is available when you choose All Programs > Parallels Shared Applications from the Windows Start menu. You can select any application from the list and start it.

Right-click a file in Mac OS X or Windows and choose any available Mac OS X or Windows application from the Open With list.

Using Mac OS X Trash

You can remove files and folders that you do not need any more by simply dragging them from your virtual machine to the Trash in Mac OS X. After a file or folder is removed, it is automatically placed to Windows Recycle Bin and can be viewed by choosing Show Windows Recycle Bin from the Applications menu. You can then restore the file/folder by right-clicking it and selecting Restore. If you wish to empty the Recycle Bin contents, choose Empty Windows Recycle Bin from the Applications menu.
Using SmartSelect

You can choose the application that will always open files of a certain type in Mac OS X, no matter whether it is a Windows or a Mac OS X application. The feature is available from the application shortcut menu (when opened from the Dock) or from the Parallels Desktop Applications menu.

Using Multiple Displays Mode

You can use several displays while working in the Coherence mode and expand the Coherence mode on the selected number of displays.
Sharing Folders and Disks

A shared folder is a folder on your Mac that can be accessed from your virtual machine. Such folders can be used for exchanging files between the primary OS (Mac OS X) and the virtual machine or between several virtual machines. You can also share the virtual machine disk volumes with Mac OS X - they will be mounted on the Mac OS X Desktop.

In the operating system, where a shared folder resides, it appears as a usual folder, while in the virtual machine it is shared to, it appears as an object of the network neighborhood.

A shared folder or volume resides on the computer (host computer or a virtual machine) to which it initially belongs. It means, that it occupies space on the hard disk of the computer or virtual machine it originally belongs to.

Using shared folders is possible in the following guest operating systems:

- Linux operating systems supported by Parallels Desktop as guest OSs. See the list of supported guest operating systems (p. 64).

Setting up a shared folder requires two steps:

1. Make sure that Parallels Tools are installed in your guest OS. See Installing Parallels Tools (p. 88) for detailed descriptions on how to do so in a particular guest OS.
2. Add a shared folder(s) to your virtual machine configuration. For the instruction on how to do that, see Shared Folders Settings (p. 158).

Adding a Shared Folder

1. Start Parallels Desktop and open a virtual machine.
2. Open the Virtual Machine Configuration dialog by:
   - choosing Configure from the Virtual Machine menu, or
   - clicking the Configure button on the toolbar of the virtual machine main window.
3. In the Virtual Machine Configuration dialog, select the Shared Folders pane. Enable the User-defined folders option to be able to add shared folders to the list.
4. Click the Add button. The Add Shared Folder dialog will appear.
5. In the Add Shared Folder dialog:
   - Specify a folder in the Mac OS X file system that will be shared in the Path field.
   - Specify a name for the folder which will appear in your guest OS in the Name field.
   - Provide a description for the shared folder if needed in the Description field.
   - If you want to restrict writing to this folder from inside the guest OS, select the Read-Only option. You will be able to save files to this folder in Mac OS X only.
   - Make sure the Enabled option is selected and click OK.
Click **OK** in the **Virtual Machine Configuration** dialog to save the changes and quit the dialog.

Now you can start your virtual machine and view the shared folders in the guest OS.

**Viewing Shared Folders in Windows Guest OS**

1. After you have created a shared folder, start your Windows virtual machine and you will see the Parallels Shared Folders shortcut on the Windows desktop.

2. Double-clicking this shortcut will lead you to the `\psf` directory where all your shared folders are stored.

**Note:** To be able to save files to a shared folder from inside the virtual machine, make sure that the Read-Only option is disabled.

**Viewing Shared Folders in Linux Guest OS**

1. After you have created a shared folder, start your Linux virtual machine.

2. Shared folders will be automatically mounted to the `/media/psf` or `/mnt/psf` directory upon the virtual machine start.

**Note:** Automatic mounting may be blocked by SELinux. For more information, refer to Setting Up Shared Folders in Linux Virtual Machines (p. 268).

**Sharing Windows Disks to Mac OS**

If you want to access your virtual machine's volumes from Mac OS X, you can enable inverse sharing. To do so:

1. Start Parallels Desktop and open a virtual machine.

2. Open the **Virtual Machine Configuration** dialog by:
   - choosing **Configure** from the **Virtual Machine** menu, or
   - clicking the **Configure** button on the toolbar of the virtual machine main window.

3. In the **Virtual Machine Configuration** dialog, select the **Shared Folders** pane and enable the **Mount virtual disks to Mac OS X desktop** option.

The virtual machine's volumes will be accessible from Mac OS X desktop where they will appear as connected volumes.

**Note:** If the virtual machine's volumes are not mounted on Mac OS X desktop, go to **Finder > Preferences > General** and make sure that the **Connected servers** option is selected.

For more information about accessing the virtual machine's disks from Mac OS, see Browsing Virtual Hard Disks In Finder (p. 144).
Using Shared Profile

Parallels Desktop 4 provides close integration between your Mac OS and Windows guest OS. Now you can access certain Mac Home folders directly from Windows and vice versa.

**Note:** This option is available for Windows guest operating systems only.

The following Windows folders can be redirected to your Mac folders:

- Windows Desktop to Mac OS X Desktop
- The My Documents folder to the Documents folder on your Mac
- The My Pictures folder to the Pictures folder on your Mac
- The My Music folder to the Music folder on your Mac

When Shared Profile is enabled, the virtual machine's desktop will display the icons present on Mac OS X Desktop, the My Documents folder will contain items stored in the Documents folder on your Mac. The My Pictures and My Music folders will behave in a similar way.

To enable and configure Shared Profile, use the **Shared Profile** pane (p. 161) of Virtual Machine Configuration.

**To disable Shared Profile**

You can disable Shared Profile either by disabling Shared Profile in Configuration Editor or by disabling Mac folders sharing at runtime or in Virtual Machine Configuration (p. 161).
Integrating Mac OS X and Your Virtual Machine

Using Shared Applications

You can use Mac OS X applications to open the files in your Windows guest OS and vice versa. The list of Parallels Shared Applications is created during Parallels Tools installation. The list includes your Mac OS X applications and is available when you choose All Programs > Parallels Shared Applications from the Windows Start menu. You can select any application from the list and start it. You can create a list of Windows applications in Mac OS X and run them even when the virtual machine is stopped. If you start a Windows application when the virtual machine is stopped, the virtual machine will automatically start and switch to Coherence (p. 129).

Note: This option is available for Windows guest operating systems only.

You can manage shared applications from the Applications menu:

- View your Favorite, Recent, and Running applications in the Shared Windows Applications group.

  If you installed a new application in the virtual machine during this working session, you can update the list of Windows applications shared with Mac OS X by selecting the Populate option.

- Select Populate in the Shared Mac Applications group to update the list of Mac applications shared with the Windows guest OS.
To share your favorite Mac OS X and Windows applications, you need to configure the **Shared Applications** settings (p. 163) in Virtual Machine Configuration.

To open a file with the application you prefer, irrespective of where the file or the application belongs to, right-click the file and choose the application from the **Open With** list. To open a Mac OS X file in a virtual machine's application, you can drag this file to this application icon on the Windows desktop.

You can also create aliases for your favorite Windows applications on Mac OS Desktop and add their icons to the Dock.

To create an alias for the application and add its icon to the Dock:

1. Open Virtual Machine Configuration.
2. Open the **Shared Applications** pane and set the **Show in Dock** option to *Always* or *In Coherence*.
4. Start any of your favorite Windows applications in the virtual machine. When the application is started, its icon appears in the Dock.
5. To create an alias for your favorite Windows application, right-click the application icon in the Dock and select **Add to Favorites** from its shortcut menu.
6. The application alias appears on the Mac OS desktop. If you double-click this alias when the virtual machine is turned off, the virtual machine and the corresponding application in it will start automatically.

   The application name also appears in the **Applications** menu in the **Favorites** section, so that you can also start this application from the Parallels Desktop **Applications** menu.
7. To keep the favorite application icon in the Dock permanently, right-click the application icon in the Dock and choose **Keep in Dock** from the application shortcut menu. The application icon will be available from the Dock even when the virtual machine is stopped.

To remove an application from **Favorites**:

1. Start the virtual machine and the application you want to remove from Favorites.
2. Right-click the application icon in the Dock, and choose **Remove from Favorites** from the shortcut menu.

To switch off the Windows applications sharing option:

1. In the **Shared Applications** settings (p. 163) pane in Virtual Machine Configuration, clear the **Share Windows applications with Mac OS X** option and submit the changes.
2. Locate your virtual machine's bundle (PVM) in Mac OS X. By default, it is stored in the `/<Username>/Documents/Parallels/` folder.
3. Right-click the bundle and choose **Show Package Contents**.
4. Delete the **Windows Applications** folder from the virtual machine bundle.

To switch off the Mac applications sharing option, just clear the **Share Mac OS X applications with Windows** option in the **Shared Applications** settings (p. 163) pane in Virtual Machine Configuration and submit the changes.
Sharing Windows system tray icons with Mac OS X

To extend the integration between Mac OS X and a Windows guest operating system installed in the virtual machine, you can share Windows system tray icons with Mac OS X. After the sharing, the icons will be displayed in the Mac OS X menu bar and you will be able to use the system tray applications by clicking these icons.

To share Windows system tray icons, you need to configure the Shared Applications settings (p. 163).
Sharing Web Applications

When you work with Mac OS X and Windows applications simultaneously, you may notice that clicking a hyperlink in a Windows application opens the corresponding web page in the browser set as default in the Windows guest OS and clicking a hyperlink in a Mac OS X application opens the web page in the Mac OS X default browser.

With Parallels Desktop, you can set a single web application for opening similar web pages from both Mac OS X and Windows applications.

You can specify different Internet applications for opening each of the following types of web pages:

- **Web pages.** Web pages accessible through the HTTP and HTTPS protocols.
- **Email.** Links in the mailto format.
- **Newsgroups.** Links in the news. format.
- **FTP.** Locations accessible through the FTP protocol.
- **RSS.** RSS feeds.
- **Remote access.** Locations accessible through the Telnet and Secure Shell (SSH) protocols.

For setting up shared web applications, use the Internet Applications pane of the Virtual Machine Configuration (p. 146) dialog.

To open the Internet Applications pane:

1. Select a virtual machine and open its configuration by choosing Configure from the Virtual Machine menu.
2. Click the Internet Applications item in the left pane of the Virtual Machine Configuration (p. 146) dialog.

**Note:** You can specify different shared web applications for each of your Windows virtual machines that have Parallels Tools installed.

For more information about setting up shared web applications, refer to Internet Applications Settings (p. 168).

**Usage Tip**

Sharing the web applications can be useful in software development and web site building to check the compatibility with different Internet browsers. Create several virtual machines and install the necessary Internet browsers in each of them. Right-click the file you want to check and specify the browser to use through Open With.

**Note:** The Open With list displays only the Internet browsers available through the virtual machines that are currently running.
Using SmartSelect

SmartSelect allows you to open files of particular types, stored in Mac OS X, in Windows guest OS applications. Moreover, you can also open files of particular types, stored in Windows guest OSs, in Mac OS X applications.

Note: To use SmartSelect, you should install Parallels Tools in the virtual machine.

SmartSelect is available for the following guest OSs:
- Windows 2000
- Windows 2003
- Windows XP
- Windows Vista

To enable SmartSelect, you need to configure the Shared Applications (p. 163) settings in Virtual Machine Configuration.

Opening files in Mac OS X with Windows applications

To make the description of opening files in Mac OS X with Windows applications more vivid, let us assume that you have the doc.txt file stored in Mac OS X and you want to open it with Notepad.

Note: Before using a Windows application in Mac OS X for the first time, you should open it once in the virtual machine guest OS.

- If you want to open the doc.txt file with Notepad only once, right-click this file, choose Open With from the shortcut menu, and select Notepad.
- If you want to open all .txt files stored in Mac OS X with Notepad from now on:
  1. Right-click the doc.txt file, choose Open With from the shortcut menu, and select Notepad.
  2. Right-click the Notepad icon in the Dock and choose SmartSelect from the shortcut menu.
3. A list of SmartSelect file associations will open. You may edit the list by selecting the applications to open files with particular types of extensions.

![SmartSelect File Associations](image)

4. Find the .txt extension, select the Notepad Windows application, and click **OK** to save the associations. From now on, all .txt files stored in Mac OS X will open in Notepad.
When trying to open a file stored in Mac OS X with the associated Windows guest OS application, mind the following:

- If the virtual machine containing this application is shut down, suspended or paused, double-clicking the file will start or resume this virtual machine. When the guest OS boots up, the file will open in the application.
- If the virtual machine containing this application is deleted or removed from the Parallels Virtual Machines dialog, you will not be able to open the file with the associated application. In this case, you can do one of the following:
  - Choose another application to open this file using the Open With list accessible through the shortcut menu.
  - Register the removed virtual machine in Parallels Desktop and double-click the file to open it with the associated application.
  - Open the file with the corresponding application of another virtual machine as it was described above.

SmartSelect file associations after you remove Parallels Desktop

If some types of Mac OS X files are associated with certain Windows applications, after you remove Parallels Desktop, it will be impossible to open them in the Windows applications they are associated with. When you try to open such a file after Parallels Desktop is removed, you will have to choose a Mac application to open this file using the Open With list accessible through the shortcut menu. To restore the SmartSelect file associations, reinstall Parallels Desktop on your Mac and register the virtual machine that has the associated Windows applications installed.

Opening files in Windows guest OS with Mac OS X applications

To make the description of opening files in Windows guest OSs with Mac OS X applications more vivid, let us assume that you have the doc.txt file stored in the Windows guest OS and you want to open it with TextEdit.

- If you want to open the doc.txt file with TextEdit only once, right-click this file, choose Open With from the shortcut menu, and select TextEdit.
- If you want to open all .txt files stored in this Windows guest OS with TextEdit from now on:
  1. Right-click the doc.txt file, choose Open With from the shortcut menu, and click Choose Program.
  2. Select TextEdit, choose Always use the selected program to open this kind of file, and click OK to save the association.

From now on, all .txt files stored in this Windows guest OS will open in TextEdit.
Browsing Virtual Hard Disks in Finder

For easy access to the files of your virtual machines, you can mount their hard disks in Mac OS X Finder, together with other disks and storage devices.

If you want your virtual hard disks to be mounted to Mac OS X Desktop and appear among the mounted volumes in Finder when the virtual machine is running, you should perform the following actions:

1. Open the **Shared Folders** pane (p. 158) of the **Virtual Machine Configuration** dialog and enable the **Mount virtual disks to Mac OS X desktop** option.

2. Open the Finder Preferences, click **General** on the toolbar and select the **Connected servers** option in the list of items displayed on the desktop.

If you want to mount the virtual hard disks manually, use Parallels Mounter:

1. Right-click the virtual machine file (PVM) and choose **Open with > Parallels Mounter** from the shortcut menu.

2. To view and work with the contents of a mounted volume, select the volume's icon in the sidebar of the Finder window.

   **Note:** If you copy files to a Windows virtual machine using Parallels Explorer or Parallels Mounter, you need to log in to Windows as an administrator to be able to open them inside the virtual machine.

3. To unmount the volume, click the Eject button next to the volume's name in the sidebar.

   **Note:** You can use Parallels Mounter to mount volumes associated with Parallels Desktop virtual machines only. To browse third-party virtual machines, use Parallels Explorer (p. 250).

For more information about Parallels Mounter, refer to *Parallels Explorer User's Guide*. 
Using Spotlight With Virtual Hard Disks

Spotlight is a Mac OS X utility that enables you to search for the items stored on your Mac. To be able to search for the items stored on your virtual machines hard disks, you can enable Spotlight support in Parallels Desktop.

**Warning:** Using Spotlight may slightly reduce the performance of your virtual machine and your Mac.

**Enabling Spotlight support in Parallels Desktop**

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.
2. In the **Shared Folders** settings pane, select the **Add virtual disks to Spotlight search** option.

   **Note:** The changes will come into effect after you shut down your virtual machine or restart it.

**Using Spotlight to search your virtual hard disks**

1. In a Finder window, open the virtual hard disk you want to search by clicking its icon in the sidebar.

   **Note:** If the disk is not mounted in the Finder, refer to **Browsing Virtual Hard Disks in Finder** (p. 144) for the instructions on mounting virtual hard disks to Mac OS X.

2. Click inside the **Search** field in the Finder window or click the Spotlight icon on the Finder menubar.
3. Type the name of the item to search and press Enter to start the search.
4. The search results will be displayed in the Finder window.
CHAPTER 8

Configuring the Virtual Machine

This section explains how you can configure your virtual machine settings.

In This Chapter

Editing the Virtual Machine Configuration ................................................................. 146
Networking in a Virtual Machine .................................................................................. 192
Adding and Removing Devices ..................................................................................... 197

Editing the Virtual Machine Configuration

The configuration of an existing virtual machine can be changed in the Virtual Machine Configuration dialog. You can open the Virtual Machine Configuration dialog by doing one of the following:

- Click the Configure button on the toolbar of the virtual machine main window.
- Choose Configure from the Virtual Machine menu.
- In Virtual Machine Directory window, right-click the virtual machine and choose Configure.

Virtual Machine Configuration allows you to configure your virtual machine in a variety of ways. For example, you can

- Configure the virtual machine general options on the General pane (p. 147).
- Define the virtual machine boot options on the Boot pane (p. 149).
- Configure different parameters of the devices currently available inside the virtual machine: hard disk drives (p. 180), CD/DVD-ROM drives (p. 177), floppy disk drives (p. 176), etc.
- Configure the resource values currently set for the virtual machine: main memory (p. 173), video memory (p. 174), CPU (p. 172), etc.
- Add a new device to the virtual machine or remove an existing one (p. 197).
**General Settings**

You can view and configure the virtual machine general parameters on the **General** pane of Virtual Machine Configuration.
The **General** pane includes the following parameters:

- **VM Name.** This field displays the name assigned to the virtual machine. The length of the name is limited to 50 characters. The name of the virtual machine is displayed on its guest OS window (p. 36).
- **OS Type.** This field displays the type of the operating system installed in the virtual machine or declared to be installed in future.
- **OS Version.** This field displays the version of the operating system installed in the virtual machine or declared to be installed in future.
- **Description.** This field displays additional information related to the virtual machine.

**Note:** The OS type and version fields should reflect the real operating system type and version installed in the virtual machine.

### Backing up with Time Machine

If your version of Mac OS X is Mac OS X Leopard and you are using Time Machine for backing up your Mac, you may exclude your virtual machine from the Time Machine backups by selecting the **Do not back up with Time Machine** option. Time Machine backups may decrease the performance of your virtual machine when it is running in parallel with the Time Machine backup. When your virtual machine is not running (when it is stopped or suspended), the Time Machine backups don't affect it in any way.

For more information about backing up your virtual machines, refer to **Backing Up a Virtual Machine** (p. 227).
Boot Order Settings

On the **Boot Order** pane of Virtual Machine Configuration, you can configure the virtual machine boot sequence, that is, the order in which the virtual machine will try to load the operating system from different boot devices.

**Note:** These settings cannot be changed when the virtual machine is running.
The currently supported boot devices are listed below:

- **Hard Disk.** Select this device if you want the virtual machine to boot up from its virtual hard disk drive.

- **CD/DVD-ROM.** Select this device if you want the virtual machine to boot up from the media connected to its virtual CD/DVD-ROM drive.

  **Note:** The virtual machine will use the CD/DVD-ROM drive specified as **CD/DVD-ROM 1** in its configuration.

- **Floppy Disk.** Select this device if you want the virtual machine to boot up from a floppy disk image connected to its virtual floppy disk drive.

- **Network Adapter.** Select this device if you want your virtual machine to boot from a network adapter using PXE (Pre-Execution Environment).

  **Note:** The virtual machine will use the network adapter specified as **Network Adapter 1** in its configuration.

Every time you start the virtual machine, it tries to boot from the device specified as the first one in the **Boot order** list. If the virtual machine cannot boot from the first device (for example, no media is connected to it), the virtual machine proceeds to the second device in the list and tries to boot from this device, and so on.

On the **Boot** pane, you can perform the following operations:

- Change the currently set boot sequence by selecting the name of the corresponding boot device in the **Boot order** list and moving it up or down using the arrows to the right of the list.

- Remove a boot device from the sequence by clearing the check box next to its name.

If you choose the **Select boot device on startup** option, you will see the following message at the virtual machine startup: "Press ESC to select boot device". If you press ESC pending 5 seconds, you will be able to select a boot device. If you do not press ESC, the virtual machine will try to boot from the devices specified in the **Boot order** list.

**Note:** Make sure that the device you wish to use for your virtual machine booting (hard disk drive, CD-ROM drive, floppy disk drive, or network adapter) is available to the virtual machine and configured properly. If you do not have any boot devices configured in your virtual machine, you will see the following error message after you start the virtual machine: “No boot device is available”. In this case, you should stop the virtual machine and configure at least one boot device for it.
Startup and Shutdown Settings

The **Startup and Shutdown** pane of Virtual Machine Configuration allows you to define a number of parameters related to the procedures of starting and shutting down your virtual machine.

**Note:** Some of these settings, like the **Enable Undo Disks** option, can be changed only when the virtual machine is not running.
In this pane, you can configure the following parameters:

- The **Open as** option defines the mode in which the virtual machine will work after you select from Virtual Machines Directory (p. 34) and start. If the **Window**, **Full screen**, **Coherence**, or **Modality** option is selected, the virtual machine will automatically switch to the specified view mode (p. 109). If the **Same as last time** option is selected, the virtual machine will start in the same mode that was applied to it before it was turned off.

- The **Turn on automatically** option defines the cases in which the virtual machine can be started automatically.
  - Select **Don't** if you do not want your virtual machine to be turned on automatically in any case.
  - Select **When window opens** if you want your virtual machine to start automatically when you open it from Virtual Machines Directory (p. 34).
  - Select **When Parallels Desktop** starts if you want your virtual machine to start automatically every time you start Parallels Desktop.

- The **On window close** option defines the operation to be performed when you close the virtual machine's window:
  - Select **Suspend** if you want the virtual machine to be suspended when you close its window.
  - Select **Stop** if you want the virtual machine to be shut down when you close its window.
  - If you select **Ask me what to do**, you will be prompted to choose the operation to perform with the virtual machine each time you close its window.

- **Close window on shutdown**. Select this option if you want the virtual machine window to automatically close after the virtual machine has been successfully shut down.

### Undo Disks

The **Enable Undo Disks** option allows you to discard or apply the changes you made to the virtual machine's hard disk during your working session. If you choose to discard them, the changes will be discarded when you shut down the virtual machine. When you start this virtual machine again, its virtual hard disk will have the same data it contained before you started the previous working session. If you choose to apply the changes on the virtual machine shutdown, the next time you start this virtual machine, its virtual hard disk will store the changes you made during the previous working session.

**Note:** When enabled, the **Undo Disks** feature is applied to all virtual hard disks this virtual machine uses.

You can choose whether you want to discard the changes you made to the virtual machine's hard disk or choose the action to perform in the **On virtual machine stop** field.

- **Discard changes**. Select this option if you want to discard the changes when you shut down this virtual machine.
- **Ask me what to do**. If this option is selected, you will be prompted to choose the action to perform with the changes (discard or apply them) each time you shut down the virtual machine.

**Notes:** 1. You cannot create snapshots of virtual machines that have this option enabled.

2. This option cannot be enabled for the virtual machines using the Boot Camp partition.
Optimization Settings

On the **Optimization** pane of Virtual Machine Configuration, you can configure two groups of settings related to the virtual machine performance.
Enable the Adaptive Hypervisor option to automatically allocate the host computer CPU resources between the virtual machine and Mac OS X applications depending on what application you are working with at the moment. If your virtual machine window is in focus, the priority of this virtual machine processes will be set higher than the priority of the Mac’s processes and as a result more CPU resources will be allocated to the virtual machine, if you switch to the primary OS window - the priority of its working applications will be set higher and the CPU resources will be relocated to Mac OS X.

**Optimizing Performance**

This group of settings defines the priority of distributing the main physical computer memory resources:

- **Virtual machine.** Select this option to allocate more physical computer memory resources to the virtual machine and its applications. Selecting this option may significantly increase the virtual machine performance; however, it may slow down the productivity of your Mac OS X applications.

- **Mac OS X applications.** Select this option to allocate more memory resources to the physical computer and its applications. In this case, the memory resources usage will be optimized to provide better performance of your Mac OS X applications.

**Optimizing Power Consumption**

This group of settings allows you to control the virtual machine power consumption when Parallels Desktop is installed on a Mac laptop computer that is running on batteries (for example, MacBook Pro):

- **Longer battery life.** If you select this option, the virtual machine power consumption will be automatically reduced to provide a longer life for your Mac laptop battery.

- **Better performance.** If you select this option, the virtual machine and its applications will operate at the maximum possible speed. However, enabling this option may significantly reduce your Mac laptop battery life.

- **Enable battery in virtual machine.** If you enable this option, the battery status will be displayed in your virtual machine each time your Mac laptop computer runs on batteries. If your Mac computer is not a laptop one, this option will be absent.
Security Settings

The Security settings determine the overall level of virtual machine's isolation from Mac OS X. Using the slider on this pane you can change the overall security level, which will have effect on certain features related to sharing, including Shared Folders (p. 158), Shared Profile (p. 161), and Shared Applications (p. 163).

**Note:** To use the functionality available on the Security pane, you should have Parallels Tools installed in the virtual machine.

You can specify one of the following security levels for your virtual machine:

- **High.** This level provides the highest level of isolation between the virtual machine and the physical computer. With this level chosen, the Shared Folders, Shared Profile and Shared Applications features are not available for setting up. Thus, no folders and applications on the physical computer can be accessed from inside the virtual machine.

- **Elevated.** When this security level is set, you can set up Shared Applications and access only those shared folders on the physical computer that you manually define on the Shared Folders pane (p. 158). The Shared Profile feature is disabled.

  **Note:** Enabling the Shared Profile feature, changes the level of security from Elevated to Medium.

- **Medium.** When this security level is set, you can access all the data stored on the physical computer from inside the virtual machine. This is the default security level for all newly created virtual machines that allows you to set up Shared Folders, Shared Profile and Shared Applications.

  **Note:** The security level can be configured for Windows guest operating systems only.
Services Settings

The Services pane of Virtual Machine Configuration allows you to manage a number of Parallels Tools-related parameters.

Note: To use the functionality available on the Services pane, you should have Parallels Tools installed in the virtual machine.
Mouse and Keyboard Synchronization

Select the **Automatically capture and release the mouse pointer** option to facilitate the process of switching the keyboard and mouse input between the virtual machine and physical computer. With this option enabled, Parallels Desktop automatically grabs input from the keyboard and mouse and directs it to the virtual machine.

Clipboard Synchronization

Select the **Share Clipboard** option to allow sharing your clipboard between the virtual machines, or the virtual machine and the physical computer. With this option enabled, you can copy and paste text and files from the physical computer to the virtual machine, and vice versa, as well as copy and paste texts and files between the Parallels virtual machines.

**Note:** This option is available for Windows guest operating systems only. For more details, see the **Parallels Tools Overview** section (p. 89).

Drag-and-Drop Support

Select the **Enable drag-and-drop** option to allow copying files between the virtual machine and the physical computer by using the drag-and-drop method.

**Note:** This option is available for Windows guest operating systems only. For more details, see the **Parallels Tools Overview** section (p. 89).

Time Synchronization

Select the **Synchronize time with the host computer** option to synchronize the time settings of your virtual machine with those of the physical computer. You can specify the frequency of time synchronization checks in the **Synchronize every** field.

If the time zone set in your virtual machine differs from that of the physical computer, you can maintain this time difference by selecting the **Allow a different time than the host computer** option.
Shared Folders Settings

You can manage shared folders and their parameters on the Shared Folders pane of Virtual Machine Configuration.

Shared folders and their parameters can be configured for Windows, Linux, and Mac OS X guest operating systems.

You can also change the shared folders settings at runtime. To learn how to do it, refer to the Changing the Configuration at Runtime section (p. 126).

Note: To use the functionality available on the Shared Folders pane, you should have Parallels Tools (p. 89) installed in the virtual machine.
The availability of the Shared Folders functionality depends on the security level. For more information, refer to Security Settings (p. 155).

Sharing Mac OS X folders to Windows

**Note:** If you have a Linux guest operating system or a Mac OS X operating system, the option name will be Sharing Mac OS X folders with Linux or Sharing Mac OS X folders with guest Mac OS X respectively.

Select the Share Mac OS X folders with Windows option to enable access to the disks and folders on the physical computer from inside the virtual machine. If this option is selected, you can configure access to the physical computer disks and folders as follows:

- Select the **All disks** option to provide the virtual machine with access to all the disks installed on the physical computer and their folders.
- Select the **Home folder only** option to provide the virtual machine with access to the Home folder on the physical computer.

**Note:** When you share the Mac disks or folders with a virtual machine, they still reside and occupy space on the Mac's hard disk.

Defining physical computer folders to be shared

Select the User-defined Mac OS X folders option to manually specify one or more folders on the physical computer that are to be shared with the virtual machine.

To add a shared folder:

1. Click the **Add** button.
2. In the Add Shared Folder dialog, specify the following settings:
   - **Enabled.** Select this option to enable the shared folder.
   - **Path.** In this field, type the path to the folder you want to share with the virtual machine. You can also use the Choose button to locate the folder.
   - **Name.** In this field, type the shared folder name under which the folder will be accessible from inside the virtual machine.
   - **Description.** In this field, you can provide a brief description for the shared folder.
   - **Read-only.** Select this option if you want the shared folder to have a read-only status when accessed from inside the virtual machine.
3. Click **OK**.

To remove a shared folder, select its name and click the **Remove** button.

If you select the Map folders to drive letters check box, all your shared Mac OS X folders will be shown as network drives in your Windows computer.

**Note:** This option is available for Windows guest operating systems only.

For more information about shared folders, see Sharing Folders and Disks (p. 133).
Sharing Windows disks to Mac OS X

Note: This option is not available for Linux and Mac OS X guest operating systems.

Select the **Share all Windows disks to Mac OS X** option to enable access to all virtual disks and partitions available in the virtual machine from the physical computer. If this option is selected, you can additionally configure the following settings:

- Select **Mount virtual disks to Mac OS X desktop** to mount the shared virtual hard disks to your Mac OS X desktop.
  
  **Note:** Windows network shares cannot be mounted.

  After you enable this option, the virtual machine's volumes will be accessible from the Mac OS X Desktop where they will appear as connected volumes.

- The **Add virtual disks to Spotlight search** option lets you use the Mac OS X Spotlight tool to search for items stored on your virtual machine's hard disks.

  **Note:** If the virtual machine's volumes are not mounted on the Mac OS X Desktop or seem to be not included in the Spotlight search, go to **Finder > Preferences > General** and make sure that the **Connected servers** option is selected.
Shared Profile Settings

The **Shared Profile** pane of Virtual Machine Configuration lets you access your Mac OS X desktop and some of Mac Home folders (Documents, Pictures, Music) directly from the Desktop and the corresponding folders (My Documents, My Pictures, My Music) in your Windows guest OS.

**Note:** To use the functionality available on the **Shared Profile** pane, you should have Parallels Tools installed in the virtual machine.
To enable the Shared Profile functionality, select the **Enabled** option at the top of the **Shared Profile** pane.

The Shared Profile functionality is disabled if you set the Elevated or High security level (p. 155). However, if you enable the Shared Profile functionality, you automatically change the security level to Medium.

**Note:** To enable the Shared Profile functionality, you must share all Mac disks or at least your Mac Home folder. You can configure the necessary sharing settings on the **Shared Folders** pane (p. 158) or click **OK** on this pane to automatically enable Mac OS X Home folder sharing together with enabling Shared Profiles.

If the Shared Profile functionality is activated, you can choose one of the following options:

- Select **Desktop** to use the Mac desktop as the desktop in your Windows guest OS.
- Select **Documents** to use the Mac Documents folder on your Mac as the My Documents folder in your Windows guest OS.
- Select **Pictures** to use the Pictures folder on your Mac as the My Pictures folder in your Windows guest OS.
- Select **Music** to use the Music folder on your Mac as the My Music folder in your Windows guest OS.

For more information about the Shared Profile functionality, see **Using Shared Profile** (p. 136).

**Note:** The Shared Profile functionality is available for Windows guest operating systems only.
Shared Applications Settings

In the **Shared Applications** pane of Virtual Machine Configuration, you can specify one or more applications that will be shared between Mac OS X and your Windows guest OS.

**Note:** The options available in the **Shared Applications** pane are relevant only to Windows virtual machines with Parallels Tools installed.
The Shared Applications functionality is not available if you have the High security level (p. 155). Enabling this functionality, automatically sets Elevated security level.

Windows applications

In this section, you can configure the following applications-related parameters:

- Select **Share Windows applications with Mac OS X** to allow using Windows applications for opening the files in Mac OS X. Before using a Windows application in Mac OS X for the first time, you should open it once in the virtual machine guest OS. If you want to switch off the **Share Windows application with Mac OS X** option, clear this option in the **Shared Applications** pane of Virtual Machine Configuration, submit the changes, and delete the Windows Applications folder from the virtual machine bundle.

- Select **Enable SmartSelect** to enable the SmartSelect functionality allowing you to associate certain files with certain applications, irrespective of whether these are Mac or Windows files, or Mac or Windows applications. For detailed information on the SmartSelect functionality, refer to **Using SmartSelect** (p. 141).

- The **Show in Dock** option allows you to configure the appearance of your Windows application icons in the Dock of Mac OS X.

For more information on working with shared applications, refer to the **Using Shared Applications** section (p. 137).

Mac OS X applications

In this section, you can allow to open Windows files with Mac OS X applications. to do this, enable the **Share Mac OS X applications with Windows** option.
Mounting

The **SmartMount** pane of Virtual Machine Configuration allows you to configure the settings related to the automatic detection and mounting of removable devices in your virtual machines.

**Note:** The **SmartMount** option is available for Windows, Linux, and Mac OS X virtual machines with Parallels Tools installed.

If the **SmartMount** option is enabled, any device that you connect to your Mac is also automatically mounted to your guest operating system. For example, a USB flash drive plugged in to your host Mac will be accessible from both the `/Volumes` folder in Mac OS X and My Computer in the Windows virtual machine. The following devices can be automatically mounted to your virtual machines:

- external storage devices such as USB hard disks and USB flash drives;
- CD-ROM and DVD-ROM drives;
- network shares;
- mounted images (DMG, ISO, and so on).

The permissions you will have for managing the mounted device from inside the virtual machine will coincide with those you have for this device in Mac OS X. So, if you can read from and write to a USB flash drive in Mac OS X, you will have the same permissions for this drive from inside the virtual machine. At the same time, if you are connecting a USB flash drive that is formatted with NTFS, you will have read-only access to it because Mac OS X can read from NTFS volumes but cannot write to them.
SmartGuard Settings

On the SmartGuard pane of Virtual Machine Configuration, you can set up the automatic creation of snapshots. You can find detailed information on snapshots and how to work with them in the Working with snapshots chapter (p. 234).

**Note:** The snapshots can be made only when the virtual machine is running or stopped.

This option allows you to back up your virtual machine automatically.
To enable the SmartGuard functionality, select the Enabled option at the top of the SmartGuard pane.

**Note:** The SmartGuard feature is available only when the Undo Disks feature (p. 151) is disabled and if the virtual machine is not running in Safe Mode (p. 111).

If you want to know when it is time to make the next snapshot and to be able to reject the snapshot creation, enable the **Notify me before snapshot creation** option.

**Setting the Time Interval**

Set how often snapshots should be made in the Interval for taking a new snapshot field. You can set from one hour to 48 hours.

If the time interval is less than 24 hours, SmartGuard will allow you to restore the latest hourly, daily and weekly snapshot. If the time interval is more than 24 hours, you will be able to restore the latest daily, weekly and monthly snapshot.

To manage the snapshots and restore any of them, use Snapshot Manager (p. 236).

**Restricting the Snapshots Number**

Use the Maximum number of snapshots to keep field to set the maximum number of snapshots that can be stored on your Mac computer. The maximum available value is 100 snapshots. As soon as Snapshots Manager reaches the limit for snapshots and needs to make a new one over limit, it deletes the oldest snapshot.
Internet Applications Settings

In the **URL Handling** pane of Virtual Machine Configuration, you can specify the settings for opening different types of Internet-related files and locations.

**Note:** The options available in the Internet Applications pane are relevant only to Windows virtual machines with Parallels Tools installed.

You can specify different Internet applications for opening each of the following types of web pages:

- **Web pages.** Web pages accessible through the **HTTP** and **HTTPS** protocols.
- **E-mail.** Links in the **mailto** format.
- **Newsgroups.** Links in the **news.** format.
- **FTP.** Locations accessible through the **FTP** protocol.
- **RSS.** RSS feeds.
- **Remote access.** Locations accessible through the **Telnet** and **Secure Shell (SSH)** protocols.

To set applications for opening these types of web pages and links:

1. Click the box next to the type name.
2. Choose the appropriate Internet application from the list.

**Note:** The list contains the Internet applications installed in Mac OS X and your virtual machine.

For more information on sharing web applications, refer to **Sharing Web Applications** (p. 140).
Coherence Settings

The Coherence pane of Virtual Machine Configuration allows you to configure a number of Coherence-related options for your virtual machine. The Coherence mode is available only for virtual machines running Windows 2000/XP/2003/Vista guest OSs. If you try to configure this option for other guest OSs, you will see the following message: "Feature is not available for this type of guest operating system".

Note: For detailed information on the Coherence mode, see Working in Coherence Mode (p. 129).
On this pane, you can configure two groups of options:

### Appearance

- **Group all Coherence windows.** Select this option to bring to front the whole group of opened Windows applications by clicking any of them. With this option disabled, you will need to click every Windows application separately to place it over the opened Mac OS X applications.
- **Disable drop shadow.** Select this option to disable the shadow frames of running Windows applications. Switching off shadows may improve the performance of your virtual machine when operating in the Coherence mode.
- **Do not minimize windows to Dock.** Select this option to make minimized Windows applications appear on the taskbar only. With this option disabled, all minimized Windows applications will appear both on the taskbar and in the Dock.
- **Bring notification windows to front.** Select this option to always display Windows notifications above the active Mac OS X applications. With this option disabled, you will see Windows notifications only if you work with the corresponding Windows applications.

### Working area

- **Exclude Dock.** Select this option to exclude the Mac OS X Dock from the working area and to make Windows applications avoid the screen area occupied by the Dock.
- **Automatically relocate Windows taskbar.** If you select this option, the taskbar will be automatically relocated to
  - the top of the screen when the Dock is located at the bottom of the screen
  - the right of the screen when the Dock is located to the left of the screen.

  In addition, the taskbar will be placed to the best position where the entire bar will be visible.

  If you leave this option disabled, the Windows taskbar will take its place in the Window and Coherence view modes depending on where it was placed during the previous working session, thus, its position may differ in the Window and Coherence view modes.

  **Note:** If you exclude the Mac OS X Dock from the working area, this option will not be available.

- **Use multiple displays.** Select this option if you are using more than one display. Enabling this option will allow you to extend Coherence to several displays, that is, to move different Windows applications to different displays.
- **Show Windows system tray icons in the Mac menu bar.** If you select this option, the Windows system tray icons will be available from both the Windows taskbar and the Mac OS X menu bar.

  **Note:** If you use several monitors, you can arrange how you will see applications when moving them from one display to another. To this effect, select **System Preferences > Displays > Arrangement** on the Mac OS X menu and arrange the available displays in the **Displays** dialog.
Modality Settings

The **Modality** pane of Virtual Machine Configuration allows you to configure the settings related to the virtual machine's appearance and behavior when it is operating in the Modality mode.

In the Modality mode, the virtual machine's window becomes transparent. It appears on top of all open windows, which allows you to supervise your virtual machine when you work in Mac OS X.

You can configure the settings on this pane even when the virtual machine is running.

In the Modality mode, the virtual machine's window becomes transparent by default. You can specify the level of visibility in the **Visibility** field by dragging the slider between **Transparent** and **Opaque**. You can change the level of transparency for your running virtual machine when it is in the Modality mode.

To manage the behavior of the virtual machine's window in the Modality mode, use the following options:

- **Stay on top of other windows**. Clear this option if you do not want the virtual machine's window to appear on top of all other open windows when the virtual machine is in Modality.
- **Capture keyboard and mouse**. Clear this option if you do not want the virtual machine to capture the keyboard and mouse input when in Modality.

By default, both these options are selected.

To learn how to switch to Modality, refer to the **Changing View Modes** section (p. 109).
CPU Settings

You can view and configure the virtual machine's CPU settings on the CPU pane of Virtual Machine Configuration.

**Note:** These settings cannot be changed when the virtual machine is running.

This pane allows you to configure the number of virtual CPUs that will be used to handle the processes running in the virtual machine. To this effect, choose the necessary number of CPUs from the **Number of CPUs** menu. The maximum allowable number of virtual CPUs is automatically calculated by Parallels Desktop. The calculation is based on the number of physical CPUs available to your Mac OS X computer.

In the **Hardware Virtualization** field, you can view the type of hardware virtualization technology used by the virtual machine to emulate the hardware.

To view or edit other CPU settings, select the **Show advanced settings** check box. You can edit the following advanced settings:

- **System Flags.** The flags you type here will change the virtual machine system behavior.

**Note:** System flags can be used by the Parallels customer support team in cases when something goes wrong in your virtual machine. It is not recommended to type anything into this field without being instructed to do so by the customer support staff.
Memory Settings

To view and configure the amount of RAM available to your virtual machine, use the Memory pane of Virtual Machine Configuration.

**Note:** These settings cannot be changed when the virtual machine is running.

In the Main Memory field, you can set the amount of RAM that will be available to the virtual machine. You can specify any value from 4 to 8192 MB, but it is recommended that you set the value provided in the Optimal Size field below the slider. This will provide the most optimal performance for your virtual machine and your Mac.

By default, the optimal size is the amount of RAM the guest operating system needs. If some of the applications installed in your virtual machine need more RAM, you can set a greater amount of RAM for this virtual machine, provided the memory resources of your Mac are enough for running both Mac OS X and this virtual machine.

**Note:** If your Mac has 1 GB of RAM, it is strongly recommended to assign not more than 512 MB to a single virtual machine.

To configure the main memory limit, do one of the following:

- drag the slider
- use the Main Memory spin box arrows
- type the value directly into the Main Memory field
Video Settings

To view and configure the amount of video memory available to the virtual machine's video card, use the Video pane of Virtual Machine Configuration.

**Note:** These settings cannot be changed when the virtual machine is running.
In the Video memory field, you can set the amount of video memory that will be available to the virtual machine. You can specify any value from 2 to 256 MB; however, we recommend that you choose the value from the range given in the Recommended size field below the slider. This will provide the most optimal performance for your virtual machine and the physical computer where this virtual machine is hosted.

The Maximum screen resolution field shows the maximum screen resolution that will be supported in the virtual machine with the specified amount of video memory.

To configure the video memory limit
- drag the slider or
- use the spin box arrows or
- type the value directly into the Video Memory field

**Adjusting the host computer screen resolution to the virtual machine screen resolution in the Full Screen mode**

When you switch the virtual machine to the Full Screen mode, its screen resolution:
- changes to the physical computer screen resolution if you have Parallels Tools installed or
- remains the same.

In the second case, if the virtual machine screen resolution is lower than that of your physical computer, in the Full Screen mode, the virtual machine's screen will appear on a black background. If the virtual machine's screen resolution is higher than that of the host computer, in the Full Screen mode, the virtual machine's screen will have scroll bars.

To adjust the screen resolution of your physical computer to that of the virtual machine, select the Adjust the host computer's screen resolution in full screen option. In this case your computer will change its screen resolution each time the virtual machine is switched to the Full Screen mode.

**Enabling 3D Acceleration**

If you want to use games or applications that require video cards that support DirectX or OpenGL, select the Enable 3D Acceleration option. For more information, refer to Using 3D Graphics Applications (p. 116).
Floppy Settings

To view and configure the virtual machine floppy disk drive settings, use the Floppy Disk pane of Virtual Machine Configuration.

Enabled. Select this option to enable floppy disk drive operations in the virtual machine. To temporary disable floppy drive operations without removing the floppy drive from the virtual machine configuration, clear this option.

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped.

Connected. Select this option if you want the floppy disk drive or floppy disk image to be automatically connected to the virtual machine on its startup.

You can choose one of the following devices to emulate the virtual machine's floppy disk drive:

- To use a real floppy disk drive, select Real Device and specify the device to use.
- To use a floppy disk image, select Image File and specify the path to the floppy disk image file in the File field. You can also use the Choose button to locate the file.

If you want to create a new floppy disk image or to replace the currently used floppy disk image by a blank floppy disk image, click the Recreate button.

Warning: Recreating the current floppy disk image deletes all the data stored on this disk image.
CD/DVD-ROM Settings

To configure the virtual machine's CD/DVD-ROM drive settings, use the CD/DVD-ROM pane of Virtual Machine Configuration. Virtual CD/DVD-ROM drives can be connected either to physical CD/DVD-ROM drives or to CD/DVD images.

**Note:** You can connect up to four IDE devices (hard disks or CD/DVD-ROM drives) and 15 SCSI devices to a virtual machine. Each device is listed separately in Virtual Machine Configuration and has its own number.
Select the **Enabled** option if you want the virtual machine to use the given CD/DVD-ROM drive. To temporarily disable operations with the CD/DVD-ROM drive without removing it from the virtual machine configuration, clear the **Enabled** check box.

**Note:** The **Enabled** option can be selected or cleared only when the virtual machine is stopped.

Select the **Connected** option if you want the CD/DVD-ROM drive to be automatically connected to the virtual machine on its startup.

To emulate the virtual CD/DVD-ROM drive, you can connect one of the real CD/DVD-ROM drives on your physical computer or a CD/DVD-ROM image file to the virtual machine.

**Note:** ISO, CCD, CUE, and DMG images are supported.

### Connecting a real device

To use a real CD/DVD-ROM drive as the virtual machine's CD/DVD-ROM drive:

1. Select the **Real Device** option.
2. Choose the device to be connected to the virtual CD/DVD-ROM drive in the **CD/DVD-ROM** list.
3. Select the type of interface for connecting the device:
   - **IDE.** Using this interface type, you can connect up to four virtual devices (hard disks or CD/DVD-ROM drives).
   - **SCSI.** Using this interface type, you can connect up to 15 virtual devices (hard disks or CD/DVD-ROM drives).

**Note:** RHEL 4.7 and RHEL 5.3 guest OSs do not support the SCSI controller.

4. Select the device position in the **Location** list.

**Note:** The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI controller itself.

5. Click **OK**.

**Note:** The **Interface** and **Location** options are available only if the **Show advanced settings** check box is selected at the bottom of Virtual Machine Configuration.

### Connecting an image file

To use an image file as the virtual machine's CD/DVD-ROM drive:

1. Select the **Image File** option.
2. Type the path to the image file in the **File** field or use the **Choose** button to locate the file.
3. Select the type of interface to connect the image file to:
   - **IDE.** Using this interface type, you can connect up to four virtual devices (hard disks or CD/DVD-ROM drives).
   - **SCSI.** Using this interface type, you can connect up to 15 virtual devices (hard disks or CD/DVD-ROM drives).
Note: RHEL 4.7 and RHEL 5.3 guest OSs do not support the SCSI controller.

4 Select the device position in the Location list.

5 Click OK.
Hard Disk Settings

To view and configure the virtual hard disk settings, use the Hard Disk pane of Virtual Machine Configuration. The current version of Parallels Desktop allows virtual machines to use hard disk images in the .hdd format and Windows Boot Camp partitions.

**Note:** You can connect up to four IDE devices (hard disks or CD/DVD-ROM drives) and 15 SCSI devices to a virtual machine. Each device is listed separately in Virtual Machine Configuration and has its own number.

Select the Enabled option if you want the virtual machine to use the given hard disk drive. To temporarily disable operations with the hard disk without removing it from the virtual machine configuration, clear the Enabled check box.

**Using a hard disk image file as a virtual hard disk**

1. Select the Image File option.
2. Type the path to the hard disk image file in the File field or use the Choose button to locate the file.
3. Select the interface type for connecting the hard disk image.
   - IDE. Using this interface type, you can connect up to four virtual devices (hard disks or CD/DVD-ROM drives) to the virtual machine.
   - SCSI. Using this interface type, you can connect up to 15 virtual devices (hard disks or CD/DVD-ROM drives) to the virtual machine.

**Note:** 1. The Mac OS X guest OS does not support the SCSI controller.
2. In the latest Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In this case, you should install this driver in your Linux guest OS to be able to use the SCSI controller.

4. Select the device location in the **Location** list.

   **Note:** The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI controller itself.

5. Click **OK**.

   **Note:** The **Interface** and **Location** options are available only if the **Show advanced settings** check box is selected at the bottom of Virtual Machine Configuration.

---

**Using a Boot Camp partition as a virtual hard disk**

1. Click **Boot Camp**.

2. In the **Disk** field, select the hard disk drive where the Boot Camp partition is located.

3. In the **Location** field, specify the device location.

4. In the table below the **Location** field, select the check box next to the appropriate Boot Camp partition.

5. Click **OK**.

For more information on using Boot Camp partitions in your virtual machines, refer to **Using Boot Camp Partition in a Virtual Machine** chapter (p. 240).

**Note:** The **Location** field and the table below this field are available only if the **Show advanced settings** check box is selected at the bottom of Virtual Machine Configuration.
Support for Virtual and Real Disks

This section lists the types of disks that can be used by Parallels virtual machines and provides the information about basic operations that you can perform with these disks.

Supported Types of Hard Disks

Parallels virtual machines can use either virtual hard disks or Boot Camp partitions as their hard disks.

Virtual Hard Disks

The capacity of a virtual hard disk can be set from 100 MB and up to 2 TB.

Virtual hard disks can be of either plain, or expanding format. When you create a virtual machine in Express Windows or Typical mode (in the New Virtual Machine assistant), the disk is created in the expanding format.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>plain</td>
<td>A plain virtual hard disk image file is stored on your host computer and has a fixed size. The size is determined when such a disk is created. Plain disks can be created with the help of New Virtual Machine assistant (the Custom mode.)</td>
</tr>
<tr>
<td>expanding</td>
<td>An expanding virtual hard disk image file is stored on your host computer and is small initially. Its size grows as you add applications and data to the virtual hard disk in the guest OS.</td>
</tr>
</tbody>
</table>

Split disks

A virtual disk of either format can be a single-piece disk or a split disk. A split disk is cut into 2 GB pieces and is stored as a single .hdd file.

Boot Camp Partitions

With Parallels Desktop, you can choose how to use your Boot Camp Windows XP or Windows Vista operating system: to boot in it natively (via Boot Camp) or in a virtual machine (via Parallels Desktop). A Boot Camp Windows partition can be used as a bootable disk or as a data disk in Parallels virtual machines.

Note: You cannot create snapshots or use Undo Disks feature for a virtual machine that uses the Boot Camp partition.

CD/DVD Discs and Their Images

Parallels Desktop can access real CD/DVD discs and images of CD/DVD discs.

Parallels Desktop has no limitations on using multisession CD/DVD discs. Virtual machine can play back audio CDs without any limitations on copy-protected discs.

If your host computer has a recordable optical drive, you can use it to burn CD or DVD discs in a virtual machine.

Parallels Desktop supports CD/DVD disc images in ISO, CUE, and CCD formats.
Note: DMG disk images made with Mac OS X Disk Utility are also supported by Parallels Desktop. When creating such an image, make sure you create a read-only and uncompressed image without any encryption.

Floppy Disks and Floppy Disk Images

Parallels Desktop can use two types of floppy disks:

- Real diskettes inserted into a real floppy disk drive that is connected to the virtual machine.
- Floppy disk image files with the `.fdd` extension connected to the virtual machine.

Parallels Desktop treats floppy disk images like real diskettes. Parallels Desktop supports floppy disk image files that have `.fdd` extension and 1.44 MB size.

With Parallels Desktop, you can also create an image of a blank floppy using Floppy Disk pane of the Virtual Machine Configuration dialog.

Note: Parallels Desktop cannot create images of real diskettes.

Network Adapter Settings

The Network Adapter pane of Virtual Machine Configuration allows you to manage the virtual machine's network settings.
Enabled. Select this option if you want to enable the given network adapter in the virtual machine. If you want to temporarily disable the network adapter without deleting the network adapter from the virtual machine configuration, clear the Enabled check box.

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped.

Connected. Select this option if you want the virtual machine to start up with this network adapter connected.

You can choose one of the following types of networking for the virtual machine's network adapter:

- **Shared Networking.** Select this option to enable the Network Address Translation (NAT) feature for the virtual machine. In this case, your virtual machine will share whatever network connection is currently used by your physical computer. See [Shared Networking](p. 192) to learn how to configure this type of networking.

- **Bridged Ethernet.** Select this option to allow the virtual machine to access the local network and Internet through one of the network adapters installed on the physical computer. In this case, the virtual machine is treated as a stand-alone computer on the network and should be configured in the same way as a real one. You can choose the physical adapter where the virtual machine adapter will be bridged in the drop-down list below the Bridged Ethernet option. See [Bridged Ethernet Networking](p. 194) to learn how to configure this type of networking.

- **Host-Only Networking.** Select this option to allow the virtual machine to connect to the physical computer and the virtual machines residing on it and to make it invisible outside the physical computer. See [Host-Only Networking](p. 195) to learn how to configure this type of networking.

In the MAC Address field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the MAC Address field or clicking the Generate button. When entering a new MAC address, make sure that it is unique within your network.

WiFi Bridging Support

To be able to connect to wireless networks from your virtual machine:

1. Select the Bridged Ethernet option.
2. Choose AirPort from the drop-down list and click OK to apply the changes.

After you perform these steps, your virtual machine will be able to connect to the Internet through the AirPort adapter of your Mac.

When you try to connect to the Internet via WiFi, and the WiFi Access Point has the Validate DHCP packets option enabled, you may experience problems with connecting to the Internet. In this case, enable the Send the host's MAC address to DHCP server option to ensure that your virtual machine gets an IP address for accessing the Internet.

Note: Enabling the Send the host's MAC address to DHCP server option will not work with some DHCP servers - your virtual machine may get the same IP address as the physical computer has.
If you cannot configure your virtual machine to work in the Bridged Ethernet mode, you can consider using another networking mode: Shared Networking mode (p. 192) or Host-Only Networking mode (p. 195).

**Parallel Port Settings**

On the **Parallel Port** pane of Virtual Machine Configuration, you can configure the virtual machine's parallel port settings. A virtual machine can have up to three parallels ports.
**Enabled.** Select this option if you want to enable the given parallel port in the virtual machine. To temporarily disable the parallel port without deleting it from the virtual machine configuration, clear this option.

*Note:* The **Enabled** option can be selected or cleared only when the virtual machine is stopped.

**Connected.** Select this option if you want the virtual machine to start up with the parallel port connected.

A parallel port can be emulated by one of the following devices:

- **Real Port.** Select this option to connect one of the parallel ports of the physical computer to the virtual machine's parallel port. In this case, you will need to specify the appropriate physical port in the **Parallel Port** field.

- **Printer.** Select this option to connect a printer using the virtual machine's parallel port. In this case, you will need to select the appropriate printer in the **Printer** list.

  By default, the HP Color LaserJet 8500 PS printer supporting PostScript is installed in Windows virtual machines, irrespective of the real printer model and version. In most cases, modern printers support PostScript and that is why you should disregard the printer name you see in the Windows printing wizard and complete the procedure. As long as you have a printer connected to Mac, the documents will be printed on this printer.

- **Output File.** Select this option to emulate the parallel port by using an output file. In this case, a new output file with the default name will be created in the virtual machine's folder. The path to the output file will be displayed in the **File** field. If you want to use another output file, type the full path to it in the **File** field or use the **Choose** button to locate the file.
Serial Port Settings

On the **Serial Port** pane of Virtual Machine Configuration, you can configure the virtual machine's serial port settings.

Using serial ports, you can establish a connection between

- the virtual machine and the physical host computer devices (using a real port) or
- between two virtual machines located on the same physical server (using a socket).

If you want to connect your virtual machine to the physical computer's device, you should create a serial port emulated by a real port. The **Serial Port** list comprises the devices on the physical computer that are available for connection. The connected device, being used in any virtual machine, cannot be used by the physical computer. To be able to use it in the physical computer, you should first disconnect it from the virtual machine. To do that, use the virtual machine status bar.

If you want to connect two virtual machines with each other, you need to create a serial port emulated by a socket in each virtual machine. The names of the serial ports should be identical. The connection between the virtual machines via serial ports is bidirectional. It means that the working modes of the sockets set during the port creation can be changed later on the **Serial Port** pane.

If you need to log the performance activity of your virtual machine or to record the data from it and use this information later on, you can connect your virtual machine's serial port to an output file on the physical server. You will be able to view and analyze the activity history of the virtual machine any time you need it by exploring this file.

You can add a new serial port to your virtual machine using Add Hardware Assistant. For the instruction on how to create serial ports, refer to **Adding Serial Port** (p. 209).

**Note:** You can connect up to four serial ports to a virtual machine.
Enabled. Select this option if you want to enable the given serial port in the virtual machine. To temporarily disable the serial port without deleting it from the virtual machine configuration, clear this option.

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped.

Connected. Select this option if you want the virtual machine to start up with the serial port connected.

Serial ports can be emulated by the following devices:

- **Real Port.** Select this option to connect the virtual machine's serial port to one of the existing serial ports on the physical computer. In this case, you will need to choose the appropriate port on the physical computer in the Serial Port list.

- **Socket.** Select this option to connect two virtual machines through the sockets. When connecting the virtual machine to a socket, you can use the default path to the socket or type a new one in the Socket field. You can also configure the role the virtual machine will play in the connection by selecting the necessary role in the Mode list. Selecting Server enables you to use this virtual machine to direct the other one. Selecting Client enables you to direct this virtual machine from the other one.

  Note: If you change the socket mode of the first virtual machine, make sure that the socket mode of the second virtual machine is also modified.

- **Output File.** Select this option to connect the virtual machine's serial port to an output file. You can accept the default path or type your own one in the File field. You can also use the Choose button to locate the necessary file.
Sound Settings

The **Sound** pane of Virtual Machine Configuration allows you to configure the virtual machine sound device parameters.
**Enabled.** Select this option if you want to enable the sound device in the virtual machine. To temporarily disable operations with the sound device without deleting it from the virtual machine configuration, clear this option.

**Note:** The Enabled option can be selected or cleared only when the virtual machine is stopped.

**Connected.** Select this option to have the sound device automatically connected on the virtual machine startup.

**Output.** Use the output list to choose the necessary device. You can choose one of the following devices:

- **Default.** Select this option if you want to use the input device set as default in your primary OS.
- **Null device.** Select this option if you want to mute the output device.
- **Built-in output.** Select this option if you want to use one of the output devices connected to your primary OS.

**Input.** Use the input list to choose the necessary device. You can choose one of the following devices:

- **Default.** Select this option if you want to use the input device set as default in your primary OS.
- **Null device.** Select this option if you want to mute the input device.
- **Built-in input.** Select this option if you want to use one of the input devices connected to your primary OS.
USB Settings

On the **USB Controller** pane of Virtual Machine Configuration, you can enable the USB controller support in your virtual machine. A virtual machine can emulate only one USB controller, which provides you with the possibility to connect up to eight USB 2.0 and eight USB 1.1 devices to the virtual machine.

**Enabled.** Select this option to allow using USB devices in the virtual machine to connect and disconnect USB devices at runtime. If you want to temporarily disable USB operations without deleting the USB controller from the virtual machine configuration, clear this option.

If the USB controller is disabled, such USB devices as keyboard, mouse, microphone will still be available to the virtual machine with other emulated subsystems, such as sound, keyboard or mouse emulation, etc.

**Note:** The **Enabled** option can be selected or cleared only when the virtual machine is stopped.
Networking in a Virtual Machine

Parallels Desktop allows you to use three types of networking in your virtual machines:

- **Shared Networking** (p. 192). This type of networking allows the virtual machine to use the current network connections of your physical computer.

- **Bridged Ethernet** (p. 194). This type of networking allows the virtual machine to use one of the physical computer's network adapters, which makes it appear as a separate computer on the network the physical computer belongs to.

- **Host-only networking** (p. 195). This type of networking allows the virtual machine to access only the physical computer and other virtual machines residing on it.

By default, the virtual machine uses Shared Networking, because configuring it requires minimal effort from the users. The Bridged Ethernet networking mode is more complex, and you may need to contact your system administrator to set it up properly.

Detailed information on these types of networking and the way to configure them is provided in the following subsections.

**Shared Networking**

By default, all virtual machines created using the *Express Windows* and *Typical* modes are set to work in the Shared Networking mode. In this mode your virtual machine can access other computers on your local network and the Internet by using the IP address of the physical computer. The virtual machine itself does not have its own IP address on the network.
The Shared Networking mode does not require any additional configuration. With this mode enabled, your virtual machine will share whatever network connection your physical computer uses at the moment.

You may wish to use the Shared Network mode in the following cases:

- your computer accesses the Internet via a modem or another non-Ethernet device
- you need to access the Internet from inside your virtual machine but are concerned about security
- you have problems with working in the Bridged Ethernet mode

To configure your virtual machine to use Shared Networking:

1. Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.
2. Select **Network Adapter** in the **Hardware** list.
3. On the **Network Adapter** pane, make sure that the **Enabled**, **Connected** and **Shared Networking** options are selected.

   **Note:** In the **MAC Address** field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the **MAC Address** field or clicking the **Generate** button. When entering a new MAC address, make sure that it is unique within your network.

4. Click **OK**.

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Bridged Ethernet Networking

When operating in the Bridged Ethernet mode, your virtual machine appears on the network as a stand-alone computer with its own IP address and network name. This mode also allows you to specify port forwarding rules (p. 50) for the virtual machines running on your Mac, which can be especially useful when running HTTP, FTP, or other types of servers in virtual machines.

**Note:** The Bridged Ethernet networking mode is more complex than the Shared Networking mode (p. 192), and you may need to contact your system administrator to configure it properly.

![Bridged Ethernet Networking Diagram](image)

To configure your virtual machine to work in the Bridged Ethernet mode:

1. Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.

2. Select **Network Adapter** in the **Hardware** list.

3. On the **Network Adapter** pane, make sure that the **Enabled**, **Connected**, and **Bridged Ethernet** options are selected.

4. Select the appropriate network adapter from the list. To connect the virtual machine's adapter to the active network adapter of your physical computer, choose **Default Adapter**.

**Note:** In the **MAC Address** field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the **MAC Address** field or clicking the **Generate** button. When entering a new MAC address, make sure that it is unique within your network.

5. Click **OK**.

If you cannot configure your virtual machine to function in the Bridged Ethernet mode, you can consider using another networking mode: Shared Networking (p. 192) or Host-Only Networking (p. 195).

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Host-Only Networking

Parallels Desktop provides a closed network that is accessible only to the primary operating system and virtual machines running on it. The primary operating system is connected to this network via the Parallels Host-Only Networking adapter automatically created on the physical computer during the Parallels Desktop installation. The addresses for the virtual machines connected to this network are provided by the Parallels DHCP server.

To configure your virtual machine to use Host-Only Networking:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. Select Network Adapter in the Hardware list.
3. On the Network Adapter pane, make sure that the Enabled, Connected and Host-Only Networking options are selected.

**Note:** In the MAC Address field, you can change the MAC address currently assigned to the virtual machine. MAC addresses are automatically generated during the virtual machine creation. However, you can modify the default MAC address by typing another value in the MAC Address field or clicking the Generate button. When entering a new MAC address, make sure that it is unique within your network.

4. Click OK.

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Using WiFi in a Virtual Machine

Parallels Desktop provides you with an opportunity to connect your virtual machine to a wireless network.

Using the Bridged Ethernet mode (p. 194), you can set up a WiFi connection and access the Internet wirelessly. When operating in this mode, your virtual machine appears on the network as a stand-alone computer with its own IP address and network name.

To configure your virtual machine to access the Internet through WiFi:

1. Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration dialog.
2. Select Network Adapter in the Hardware list.
3. In the Network Adapter pane (p. 183), make sure that the Enabled, Connected and Bridged Ethernet options are selected.
4. In the Bridged Ethernet drop-down list, choose AirPort.
5. Click OK.

After you perform these steps, your virtual machine will be able to connect to the Internet through the AirPort adapter of your Mac.

**Note:** If the WiFi bridging does not work in your virtual machine, try to enable the Send the host's MAC address to DHCP server option in the Network Adapter pane to ensure that the virtual machine gets a valid IP address from the WiFi access point for accessing the Internet.

If you cannot configure your virtual machine to function in the Bridged Ethernet mode, you can consider using another networking mode: Shared Networking (p. 192) or Host-Only Networking (p. 195).

For the information about troubleshooting networking problems, refer to the Parallels knowledge base http://kb.parallels.com/ available at the Parallels website.
Adding new devices to a virtual machine is easier than connecting new devices to a real computer. Removing or disconnecting devices is also easy. The following virtual devices can be added to the configuration or removed from it:

- virtual hard disk drive (p. 199)
- CD/DVD-ROM drive (p. 204)
- floppy disk drive (p. 206)
- network adapter (p. 207)
- serial port (p. 209)
- parallel port (p. 210)
- sound device (p. 211)
- USB controller (p. 213)

Any of the aforementioned devices can be added to the corresponding virtual machine only when it is stopped.
Add Hardware Assistant

You can add new devices to your virtual machines using Add Hardware Assistant. The assistant allows you to add only one device at a time.

**Note:** To be able to connect any virtual device to a real one, you should have system privileges to access the real device. Otherwise, the real device will not appear in the list of available devices even though it is installed on your computer.

To add a new device to a virtual machine

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.

2. Click the **Add** button in the bottom part of the **Virtual Machine Configuration** dialog to launch Add Hardware Assistant.

3. The **Select Device** window displays the list of virtual hardware devices that can be added to the virtual machine. Select the device to be added to your virtual machine and click **Continue**.

   **Note:** If the virtual machine does already have the allowed number of devices of a particular type, the corresponding device icon is dimmed in the **Select Device** window.

4. Follow the assistant's instructions to add and configure the selected device.

   If you want to add a device that will have typical settings to the virtual machine, select the device and click the **Add Typical Device** button in the **Select Device** window.
Adding a Virtual Hard Disk Drive

You can add to your virtual machine an existing hard disk image or create a new, blank one.

---

**Note:** A virtual machine can have up to four IDE devices (hard disks or CD/DVD-ROM drives) and 15 SCSI devices (hard disks or CD/DVD-ROM drives).

---

**To add a hard disk to a virtual machine**

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.

2. Click the **Add** button in the bottom part of the **Virtual Machine Configuration** dialog to launch Add Hardware Assistant.

3. In the **Select Device** window, select **Hard Disk** and click **Continue**.

   To add a hard disk that will have a typical configuration, choose the **Hard Disk** icon and click the **Add Typical Device** button. Assistant will create a typical hard disk ready for use.

   **Note:** A typical virtual hard disk is in the *expanding* format (p. 182) and its capacity is 32 GB.

4. In the **Add Hard Disk** window, select the resource for the new virtual hard disk and click **Continue**. You can choose one of the following options:

   - **New image file.** In this case, the assistant will create a new image that will emulate the hard disk.

   - **Existing image file.** In this case, an existing image file will be added to the virtual machine and used to emulate the hard disk. If you selected this option, go to **Step 8**.

   - **Boot Camp partition.** In this case, Boot Camp partition will be added as a hard disk to your virtual machine. If the virtual machine doesn't have any hard disk, Boot Camp is added as [0,0] disk. If there is already a virtual disk, Boot Camp will be added as a data disk. For more information on adding a Boot Camp partition to a virtual machine, see the **Using the Boot Camp Partition in a Virtual Machine** chapter (p. 240). Click **Finish**.

5. If you selected the **New image** option, on the next step you will need to set the virtual hard disk size in the **Size** field and define its format. You can choose one of the following formats for the disk: *Expanding* or *Plain*. If you want the virtual hard disk to be splitted, select the **Split the hard disk image into 2 GB files** option. For more information on hard disk formats, refer to **Support of Virtual and Real Disks** (p. 182).
When you are ready, click **Continue**.

6 In the next window, you can configure the location of the hard disk image file and specify its interface type. You can choose one of the following interface types for the disk:

- If you select the **IDE** option, you will be able to define the IDE device identifier in the **Location** list.

- If you select the **SCSI** option, you will be able to select the SCSI device identifier in the **Location** list.

**Note:** The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI controller itself.
**Note:** 1. The Mac OS X guest OS does not support the SCSI controller.

2. In the latest Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In this case, you should install this driver in your Linux guest OS to be able to use the SCSI controller.

Click **Add Device** to add a new hard disk to the virtual machine.

7 If you selected the **Existing image file** option on **Step 5**, in the **Add Hard Disk** window you will need to specify the full path to the image file you wish to use in your virtual machine. You can type the path manually or use the **Choose** button to locate the image file.

If you added a new blank virtual hard disk, you need to initialize it before you can use it. For more information about initializing the newly added disk, see [Initializing the Newly Added Disk](p. 202).

If you added an existing disk, make sure that its file system is compatible with the guest OS installed in the virtual machine.
Initializing the Newly Added Disk

After you added a new virtual hard disk to the virtual machine configuration, it will be invisible to the operating system installed inside the virtual machine until the moment you initialize it.

Initializing the New Virtual Hard Disk in Windows

To Initialize the new virtual hard disk in a Windows guest OS, you will need the Disk Management utility available through:

- In Windows Vista: **Start > Control Panel > System and Maintenance > Administrative Tools > Create and Format Hard Disk Partitions > Disk Management.**
- In Windows XP: **Start > Control Panel > Administrative Tools > Computer Management > Storage > Disk Management.**

When you open the Disk Management utility, it automatically detects that a new hard disk was added to the configuration and launches **Initialize and Convert Disk Wizard:**

1. In the introduction window, click **Next.**
2. In the **Select Disks to Initialize** window, select the newly added disk and click **Next.**
3. In the **Select Disks to Convert** window, select the newly added disk and click **Finish.**

The added disk will appear as a new disk in the Disk Management utility window, but its memory space will be unallocated. To allocate the disk memory, right-click this disk name in the Disk Management utility window and select **New Simple Volume** in Windows Vista or **New Volume** in Windows XP. The **New Simple Volume Wizard/New Volume Wizard** window will appear. Follow the steps of the wizard and create a new volume in the newly added disk.

After that your disk will become visible in **Computer/My Computer** and you will be able to use it as a data disk inside your virtual machine.

Initializing the New Virtual Hard Disk in Linux

Initializing the new virtual hard disk in a Linux guest OS comprises two steps: allocating the virtual hard disk space and mounting this disk in the guest OS.

To allocate the space, you will need to create a new partition on this virtual hard disk, using the **fdisk** utility.

**Note:** To use the **fdisk** utility, you need the **root** privileges.

1. Launch Terminal.
2. To list the IDE disk devices present in your virtual machine configuration, enter:
   ```
   fdisk /dev/hd*
   
   Note: If you added a SCSI disk to the virtual machine configuration, use the **fdisk /dev/sd* command instead.**
   ```
3. By default, the second virtual hard disk appears as **/dev/hdc** in your Linux virtual machine. To work with this device, enter:
   ```
   fdisk /dev/hdc
   
   Note: If this is a SCSI disk, use the **fdisk /dev/sdc** command instead.```
4 To get extensive information about the disk, enter:

\[ p \]

5 To create a new partition, enter:

\[ n \]

6 To create the primary partition, enter:

\[ p \]

7 Specify the partition number. By default, it is 1.

8 Specify the first cylinder. If you want to create a single partition on this hard disk, use the default value.

9 Specify the last cylinder. If you want to create a single partition on this hard disk, use the default value.

10 To create a partition with the specified settings, enter:

\[ w \]

When you allocated the space on the newly added virtual hard disk, you should format it by entering the following command in the terminal:

\[ \text{mkfs -t <FileSystem> /dev/hdc1} \]

**Note:** `<FileSystem>` stands for the file system you want to use on this disk. It is recommended to use `ext3` or `ext2`.

When the added virtual hard disk is formatted, you can mount it in the guest OS.

1 To create a mount point for the new virtual hard disk, enter:

\[ \text{mkdir /mnt/hdc1} \]

**Note:** You can specify a different mount point.

2 To mount the new virtual hard disk to the specified mount point, enter:

\[ \text{mount /dev/hdc1 /mnt/hdc1} \]

When you mounted the virtual hard disk, you can use its space in your virtual machine.
Adding a CD/DVD-ROM Drive

You can add to your virtual machine a virtual CD/DVD-ROM drive that is either connected to a real CD/DVD-ROM on your physical computer or to an existing image file.

**Note:** A virtual machine can have up to four IDE devices (hard disks or CD/DVD-ROM drives) and 15 SCSI devices (hard disks or CD/DVD-ROM drives).

**To add a new CD/DVD-ROM drive to a virtual machine**

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.

2. Click the **Add** button \(+\) in the bottom part of the **Virtual Machine Configuration** dialog to launch Add Hardware Assistant.

3. In the **Select Device** window, select **CD/DVD-ROM** and click **Continue**.

   To add a CD/DVD-ROM drive that will have a typical configuration, choose the **CD/DVD-ROM** icon and click the **Add Typical Device** button. Assistant will create a typical CD/DVD-ROM drive ready for use.

4. In the **Add CD/DVD-ROM** window, select the resource for the new CD/DVD-ROM drive and click **Continue**. You can choose between the following options:
   - **Real Device**: select this option if you wish to add a real CD/DVD-ROM drive to your virtual machine.
   - **Image File**: select this option if you wish to use an existing image file as a virtual CD/DVD-ROM drive inside your virtual machine.

**Note**: Parallels Desktop supports .iso, .cue, .ccd and .dmg (non-compressed and non-encrypted) image files.

If you want the device to be connected to the virtual machine automatically at startup, select the **Connected** option. If you clear this option, the drive will be enabled in the configuration, but not connected to the virtual machine. You can connect it later when running the virtual machine.

5. Your next window will be different depending on what option (**Real Device** or **Image File**) you chose on the previous step:
   - If you chose to add a real device, select the corresponding device from the list in the **Drive Name** field.
   - If you chose to use an image file, type the path to the corresponding file in the **Image File** field or use the **Choose** button to locate the file.

In both cases, you should specify the interface type for the CD/DVD-ROM device or image file:
   - **IDE**: Using this interface type, you can connect up to four virtual devices (hard disks or CD/DVD drives) to the virtual machine.
   - **SCSI**: Using this interface type, you can connect up to 15 virtual devices (hard disks or CD/DVD drives) to the virtual machine.

**Note**: 1. The Mac OS X guest OS does not support the SCSI controller.
2. In the latest Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In this case, you should install this driver in your Linux guest OS to be able to use the SCSI controller.

You can also define the device position in the Location list or accept the position offered by Add Hardware Assistant.

**Note:** The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI controller itself.

When you are ready, click the Add Device button to add a new virtual CD/DVD-ROM drive to your virtual machine.
Adding a Floppy Disk Drive

You can add an existing floppy disk drive or floppy disk image to your virtual machine. You can also create a new floppy disk image and add it to the virtual machine.

Note: Any virtual machine can have only one floppy disk drive.

To add a floppy disk to a virtual machine

1. Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.

2. Click the Add button in the bottom part of the Virtual Machine Configuration dialog to launch Add Hardware Assistant.

3. In the Select Device window, select Floppy Disk and click Continue.

4. In the Add Floppy Disk window, select the resource for the new virtual floppy disk and click Continue. You can choose one of the following resources for the floppy disk:
   - Real Floppy Disk. In this case, Assistant will use a real disk to emulate the floppy disk drive.
   - Existing Image File. In this case, Assistant will use an existing image file for the floppy disk drive emulation.
   - New Image File. In this case, Assistant will create a new image that will emulate the floppy disk drive. To create a new floppy disk drive and add it to your virtual machine, just click Add Device in the Add Floppy Disk window.

   If you want the device to be connected to the virtual machine automatically at startup, select the Connected option. If you clear this option, the drive will be enabled in the configuration, but not connected to the virtual machine. You can connect it later when running the virtual machine.

5. Your next window will be different depending on what option (Existing Image File or Real Floppy Disk) you selected on the previous step:
   - If you selected Existing Image File, you will need to specify the location of the corresponding image file and click Add Device to add a new floppy disk drive to your virtual machine.
   - If you selected Real Floppy Disk, specify the floppy disk drive on your physical computer and click Add Device to add a new floppy disk drive to your virtual machine.
Adding a Network Adapter

A virtual machine can have up to 16 virtual network adapters simultaneously. Macintosh computers allow you to use multiple adapters, each for connecting to a different network.

To add a network adapter to a virtual machine

1. Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.
2. Click the Add button in the bottom part of the Virtual Machine Configuration dialog to launch Add Hardware Assistant.
3. In the Select Device window, select Network Adapter and click Continue.
   To add a network adapter that will have a typical configuration, choose the Network Adapter icon and click the Add Typical Device button. Assistant will add a typical network adapter ready for use.
4. In the Add Network Adapter window, select the type of networking you want to use in the virtual machine. The current version of Parallels Desktop allows you to choose one of the following networking types:
   - **Shared Networking.** If you select this option, the virtual machine will use the host computer's network connections and will be visible only for the host computer and the other virtual machines running on this server. This option is selected by default.
   - **Bridged Networking.** If you select this option, the virtual machine will be visible on the network as a separate computer.
   - **Host-Only Networking.** If you select this option, the virtual machine will be able to access only the host computer and the virtual machines running on it.

   If you want the device to be connected to the virtual machine automatically at startup, select the Connected option. If you clear this option, the drive will be enabled in the configuration, but not connected to the virtual machine. You can connect it later when running the virtual machine.

   If you choose the Shared Networking or Host-Only Networking option, click Add Device to add a new shared networking adapter to the virtual machine.

   If you choose the Bridged Networking option, click Continue and proceed to Step 6.
5. If you chose the Bridged Networking option, on the next step you will need to specify the virtual network adapter properties. Assistant will prompt you to specify the adapter to use. Select the appropriate adapter in the Adapter to Bind list and specify the MAC address in the MAC Address field. If you wish Add Hardware Assistant to generate the MAC address for you, click the Generate button.
Click the **Add Device** button to add a new network adapter to the virtual machine.
Adding a Serial Port

You can add to your virtual machine a serial port that will be connected to a real port on your physical computer, a socket, or an output file.

**Note:** A virtual machine can have up to four serial ports.

To add a serial port to a virtual machine

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.

2. Click the **Add** button in the bottom part of the **Virtual Machine Configuration** dialog to launch Add Hardware Assistant.

3. In the **Select Device** window, select **Serial Port** and click **Continue**.

   To add a serial port that will have a typical configuration, click the **Add Typical Device** button. Assistant will add a typical serial port ready for use.

4. In the **Add Serial Port** window, specify the resource to be used for the serial port emulation and click **Continue**. You can choose one of the following resources:
   - **Real Port.** Select this option to connect the virtual machine's serial port to the serial port of the physical computer. You will be able to choose the serial port in the next window.
   - **Output File.** Select this option to connect the virtual machine's serial port to an output file. You will be able to locate the file in the next window.
   - **Socket.** Select this option to create and connect the virtual machine's serial port to a socket of the physical computer.

   **Note:** When you connect two virtual machines via serial ports, both virtual machines should have serial ports emulated by sockets with the identical names.

5. In the next window, specify the resource properties and click **Add Device**:
   - If you chose **Real Port**, specify the port to be used for the virtual serial port device in the **Serial Port** list.
   - If you chose **Output File**, define the file to be used for the virtual serial port device in the **Output File** field or leave the default file offered by Add Hardware Assistant.
   - If you chose **Socket**, specify the name of the socket to be used for the virtual serial port device and its mode. The socket mode defines the role the virtual machine will play when establishing a network connection to another computer. It can be set to one of the following: **Server** or **Client**. The **Server** socket enables you to use the given virtual machine to direct the other one. The **Client** socket enables you to direct the given virtual machine from the other one.

   **Note:** When you establish a connection between two virtual machines, one virtual machine socket should function in the **Server** mode, and the other one - in the **Client** mode.
When you are ready, click the Add Device button to add a new serial port to your virtual machine.

Adding a Parallel Port

You can add a parallel port to your virtual machine that will be connected either to a printer or to an output file.

**Note:** A virtual machine can have up to three parallel ports.

To add a parallel port to a virtual machine

1. Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.

2. Click the Add button in the bottom part of the Virtual Machine Configuration dialog to launch Add Hardware Assistant.

3. In the Select Device window, select Parallel Port and click Continue.

   To add a parallel port that will have a typical configuration, click the Add Typical Device button. Assistant will add a typical parallel port ready for use.

4. In the Add Parallel Port window, specify the resource to be used for the parallel port emulation and click Continue. You can choose one of the following resources:

   - **Output File.** Select this option to emulate the parallel port by using an output file. In this case, a new output file with the default name will be created in the virtual machine's folder.

   - **Printer.** Select this option to connect a printer using the virtual machine's parallel port.

   If you want the device to be connected to the virtual machine automatically at startup, select the Connected option. If you clear this option, the drive will be enabled in the configuration, but not connected to the virtual machine. You can connect it later when running the virtual machine.

5. In the next window, specify the resource properties:

   - If you chose the Output File option on the previous step, you should set the path to the corresponding file in the Output File field. You can leave the file offered by Add Hardware Assistant or specify another one by using the Choose button or manually typing the full path to it in the field provided.

   - If you chose the Printer option on the previous step, you should choose the appropriate printer name in the Printer list.

   Click the Add Device button to add a new parallel port to your virtual machine.
Adding a Sound Device

Parallels Desktop allows you to add sound devices to your virtual machines.

**Note:** Any virtual machine can have only one sound device.

To add a sound device to a virtual machine

1. Choose **Configure** from the **Virtual Machine** menu to open Virtual Machine Configuration.

2. Click the **Add** button in the bottom part of the **Virtual Machine Configuration** dialog to launch Add Hardware Assistant.

3. In the **Select Device** window, select **Sound** and click **Continue**.
   
   To add a sound device that will have a typical configuration, click the **Add Typical Device** button. Assistant will add a typical sound device ready for use.

4. In the **Add Sound** window, specify the sound input and output devices the virtual machine will use:
   
   **Output device.** Use the output list to choose the necessary device:
   - **Default.** Select this option if you want to use the input device set as default in your primary OS.
   - **Null Device.** Select this option if you want to mute the output device inside the virtual machine.
   - **Built-in Output.** Select this option if you wish to use other output devices connected to your primary OS.

   **Input device.** Use the input list to choose the necessary device:
   - **Default.** Select this option if you want to use the input device set as default in your primary OS.
   - **Null Device.** Select this option if you want to mute the input device inside the virtual machine.
   - **Built-in Input.** Select this option if you wish to use other input devices connected to your primary OS.

   You can also select the **Activated** option to have the sound device automatically activated on the virtual machine startup.
When you are ready, click the Add Device button to add a new sound device to your virtual machine.
Adding a USB Controller

You can add a USB controller to your virtual machine. USB controllers installed inside your virtual machines allow USB devices plugged into the USB drives of your physical computer to be automatically connected to the corresponding virtual machines.

**Note:** A virtual machine can have only one USB controller.

**To add a USB controller to a virtual machine**

1. Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration.

2. Click the Add button in the bottom part of the Virtual Machine Configuration dialog to launch Add Hardware Assistant.

3. In the Select Device window, select USB Controller and click Add Device.
Removing Devices

Most virtual machine devices can be removed from the virtual machine configuration (except for the main memory, CPU, and video memory).

**Note:** You can disable any device, except for the memory, without removing it from the virtual machine configuration. To this effect, clear the **Enabled** option on the corresponding device's pane in Virtual Machine Configuration.

**To remove a device**

1. Open the virtual machine the virtual device of which you wish to remove. Make sure that the virtual machine is stopped.

2. Choose **Configure** from the **Virtual Machine** menu to open the **Virtual Machine Configuration** dialog.

3. Select the device you wish to remove and click the **Remove** button in the bottom part of the **Virtual Machine Configuration** dialog.

**Note:** If you accidentally click the **Remove** button, click **Cancel** in Virtual Machine Configuration. Once you click **OK**, the device will be removed.
CHAPTER 9

Managing Virtual Machines

This chapter provides the information on how to change a virtual machine configuration and how to set user preferences for a particular virtual machine or all of them.

In This Chapter

Cloning a Virtual Machine ................................................................. 216
Removing a Virtual Machine From the List ...................................... 218
Deleting a Virtual Machine ............................................................... 219
Working With Virtual Machine Templates ....................................... 222
Backing Up a Virtual Machine .......................................................... 227
Compacting Virtual Hard Disks ......................................................... 228
Managing Virtual Machines From iPhone ........................................... 229
Cloning a Virtual Machine

An exact copy of a virtual machine can be created using Clone Virtual Machine Assistant. The clone is an separate virtual machine that includes as many virtual hard disks as were connected to the original machine. The assistant places the cloned virtual machine into a default folder, but you may specify a different one.

In the virtual machine clone, the names of all the devices, drivers and virtual hard disk images remain the same as they were in the original machine. All connections between the devices in the cloned VM will be the same as in the original virtual machine.

If a device in the original machine was connected to an external resource, this device in the clone will be connected to the same resource. The only exception is serial/parallel port log files. If such files are used by the original virtual machine, Parallels Desktop creates a new set of empty log files for the clone.

If the original virtual machine has a snapshot tree, the virtual machine clone will have the same structure of snapshots.

If a network adapter was enabled in the original configuration, Parallels Desktop generates a new MAC address for the clone.

You can also make a clone of a clone, and give it a unique name. The resulting clone will have the same configuration and the same devices connected as the initial clone.

Unlike snapshots (p. 234), a virtual machine and its clones are used separately and there is no any connection between them after the clones creation. If you need to delete an initial virtual machine from which you have made clones, you can do it without any threat to the clones.

Before cloning a virtual machine, make sure that:

- The virtual machine is turned off. If the virtual machine is running, the Clone option in the Virtual Machine menu is disabled.
- The virtual machine has a guest OS. You cannot clone a virtual machine without a guest OS.

To make a clone of a virtual machine:

- Open the virtual machine you want to clone.
- From the Virtual Machine menu, select Clone. The Clone Virtual Machine Assistant window appears. If you do not want the Introduction window to appear in the future, select Always skip introduction. Click Continue.
In the **Name and Location** window, specify the name and folder for the virtual machine clone. The name suggested by the assistant is made by adding "Copy of" to the original virtual machine name. You can specify another name but it should not be longer than 50 characters.

To specify the location for the virtual machine clone, click the **More Options** item and do the following:

- accept the default location suggested by the assistant
- type the new location in the **Place virtual machine files to the folder** field
- use the **Choose** button to locate the virtual machine clone

If you want to provide a quick access to the virtual machine clone, tick the **Create icon on Desktop** checkbox located under the **Place virtual machine files to the folder** field.

To test the newly created virtual machine clone immediately after its creation, tick the **Open copy in new window automatically** checkbox.

Click **Clone** to start cloning the virtual machine.

The **Cloning Finished** window informs you that copying has been completed successfully and the new machine is ready. Click **Done** to close the assistant.
Removing a Virtual Machine From the List

When you launch Parallels Desktop, you are presented with the Parallels Virtual Machines list containing the virtual machines that are currently registered in Parallels Desktop. This feature gives you an opportunity to select a virtual machine you are going to work with.

If a virtual machine is not currently used, it can be temporarily removed from the list. When you need this virtual machine again, you will be able to add it to the list as an existing one (p. 84).

To remove a virtual machine from the Parallels Virtual Machines list:

1. Launch Parallels Desktop, choose a virtual machine in the Parallels Virtual Machines list, and choose Remove from the File menu.

2. The Delete Virtual Machine Assistant welcome window appears. If you do not want this window to appear the next time you start this assistant, select Always skip introduction. Click Continue.

3. Select the Remove from list option and click Remove.
4 The assistant removes the virtual machine from the Parallels Virtual Machines list. If the operation was successful, the Removal Succeeded window appears.

5 Click Done to close the assistant.

Deleting a Virtual Machine

You can delete a virtual machine using the Delete Virtual Machine assistant or by deleting its file manually.

The Delete Virtual Machine assistant removes the following virtual machine files by default:

- configuration file
- virtual hard disk file(s)
- snapshots
- floppy disk image file(s), if any
- output files of serial and parallel ports, if any
- folder where this virtual machine files are stored

The Delete Virtual Machine assistant can delete an open virtual machine that meets the following requirements:

- The virtual machine is not running. If it is running, the Remove command in the File menu will be disabled.
- The virtual machine is not blank.

To delete a virtual machine:

1 Open the desired virtual machine.

2 Choose Remove from the File menu. The Delete Virtual Machine Assistant window appears. If you do not want this window to appear the next time you start this wizard, select Always skip introduction. Click Continue.

3 Select the Delete option and click Continue.
The assistant finds all files related to the virtual machine and displays the list of them in the **Files Selection** dialog. The configuration file, virtual hard disk, output files of serial and parallel ports, and the home folder are pre-selected for deleting. However, the `.iso` image is not selected by default, because it can be used by other virtual machines. If you want to delete it too, select it in the list.
**Note:** Make sure you are not going to delete the virtual hard disk that is also used by other virtual machines.

If you want to select all items in the list of files related to the virtual machine at a time, click the **Select All** button displayed below the list.

If you want to clear all items in the list of files related to the virtual machine at a time, click the **Clear All** button displayed below the list.

Review the selection and click **Delete**.

5 The assistant removes the selected files from the hard disk of your Mac. If the operation was successful, the **Deletion Succeeded** window appears.

The virtual machine is considered as successfully deleted if all selected components or all selected components except the home folder (if it was chosen for deleting) have been removed. If the home folder contains any other files, the folder will not be deleted.

Click **Done** to close the assistant.

### Deleting virtual machines manually

Though it is strongly recommended to use Delete Virtual Machine Assistant for deleting your virtual machines, you may also delete virtual machines manually.

If you have virtual machines that are not registered in Parallels Desktop but their files are stored on your Mac, you can permanently delete the unnecessary virtual machines by deleting their files (p. 15). The virtual machine files (PVM files) are stored in the following folder by default: `/<Username>/Documents/Parallels/`. Each virtual machine is represented by a single PVM file.

**Warning!** Before deleting the virtual machine manually, make sure that this virtual machine is not registered in Parallels Desktop and none of its files (like virtual hard disk) are used by other virtual machines.
Working With Virtual Machine Templates

Parallels Desktop makes your work with virtual machines even more convenient by enabling you to create templates of Parallels virtual machines.

A template, like a virtual machine, has hardware and may have operating system and software installed. The only difference is that it cannot be started. A template can be easily converted to an ordinary virtual machine and vice versa.

Using one template, you can create as many virtual machines as you need and the disk space of your Mac allows. The virtual machines created using such a template will have the same hardware configuration, operating system, and software that this template has.

You can convert an existing virtual machine into a template or make a clone of the virtual machine that will be used as a template and continue using the original virtual machine.
Creating a Virtual Machine Template

If you need to create a number of virtual machines with same configuration, you can create a virtual machine template and use it to create new virtual machines.

There are two ways of creating a virtual machine template:

- Convert an existing virtual machine into a virtual machine template.
- Clone an existing virtual machine to a virtual machine template.

If you choose to convert a virtual machine into a template, this virtual machine will change its operating system icon to a template icon in the list of virtual machines and it will be available as a template only. You will not be able to run it as a virtual machine.

If you do not want to convert a virtual machine into a template but need to make a copy of it with the same configuration, you can make a clone of this virtual machine that will be used as a template.

To convert an existing virtual machine into a template:

1. Launch Parallels Desktop.
2. Choose the virtual machine you want to convert into a template from the list of Parallels virtual machines.
3. Choose **Convert to Template** from the **Virtual Machine** menu.
4. The virtual machine will become a template and will have a different icon indicating that it is a template.

To clone a virtual machine to a template:

1. Launch Parallels Desktop.
2. Choose the virtual machine you want to clone to a template from the list of Parallels virtual machines.
3. Start Clone to Template Virtual Machine Assistant by choosing **Clone to Template** from the **Virtual Machine** menu.
4. In the **Introduction** window, click **Continue**. To skip this window next time you start the assistant, select **Always skip introduction**.
5. In the **Name and Location** window, specify the name and location for the virtual machine template and click **Clone**. You can use the **Choose** button to change the location.

By default, the virtual machine template files will be placed to the following folder on your Mac: /Users/UserName/Documents/Parallels/<Virtual Machine Template Name>/.

If you want to have the icon of the cloned template on your Desktop enable the **Create icon on Desktop** option.

If you want to start working with the template right after its creation, choose the **Open copy in new window automatically** option.
6 In the **Creation Finished** window, click **Done** to quit the assistant.
Deploying a Virtual Machine Template

A virtual machine template cannot be run as a virtual machine. To be able to run it as a virtual machine, you should create a virtual machine that will have the same configuration the template does.

There are two ways of creating a virtual machine from a template:

- Convert a template into a virtual machine.
- Deploy a template to a new virtual machine.

If you convert a virtual machine template into a virtual machine, its icon will be moved from the templates list to the virtual machines list, and you will be able to use it as a virtual machine.

If you deploy a virtual machine template to a virtual machine, the Deploy Virtual Machine Template assistant will create a new virtual machine, but the template will not be removed from the templates list.

To convert a virtual machine template into a virtual machine:

1. Launch Parallels Desktop.
2. In the list of Parallels virtual machines, right-click the virtual machine template you want to convert into a virtual machine and choose **Convert to Virtual Machine** from the shortcut menu.
3. The virtual machine template will be processed into a virtual machine and will change its icon.

To deploy a virtual machine template to a new virtual machine:

1. Launch Parallels Desktop.
2. In the list of Parallels virtual machines, click the virtual machine template you want to be deployed to a virtual machine and click **Create** or right-click the template and choose **Deploy to Virtual Machine** from the shortcut menu.
3. Deploy Virtual Machine Template Assistant starts. In the **Introduction** window, click **Continue**. To skip this window next time you start the assistant, select **Always skip introduction**.
4. In the **Name and Location** window, specify the name and location for the virtual machine and click **Deploy**. You can use the **Choose** button to change the location.

By default, the virtual machine files will be placed to the following folder on your Mac: `/Users/UserName/Documents/Parallels/<Virtual Machine Template Name>/`.

If you want to have the icon of the newly created virtual machine on your Desktop, enable the **Create icon on Desktop** option.

If you want to start working with the virtual machine right after its creation, choose the **Open copy in new window automatically** option.
5 In the Deployment Finished window, click Done to close the assistant.

The resulting virtual machine will have the same configuration that the original template had.
Back up your virtual machine using one or several of the following methods:

- Copy the virtual machine files manually.
- Clone the virtual machine with the help of Clone Virtual Machine Assistant (p. 216). Give a descriptive name to the clone and save it in a location specially designated for backups.
- Include the virtual machine files in the automatic Time Machine backups by editing the General settings (p. 147) in the virtual machine configuration.
- Use third-party backup utilities like Acronis True Image.

If you need to back up the data stored inside the virtual machine, you may view its contents and create backup copies of the files you need using Parallels Explorer available from the /Applications/Parallels/ folder. For more information about Parallels Explorer, refer to Using Parallels Explorer (p. 250) or Parallels Explorer User's Guide.

### Copying the virtual machine files

You can locate your virtual machine in Finder and create a backup copy of the virtual machine file (PVM).

1. In Finder, go to the folder where your virtual machine is stored. By default, it is /<Username>/Documents/Parallels/.

2. Locate the required virtual machine PVM file.

   **Note:** PVM file is bundle that contains the virtual machine configuration file (PVS), virtual hard disk file (HDD), and other files. For more information about the virtual machine files, see Parallels Virtual Machine (p. 15).

3. Copy the virtual machine's PVM file to a safe location.

### Cloning the virtual machine

You can create a complete clone of the virtual machine using Clone Virtual Machine Assistant. For details, see Cloning a Virtual Machine (p. 216).

### Backing up your virtual machine using Time Machine

If you choose to back up your virtual machine with Time Machine, your virtual machine's PVM file will be automatically backed up together with other files stored in Mac OS. As a consequence, files stored on your virtual machine's hard disk will be also backed up, since the virtual hard disk file (HDD) is stored inside the virtual machine bundle file (PVM).

If you want to restore some of your Windows files, do the following:

1. Locate the backup copy of your virtual machine's file (PVM).
2  Right-click the file and choose **Show Package Contents**.

3  In the virtual machine contents window, right-click the virtual hard disk file (HDD) that is usually named `<VirtualMachine'sName>.hdd` and choose **Open With > Parallels Explorer** or **Open With > Parallels Mounter**.

4  Using Parallels Explorer (or Parallels Mounter), browse the contents of your virtual machine's hard disk to find the files you need to restore.

For more information about Parallels Explorer, refer to **Using Parallels Explorer** (p. 250). To learn more about Parallels Mounter, see **Browsing Virtual Hard Disks in Finder** (p. 144).

### Using third-party backup utilities

You can use any third-party backup application you like. Registered users of Parallels Desktop can use Acronis True Image Home for free for backing up their virtual machines. You can download this application from the Download Parallels Desktop page.

---

## Compacting Virtual Hard Disks

Compacting can be performed only for the expanding virtual hard disks no matter whether they are single-file disks or split disks. For more information on disks formats, refer to **Support of Virtual and Real Disks** (p. 182).

Disk Compacting is performed with the help of Parallels Image Tool. While compacting the virtual hard disk, Parallels Image Tool cleans up the unused disk space on expanding virtual hard disks and cuts off the cleaned free space thus reducing the sizes of virtual hard disk image files in Mac OS X. We recommend that you use Disk Compacting Tool on your virtual machines from time to time to save space on the host hard disk.

For instructions on compacting the disk using Parallels Image Tool, see **Using Parallels Image Tool** (p. 254) or **Parallels Image Tool User's Guide**.

**Note:** Compacting of virtual hard disks cannot be performed if the virtual machine has the **Undo disks** option enabled or if it has snapshots.

If you want to compact the virtual hard disk of a virtual machine with Windows 2003 or later, you may use Parallels Compressor that deletes temporary and unnecessary files from the disk, empties the Recycle Bin, performs disk defragmenting and disk compacting. For details on using Parallels Compressor, see **Using Parallels Compressor** (p. 251).
Managing Virtual Machines From iPhone

With the Parallels Mobile application, you can start, stop, and suspend your virtual machine or simply view its desktop right from your iPhone when your Mac is out of reach. All you need is to connect your iPhone to the Internet, launch the Parallels iPhone application, and establish a connection with your Mac.

Before you try to connect your iPhone to Parallels Desktop on your Mac:

- Enable the Allow connections from iPhone option in the General pane of the Parallels Desktop Preferences (p. 42).
- Contact your system administrator or Internet provider to learn the external IP address of your Mac.
- Check your short user name by entering the following command in Terminal: whoami
- Make sure that the port 64001 is not blocked by firewall. (This action is optional, since firewall does not block port 64001 as usual.) Port 64001 is used by Parallels Desktop for external connections.

Installing Parallels Mobile

The Parallels Mobile application can be downloaded for free from the App Store and is installed like any other iPhone application. Just search for "Parallels Mobile" at the App Store.

Starting Parallels Mobile

You can start the Parallels Mobile application by clicking its icon on the iPhone Home screen.

Adding your Mac to the Hosts list

1. Start the Parallels Mobile application and click the add button.
2. Specify the IP address of your Mac, your user name, and the password.
   - **Host.** In this field, specify the external IP address of your Mac.

   **Note:** Parallels Desktop uses port 64001 for external connections. This port shouldn't be blocked by firewall.

   - **User Name.** In this field, specify your short user name.
   - **Password.** In this field, type your password and specify if you want to save it for future connections.

When finished, click the Save button.

**Note:** The computer you are trying to connect to should be turned on and have a stable Internet connection.
When the connection to your Mac is established, it will be added to the **Hosts** list.

**Viewing and managing your virtual machines**

1. Select your Mac in the **Hosts** list. This will open a list of virtual machines available on your Mac.

2. The list of virtual machines displays the names of the virtual machines available on your Mac and the types of operating systems installed in them. The virtual machines that are currently running are indicated by this sign: 🏛

Select a virtual machine from the list to see its console window.
The appearance of the virtual machine console window depends on its current state:

- If the virtual machine is running, you will see its live screen shot. To refresh the screen shot, click the refresh button.
- If the virtual machine is stopped, its screen will be black.
- If the virtual machine is suspended or paused, its screen will be dimmed.
For managing your virtual machine, use the toolbar buttons that correspond to the actions you want to perform with this virtual machine:

- 🔔 - Use this button to start the virtual machine if it is stopped or to shut down it if it is running.

- 🔑 - Use this button to reset the virtual machine.

- ⏳ - Use this button to suspend your virtual machine. When the virtual machine is suspended, this button changes its appearance to ⏯. Click this button to resume the virtual machine.

- ⏭ - Use this button to pause the virtual machine. When the virtual machine is paused, this button changes its appearance to ➤. Click this button to resume the virtual machine.

- ⌘ - Use this button to refresh the virtual machine live screen shot.

When supervising applications and processes running in the virtual machine, you will need to use the Refresh button ⌘, since the virtual machine's screen can be refreshed only manually.

To go back to the list of virtual machines, click Virtual Machines.
Troubleshooting the Firewall and Network Problems

Editing Firewall Settings

The settings you may need to apply to the firewall application depend on the type of firewall you use:

- **Application Firewall** (on Mac OS X Leopard). Go to General Preferences > Security > Firewall and allow incoming connections to Parallels Desktop.
- **IPFW**. Check the firewall rules list and add a new rule that will allow TCP connections to your 64001 port from any locations.
- **Intego NetBarrier**. Create a new rule that will allow incoming connections from the Internet (Source) to Parallels Desktop (Service) on your Mac (Destination).

Please contact your system administrator before configuring the firewall.

Establishing a VPN connection from iPhone

If your computer is behind NAT and you have a VPN access to your LAN, you can learn how to establish a VPN connection from an iPhone using these online resources:


Forwarding TCP traffic to your Mac

If your computer is behind NAT and you don't have VPN access to your LAN, you should set port forwarding rules on your router to forward TCP traffic from certain port on your router to 64001 port on your Mac. If you want to access several Macs, you should create a separate port forwarding rule for each Mac.

Please contact your system administrator and read the router configuration guide before configuring the router.
CHAPTER 10

Working With Snapshots

A snapshot is a saved state of the virtual machine. Snapshots can be created manually or automatically when the virtual machine is running. After you make a snapshot, you can continue working with the virtual machine and revert to the created snapshot at any time of your work.

Snapshots are stored in the primary OS inside the virtual machine bundle (p. 15), in the Snapshots subfolder. Each snapshot has a number of files, including the .sav file that contains the virtual machine's state, the .mem file that contains the memory dump for the virtual machine, and other different files of the virtual hard disk.

Note: Snapshots are not backup copies or clones (p. 216) of your virtual machine. You cannot use them alone without your virtual machine or move them from the virtual machine bundle.

You may need to make snapshots in the following cases:

- If you are configuring a software that requires a lot of settings, you may want to explore the settings functions before selecting them. For testing the settings, create snapshots at branching points.
- If you want to mark milestones in the development process. If something goes wrong, you can always revert to the previous state or create a branch of snapshots starting with the particular milestone snapshot.

Note: Snapshots cannot be created for virtual machines that use the Boot Camp partition.

In This Chapter

Making Snapshots ................................................................................................................. 235
Managing Snapshots ............................................................................................................. 236
Making Snapshots

Snapshots can be created manually when the virtual machine is running or automatically using SmartGuard (p. 166).

To make a snapshot manually:

1. Make sure that you completed all operations of installing, downloading, or writing to external devices before taking a snapshot.

   **Note:** You can create a snapshot at any time. But it is recommended to complete all operations of installing, downloading, or writing to external devices before taking a snapshot. You should also complete or cancel any transactions performed via the virtual machine in external databases.

2. Choose **Take Snapshot** from the **Virtual Machine** menu or use the **Take Snapshot** button on the toolbar of your virtual machine's window. If the toolbar does not contain this button, you can add it to the toolbar. For more information, refer to the **Customizing Toolbar** section (p. 41).

   **Note:** To make a snapshot, you can also use Snapshot Manager. Just open the manager by choosing **Snapshot Manager** from the **Virtual Machine** menu and click the **New** button. A new snapshot will be created.

3. In the **Snapshot Parameters** window, you can provide a name and a short description for the snapshot. This information and the date of creation will be visible in Snapshot Manager when you hover the pointer over the snapshot icon.

4. Click **OK** to take a snapshot.

After the snapshot is created, you can continue working with your virtual machine's current state or use any of its snapshots.

To revert to a snapshot, open Snapshot Manager by choosing **Snapshot Manager** from the **Virtual Machine** menu or by clicking the **Snapshot Manager** button on the toolbar of the virtual machine window.

To create snapshots automatically, configure the **SmartGuard** settings (p. 166).
Managing Snapshots

You can use Snapshot Manager to revert to a specific snapshot, as well as to manage the snapshots. To open Snapshot Manager:

- Choose **Snapshot Manager** from the **Virtual Machine** menu, or
- Click the **Snapshot Manager** button on the toolbar of the virtual machine window.

**Note:** To add this button in the toolbar, you should customize it. To learn how to do that, refer to the **Customizing Toolbar** section (p. 41).

Using Snapshot Manager, you can:

- create new snapshots and delete the unused ones
- view the snapshot tree of a particular virtual machine
- select a snapshot to revert to
The Virtual Machine Snapshots window consists of the following areas:

- The snapshots tree pane.
- The snapshots management pane.

**Snapshots Tree Pane**

Snapshot icons appear as screen shots of the guest OS window if the virtual machine was running at the time you created a snapshot.

The left icon with a flag is the *root* of the snapshots tree - it is the initial state of the virtual machine used as the reference point. You cannot delete the root icon. The root icon is visible if at least one snapshot exists. If you want to delete a snapshot which is parental for some other snapshots, you can decide whether to delete only this snapshot or delete it with all the subsequent snapshots.

All snapshots in the snapshots tree are descendants of the *root* state of the virtual machine. The first snapshot contains "differences" with respect to the root state. The second successive snapshot contains differences with respect to the first snapshot. You may want to return to one of the previous snapshots and work with it. If you then create a new snapshot, a new snapshots branch will be created.

An icon that represents the current state of the virtual machine is marked by a red flag.

When you hover the pointer over an item, you will see a tooltip message with a short description.

**Snapshots Management Pane**

The snapshots management pane includes the buttons necessary for managing the snapshots.

- The **New** button. Click this button to create a new snapshot for the present state of your virtual machine.
- The **Go to** button. Select the snapshot you want to go to in the snapshots tree and click this button to move from the present state of your virtual machine to the state saved in this snapshot.

*Note:* Before you go to a specific snapshot, decide what you want to do with the current state of the virtual machine - by default, it will not be saved. To retain the changes made since the last snapshot, make a new snapshot.

- The **Delete** button. Select the snapshot you want to delete and click this button. If you delete an intermediate snapshot, the information it contains will be merged into the subsequent snapshot.

*Note:* You cannot delete the *root* icon. It disappears only when you delete all snapshots in the tree.

You can also manage snapshots by right-clicking them in the tree:

- If you right-click the icon that shows the present state of the virtual machine, you can create a new snapshot for this state.
- If you right-click any other intermediate snapshot, you can choose to go to it, to delete it alone or with all the subsequent snapshots.
Going to a Snapshot

1. Launch Parallels Desktop and open a virtual machine.

2. Open Snapshot Manager by
   - choosing **Snapshot Manager** from the **Virtual Machine** menu, or
   - clicking the **Snapshot Manager** icon in the toolbar of the virtual machine main window.

3. In the **Virtual Machine Snapshots** window, choose the snapshot and click the **Go To** button. You can also right-click the snapshot and choose **Go to Snapshot** from the shortcut menu or just double-click the snapshot.

   **Note:** If, after the Parallels Desktop update, you decided to revert to one of the snapshots made before the update, you will see the message that a new Parallels Tools update is available. We recommend you to install them to work effectively with the virtual machine.

4. If you revert to a snapshot from an unsaved state of the virtual machine, you will see the notification about that. Click **Yes** if you want to proceed without saving the state. Click **No** if you want to save the state and then go to the needed snapshot.

   If you want to revert to the previous snapshot made on the same branch of snapshots, use the **Revert To Snapshot** option from the **Virtual Machine** menu or from the virtual machine main window toolbar. If you want to know to what exactly snapshot you will revert, you can always see your snapshots tree in Snapshot Manager (p. 236).

   **Note:** If you revert to the previous snapshot from an unsaved state of the virtual machine, you will see the notification about that. Click **Yes** if you want to proceed without saving the state. Click **No** if you want to save the state and then revert to the snapshot.

   After reverting to a snapshot, it is recommended to update Parallels Tools in the virtual machine.

Deleting a Snapshot

1. Launch Parallels Desktop and choose a virtual machine.

2. Open Snapshot Manager by
   - choosing **Snapshot Manager** from the **Virtual Machine** menu, or
   - clicking the **Snapshot Manager** button in the toolbar of the virtual machine window.

3. Select the snapshot you want to delete and click the **Delete** button if you want to delete only this snapshot. If you want to delete all the snapshots that come after it, right-click the snapshot and choose the **Delete Snapshot with children** option.

   If you delete an intermediate snapshot, the information it contains will be merged into the snapshot that follows it.

   **Note:** You cannot delete the root icon, but it gets automatically deleted after you delete all the other snapshots.

Merging Snapshots
Merging is performed automatically when you delete any snapshot except the last one in the branch. When you delete an intermediate snapshot, the information it contains is merged into the next snapshot of the same branch.

If you delete the snapshot belonging to two branches, the information is merged into the next snapshot of each branch.

**Note:** If you delete the snapshot that comes after the root icon and that belongs to two branches, the branches will start from the initial state icon directly.

The snapshots are also merged automatically if you manage the capacity of your virtual hard disk with the help of Parallels Image Tool. Before applying any changes to the virtual hard disk, Parallels Image Tool merges and deletes all the snapshots except for the last one. Unlike merging the snapshots in Snapshot Manager, the results of merging process via Parallels Image Tool are not reflected in the snapshots tree, and the icons of already deleted snapshots are still present in the tree.
This chapter provides the necessary information on using a Boot Camp partition with the Windows XP or Windows Vista installation in a Parallels virtual machine.

In This Chapter

Overview ............................................................................................................................... 241
Boot Camp Configurations ................................................................................................... 242
Creating a Virtual Machine for the Boot Camp Partition ..................................................... 243
Booting via Parallels Virtual Machine .................................................................................. 245
Booting via Boot Camp ......................................................................................................... 247
Overview

In the current version of Parallels Desktop, you can use your Boot Camp Windows Vista (SP1) or Windows XP (SP2 or SP3) partition as a bootable disk or as a data disk in virtual machines.

**Warning:** If your Boot Camp partition has not Windows XP (SP2) or Windows Vista (SP1) operating system installed, you may damage this installation trying to use it via Parallels Desktop virtual machine.

Using Boot Camp Partition as a Data Disk

To use the Boot Camp Windows partition as a data disk, add it as a hard disk to an existing Windows XP or Windows Vista virtual machine respectively. Add the disk with the help of Add Hardware Assistant (p. 198). The Windows operating systems will automatically recognize it as a new disk.

Using Boot Camp Partition as a Bootable Disk

If you install Parallels Desktop on a Mac computer with a Boot Camp Windows XP/SP2 or Windows Vista (SP1) partition, and Parallels Desktop detects that there are no virtual machines on the computer, it automatically creates a new virtual machine for this Boot Camp partition and places it to the following location:

<Username>/Documents/Parallels/My Boot Camp

- If the Boot Camp partition is mounted to the Mac's Desktop, Parallels Desktop attempts to recognize the operating system installed on the partition and creates an appropriate virtual machine for the recognized OS.
- If the Boot Camp partition is not mounted to the Mac's Desktop, or if Parallels Desktop cannot recognize the operating system, it creates a virtual machine for Windows XP. If you have Windows Vista installed on the Boot Camp partition, you just need to change the type of the guest OS for the virtual machine from Windows XP to Windows Vista in the **Virtual Machine Configuration** (p. 146) dialog.

Alternatively, you do not need to create a special virtual machine for the Boot Camp partition, but can simply substitute a bootable virtual disk of an existing Windows virtual machine with a Boot Camp partition. To do that, use the **Virtual Machine Configuration** (p. 146) dialog.

**Note:** It is important to specify the type of the guest OS in the virtual machine correctly, in accordance with the operating system installed on the Boot Camp partition.

When you boot into Boot Camp Windows through Parallels Desktop for the first time, Parallels Desktop installs Parallels Tools.

**Note:** Using Boot Camp Windows XP via virtual machine may require to re-activate Windows XP or Windows Vista.
After that, you can use Boot Camp as usually to boot into the Windows partition, or you can boot into it via Parallels virtual machine, see the Booting via Parallels Virtual Machine section (p. 245).

**Limitations for Parallels Virtual Machines Using Boot Camp Partition**

There is a number of limitations for a Parallels virtual machine that uses the Boot Camp Windows partition either as a bootable volume or as a data disk:

- it cannot be suspended or paused
- such a virtual machine cannot have snapshots and the Safe Mode feature cannot be enabled for it
- compression or compacting cannot be performed

*Note:* In Parallels Desktop 4, there is no limitations on types of users who can access the Boot Camp Windows partition from a virtual machine. You can log into Windows even if you don't have administrator rights.

**Boot Camp Configurations**

When creating a Boot Camp virtual machine, you can set its configuration. There may be two types of Parallels Boot Camp configurations:

- default Boot Camp configuration and
- custom Boot Camp configuration

The default Boot Camp configuration allows using only one Boot Camp partition in a Windows XP or Windows Vista led. The custom Boot Camp configuration allows using several physical partitions grouped as Boot Camp disks.

If you have chosen to customize the Boot Camp configuration, you should define one or more (up to total 4 disk drives) custom Boot Camp disks. To do that, just replace an existing definition of the virtual disk by the custom Boot Camp disk definition. A custom Boot Camp disk may include several partitions from the same hard disk.

Parallels Boot Camp supports disks with GPT or MBR disk partitioning schemes, but handles them differently.

- **GPT** is the default disk partitioning scheme used on Mac computers. Parallels Desktop can connect partitions from such disks into a virtual machine configuration, converting this partitioning scheme to MBR scheme. In the virtual machine, you will see only those partitions that were connected to the virtual machine. Other partitions will not be visible even if they are present on a real hard disk.
  
  Windows XP and Windows Vista are supported as bootable OSs on GPT disks.

- **MBR** is a default partitioning scheme on personal computers. Parallels Desktop can connect partitions (including logical disks) from such disks into the virtual machine configuration. In the virtual machine, you will be able to see all the partitions on a real hard disk, but will have a read/write access only to the connected ones.
Creating a Virtual Machine for the Boot Camp Partition

To create a new virtual machine for using the Boot Camp Windows XP (SP2 or SP3) or Windows Vista (SP1) partition, do the following:

1. Boot into Mac OS X.
2. Start Parallels Desktop and launch New Virtual Machine Assistant by clicking New Virtual Machine on the File menu or choosing Virtual Machines Directory from the Window menu and clicking the button in the displayed window.
3. In the Introduction window, click Continue to proceed with the virtual machine creation.
4. In the Operating System Detection window, click Skip Detection.
5. In the Select Operating System Type and Version window, select the type and version of guest OS you want to install in this virtual machine and click Continue. You can either select an operating system from the list, or select Other in case you cannot find the required one there.
6. In the Virtual Machine Type window, select Custom and click Continue.
7. In the CPU and Memory Options window, specify the number of CPU(s) and the amount of RAM for the virtual machine and click Continue. You may use the slider or arrow buttons to set the value or simply type it into the corresponding field.
8 In the **Hard Disk Options** window, select **Boot Camp**. Click **Continue**.

9 Specify the Boot Camp disk details. Click **Continue**.

10 Then proceed as described in the **Custom Installation Mode** section (p. 79).
### Booting via Parallels Virtual Machine

When you boot into the Boot Camp Windows partition for the first time, you may notice some problems with the mouse and keyboard. In this case, wait while Windows configures the driver settings to enable the devices. Follow the instructions on the first-time booting into Boot Camp partitions with Windows XP and Windows Vista.

To boot into Boot Camp partition with Windows XP:

1. Start your Mac computer and boot into Mac OS X.
   
   **Note:** You may be prompted to authenticate using your Mac administrator account.

2. Launch Parallels Desktop and start the virtual machine created for using the Boot Camp partition.

3. You may notice some problems with the mouse and keyboard; do nothing, just wait until they become enabled.
   
   As soon as the mouse and keyboard are enabled, Parallels Desktop initiates the Parallels Tools installation.

4. When the installation is complete, the guest OS restarts automatically.

5. Upon booting, activate your Windows XP once again. You will have to reactivate it only once. Detailed information on how to activate Windows XP can be found at [http://support.microsoft.com/kb/307890](http://support.microsoft.com/kb/307890).

To boot into Boot Camp partition with Windows Vista:

1. Start your Mac computer and boot into Mac OS X.
   
   **Note:** You may be prompted to authenticate using your Mac administrator account.

2. Launch Parallels Desktop and start the virtual machine created for using the Boot Camp partition.

3. You may notice some problems with the mouse and keyboard; do nothing, just wait until they become enabled.
   
   As soon as the mouse and keyboard are enabled, Windows Vista restarts automatically.

4. Upon booting, Windows Vista may prompt you for your Windows user name and password. Log in as a user with the administrator's rights.

5. The installation of Parallels Tools starts automatically.

6. When the installation is complete, the guest OS will restart.

7. Upon booting, activate your Windows Vista once again. You will have to reactivate it only once. Detailed information on how to activate Windows Vista can be found at [http://support.microsoft.com/kb/940315](http://support.microsoft.com/kb/940315).
Warning: In case you met an error not related to the guest OS while working with virtual machine using the Boot Camp Windows installation, restart this Parallels virtual machine before you try to boot via Boot Camp as usual.

Troubleshooting Windows XP That Misses Drivers

When booting into Boot Camp Windows XP via the virtual machine, you may get the message saying that Parallels Desktop cannot find necessary drivers. In this case, do the following:

1. Boot into Windows XP via Boot Camp.
2. Insert a Microsoft Windows installation disc that was used for this Windows installation.
3. Locate the folder i368 on the disc and open it. Copy the following files: driver.cab and sp2.cab to C:\Windows\Driver Cache\i386.
Booting via Boot Camp

After you have installed Parallels Desktop and booted for the first time into the Boot Camp Windows partition via a virtual machine, you can continue booting into this partition as usually, via Boot Camp. The Parallels Tools installation does not affect Windows operating system itself, it only helps you work with this operating system via the virtual machine.

To boot via Boot Camp partition:

1. Start your Macintosh computer, perform the usual actions required to boot into Boot Camp.
2. You'll see Windows starting up.

**Warning:** Before booting into the partition via Boot Camp, make sure that the Boot Camp virtual machine is stopped.

**Troubleshooting**

When booting into Boot Camp, you may get a black screen with the choice of two configurations:

- Parallels
- Windows XP or Windows Vista

You may get an error message about a computer disk hardware configuration problem.

To troubleshoot a problem:

1. Restart your Macintosh computer and boot into Mac OS X.
2. Start Parallels Desktop. Start the virtual machine which uses the Boot Camp Windows installation as a bootable disk.
3. Wait while the guest OS is fully loaded and running. Shut it down.
4. Restart your Macintosh computer.
5. Try to boot via Boot Camp again. This time, booting must be successful.

Anyway, you can connect this partition as a data disk to any Windows XP or Windows Vista virtual machine.
CHAPTER 12

Using Parallels Add-ons

In This Chapter

Using Parallels Transporter ................................................................. 248
Using Parallels Explorer ................................................................. 250
Using Parallels Compressor ............................................................ 251
Using Parallels Image Tool ............................................................. 254

Using Parallels Transporter

Parallels Transporter is an easy-to-use application which helps you migrate physical or virtual computers with the whole information they contain to Parallels virtual machines on your Mac. This chapter contains an overview of Parallels Transporter usage scenarios and working principles.

Parallels Transporter is provided as a Parallels Desktop utility and is installed automatically during the Parallels Desktop installation.

For the detailed information, see Parallels Transporter Help.
Parallels Transporter Working Principles

Parallels Transporter package includes two applications:

- **Parallels Transporter.** This application transfers data stored on a physical computer or a volume to a Parallels virtual machine or virtual hard disk.
- **Parallels Transporter Agent.** This application collects essential system data on the remote computer (the *source computer*) or volume you are planning to migrate and transfers it to Parallels Transporter installed on the computer that will host the resulting virtual machine or virtual hard disk (the *host computer*).

Parallels Transporter is provided as a Parallels Desktop utility and is installed automatically on your Mac during the Parallels Desktop installation.

On the source computer, you can install a separate package containing Parallels Transporter and Parallels Transporter Agent. You can download the most recent version of Parallels Transporter package from Parallels Download Center (http://www.parallels.com/en/download/desktop/):

- for a PC with a Windows OS installed - *Parallels-Transporter-Full-x.x.xxxx-en_US.exe*
- for a PC with a Linux OS installed - *parallels-transporter-xxxx.xxxxxx.run*

Each of these packages contains Parallels Transporter and Parallels Transporter Agent. Depending on what scenario will be used, install Parallels Transporter Agent or both on the source PC. Before you start the migration, make sure that your your Mac and the source PC are connected by a network cable and can access each other over the network. Check that you have enough free disk space on the host computer to allocate the resulting images of the migrated volumes.

For more detailed information, please refer to *Parallels Transporter User's Guide*. 
Using Parallels Explorer

Parallels Explorer - is a tool for browsing through and organizing the contents of your Parallels (and other) virtual machines in Mac OS X. With it, you can view and change data inside a virtual machine without starting it. Also, you can exchange files and folders between Mac OS X and a powered off virtual machine. By using Parallels Explorer, you can save time and computer resources on routine operations, such as moving files between Mac OS X and a virtual machine.

Parallels Explorer is installed with Parallels Desktop for Mac and does not require separate installation. You can find Parallels Explorer in the /Applications/Parallels folder on your Mac.

To start Parallels Explorer:

1. Click Finder, open the /Applications/Parallels folder.
2. Double-click the Parallels Explorer icon.

When Parallels Explorer starts, it automatically detects all Parallels virtual machines, except Boot Camp-based virtual machines, on your Mac OS hard disk and displays them in the working area.

The Parallels Explorer interface is similar to that of the Mac OS Finder. You can work in multi-window mode, which is useful when you browse several virtual disks, change the appearance of Parallels Explorer window by switching between Icon, Tree, and Column view modes.

To browse the contents of virtual machines:

1. Click Virtual Machines in the sidebar.
2. In the working area, double-click the .pvs file for the virtual machine.
3. If the virtual machine has multiple volumes, then double-click the volume to explore.

To browse the contents of virtual disks:

1. Click Virtual Disks in the sidebar.
2. In the working area, double-click the .hdd file.

**Working with the contents of a virtual hard disk**

With Parallels Explorer you can copy, paste, delete and rename files and folders. Also, you can open some types of files without starting a virtual machine. To manage files and folders in Parallels Explorer you can use either the shortcut menu, which appears when you right-click an item, or the Edit menu commands.

**Note:** If you copy files to a Windows virtual machine using Parallels Explorer or Parallels Mounter, you need to log in to Windows as an administrator to be able to open them inside the virtual machine.

For more information about Parallels Explorer, refer to Parallels Explorer User Guide.
Using Parallels Compressor

Parallels Compressor is an easy-to-use Parallels utility which will help you keep your virtual machines efficient for many purposes.

Parallels Compressor is a part of the Parallels Tools set and is installed, updated, and removed with Parallels Tools. To start Parallels Compressor, choose Run Parallels Compressor from the Virtual Machine menu.

Note: Parallels Compressor is not available for the virtual machines that use the Boot Camp partition. The Run Parallels Compressor menu command is disabled.

Parallels Compressor allows users to:

- effectively clean up disk space in a virtual machine
- significantly reduce the size of virtual hard disks files
- efficiently use the resources of a physical hard disk

Warning: Compressing of a virtual machine cannot be performed if the virtual machine has the Undo disks option enabled, or if it has snapshots. Compressing is also unavailable for the virtual machines with plain disks.

If, nevertheless, you want to compress the virtual machine that has snapshots, delete all the snapshots with the help of Snapshot Manager before you start compressing the virtual machine's disks. For more information, refer to Managing Snapshots (p. 236).

To compress the virtual machine with Undo Disks (p. 151), first disable the Undo disks feature in Configuration Editor.
Parallels Compressor Working Principles

Compressor processes a virtual machine in the following way:

- defragments virtual disks and cleans up unused space
- compacts virtual disks

The actions performed on your particular virtual machine depend upon the running mode:

- in automatic mode Parallels Compressor compresses only the current system disk performing the pre-defined set of actions
- in manual mode you are able to choose disks to compress and actions to perform

More about running modes and other Compressor properties can be found in Parallels Compressor Help.

Steps of the Compression Procedure

Parallels Compressor is designed to perform the most efficient compression of a virtual machine. The procedure consists of two steps:

- a preparatory step performed in the guest operating system (deleting temporary and unnecessary files, defragmenting virtual disks and cleaning unused disk space);
- a compacting step (reducing the size of the virtual disk files) performed in the primary operating system.

Guest Operating System Requirements

Parallels Compressor supports the following guest operating systems:

32-bit operating systems:
- Windows 2000 Server SP4, Professional SP4
- Windows XP Professional SP2, SP3, Home SP2, SP3
- Windows Server 2003 Web, Standard, Enterprise, Datacenter SP2, R2
- Windows Vista Home, Business, Ultimate, Enterprise SP0, SP1
- Windows 2008

64-bit operating systems:
- Windows XP Professional SP2
- Windows Server 2003 Web, Standard, Enterprise, Datacenter SP2, R2
- Windows Vista Home, Business, Ultimate, Enterprise SP0, SP1
- Windows 2008
How to Run Parallels Compressor

Before Starting Parallels Compressor

Before starting the utility, back up your virtual machine by cloning it or by copying its hard disk files to a safe location. This will allow you to restore your virtual machine in case you do not like the results of the compression.

Warning: The result of virtual machine compression is irreversible.

To start Parallels Compressor:

1. Start the virtual machine you want to compress.
2. Log in to the guest operating system as a user with administrator rights.
   Note: To run Parallels Compressor in a virtual machine you must have administrator rights in the guest operating system.
3. Choose Run Parallels Compressor from the Virtual Machine menu.

Running Parallels Compressor

Parallels Compressor has the following running modes:

- automatic, the default mode. In this mode Compressor uses the default compression options.
- manual, Parallels Compressor runs as a wizard which helps you select the options of virtual machine compression.

When you start Parallels Compressor, you will see the dialog box with a time indicator. The time indicator shows the time remaining until Parallels Compressor will run in automatic mode (timeout is about 10 seconds).
To run Parallels Compressor:

- in automatic mode, do not do anything, just wait until the timeout expires.
- in manual mode, press the ESC key or click the Manual Mode button on the dialog box before the timeout expires.
- Detailed information about running Compressor in these modes is given in Parallels Compressor Help.

**After Compressing Is Finished**

When the compressing is complete, click Finish to exit Parallels Compressor.

---

**Using Parallels Image Tool**

Virtual machines use virtual hard disks that actually are hard disk image files. After using your virtual machine for some time, you may find that your virtual machine hard disk does not fit your needs anymore, and you want to increase its capacity, reduce its size, or change its type and properties. Parallels has developed a special utility for increasing the virtual hard disk capacity and managing its properties - Parallels Image Tool.

**Note:** The virtual hard disk image file can be found inside the virtual machine's PVM bundle. In Mac OS X PVM bundles are stored in the /<Username>/Documents/Parallels/ folder by default.

Parallels Image Tool is installed automatically during the Parallels Desktop installation.

By default, Parallels Image Tool is installed to the following folder: /Applications/Parallels.
Increasing the Virtual Hard Disk Capacity

If you find that the capacity of your virtual machine’s hard disk does not fit your needs anymore, you can increase it using Parallels Image Tool.

To increase the capacity of the virtual hard disk:

1. Launch Parallels Image Tool.
2. In the Introduction window, click Continue.
3. Specify the source virtual disk image file with the .hdd extension in the Source Virtual Disk window. You may type the path and file name or use the Choose button to locate the file. The virtual hard disk image file can be found inside the virtual machine's PVM bundle. PVM bundles are stored by default:
   - in the /<Username>/Documents/Parallels/ folder in Mac OS X.
   - in the C:\Documents and Settings\<Username>\My Documents\Parallels\ folder in the Windows primary OS.
   - in the /<username>/parallels directory in the Linux primary OS.

   Note: The virtual machine using this virtual hard disk should be stopped before proceeding.

4. Select the Increase the disk capacity option in the Select Action window.
5. Specify the new capacity for the disk. The Add the unallocated space to the last volume check box, which is selected by default, means that the additional disk space will be added to the last volume. If you clear it, the added space will appear as unallocated space. To allocate this space, you can either create a new partition or expand an existing partition. For instructions on allocating the added space, see the Using the Added Space section of Parallels Image Tool User's Guide.

   Note: If you choose a hard disk used by a virtual machine that has snapshots, all snapshots, except the last one, will be deleted.

To start the process of increasing the disk capacity, click Start. You can view the operation progress in the Processing the File window. Clicking Cancel terminates the operation.
Note: If the virtual hard disk image file you specified is in the old format, it will be automatically converted to the new format.

6 After the disk image has been successfully modified, the Execution is Completed window appears. Click Finish to close Parallels Image Tool.
Managing the Virtual Hard Disk Properties

With Parallels Image Tool, you can manage the properties of your virtual machine hard disk. You can change the virtual hard disk type from *plain* to *expanding* and vice versa, split or merge the disk parts, or merge snapshots of the virtual machine that uses this virtual hard disk.

To change the type of the virtual hard disk:

1. Launch Parallels Image Tool.
2. In the **Introduction** window, click **Continue**.
3. Specify the source image file of the virtual hard disk in the **Source Virtual Disk Image File** window. You may type the path and file name or use the **Choose** button to locate the file. The virtual hard disk image file can be found inside the virtual machine's PVM bundle. PVM bundles are stored by default:
   - in the `/<Username>/Documents/Parallels/` folder in Mac OS X.
   - in the `C:\Documents and Settings\<Username>\My Documents\Parallels\` folder in the Windows primary OS.
   - in the `/<username>/parallels` directory in the Linux primary OS.

   **Note:** The virtual machine using this virtual hard disk should be stopped before proceeding.
4. Select the **Manage disk properties** option in the **Select Action** window.
5. In the **Select Operations** window, choose one or several of the following operations to perform on the disk and click **Start**:

   **Note:** The operations with the virtual hard disk are irreversible.

   - If the virtual hard disk image you specified is an *expanding* virtual hard disk, the **Split virtual hard disk image file** option is selected by default.
   - If it is an *expanding* disk, you can select the **Convert to Plain** option.
   - If it is a *plain* disk, the **Convert to Expanding** option is selected by default.
   - If the hard disk image you selected has snapshots, the **Merge snapshots** option is selected by default. You cannot clear this option.

   **Note:** The merging process deletes all the snapshots, except the last one.

Parallels Image Tool needs to merge all the snapshots of the current virtual hard disk before performing any actions with it. The information from all the snapshots will be merged to the last one, and all the other snapshots will be deleted. Parallels Image Tool does not change the snapshots tree in Snapshot Manager, so if you attempt to revert to any snapshot of the tree, it will be no longer accessible, and you can remove it manually.
Note: If the virtual hard disk image file you specified is in the old format, it will be automatically converted to the new format.

You can view the operation progress in the Processing the File window. Clicking Cancel terminates the operation.

6 After the disk image has been successfully modified, the Execution is Completed window appears. Click Finish to close Parallels Image Tool.
Changing the Virtual Hard Disk Format

If you want to use your virtual machine with an earlier version of Parallels Desktop, use Parallels Image Tool to convert its hard disk image file to the old format. Image Tool can be also used to convert virtual hard disk image files created with Parallels Desktop 2.5 or older to the new format, supported by Parallels Desktop 4.

**Warning:** If you have Parallels Tools installed on your virtual hard disk, remove them before processing the disk.

To change the format of your virtual hard disk image file:

1. Launch Parallels Image Tool.
2. In the **Introduction** window, click **Continue**.
3. Specify the source image file of the virtual hard disk in the **Source Virtual Disk Image File** window. You may type the path and file name or use the **Choose** button to locate the file.
4. In the **Select Action** window, select:
   - **Convert to the old format** if your hard disk image file is in the Parallels Desktop 4 format and click **Start**. In this case, the hard disk will be converted into the Parallels Desktop 2.5 format.
   - **Convert to the new format** if your hard disk image file is in the Parallels Desktop 2.5 format and click **Start**. In this case, the hard disk will be converted into the Parallels Desktop 4 format.

**Note:** If you are converting the disk to the old format, you may need to reconfigure the guest OS installed on it. To do that, you will need the installation media for the guest OS installed on the disk. You may insert it into the CD/DVD-ROM drive of your computer or select the installation media to use in the **More Options** area. When finished, click **Start**.
You can view the operation progress in the **Processing the File** window. Clicking **Cancel** terminates the operation.

5 After the disk image has been successfully modified, the **Execution is Completed** window appears. Click **Finish** to close Parallels Image Tool.

## Reducing the Virtual Hard Disk Size

With Parallels Image Tool, you can manage the properties of your virtual machine hard disk.

If you have an expanding virtual hard disk and need to reduce its size by removing unused space on the disk, you can compact it.

**Note:** A plain virtual hard disk cannot be compacted.

To reduce the virtual hard disks size:

1 Launch Parallels Image Tool.
2 In the **Introduction** window, click **Continue**.
3 Specify the source image file of the virtual hard disk in the **Source Virtual Disk Image File** window. You may type the path and file name or use the **Choose** button to locate the file. The virtual hard disk image file can be found inside the virtual machine's PVM bundle. PVM bundles are stored by default:
   - in the \;/<Username>/Documents/Parallels/ folder in Mac OS X.
   - in the \;C:\Documents and Settings\<Username>\My Documents\Parallels\ folder in the Windows primary OS.
   - in the \;/<username>/parallels directory in the Linux primary OS.

**Note:** The virtual machine using this virtual hard disk should be stopped before proceeding.

4 Select the **Compact the disk** option in the **Select Action** window and click **Start**.
Note: If the virtual hard disk has one or several snapshots, Parallels Image Tool needs to merge them before performing the required action with the disk. The information from all snapshots will be merged to the last one, and all the rest will be deleted. Parallels Image Tool does not change the snapshots tree in Snapshot Manager, so if you attempt to revert to any snapshot of the tree, it will be no longer accessible, and you can remove it manually.

The disk compacting procedure starts.

4. Click **Finish** in the **Execution is Completed** window to exit Parallels Image Tool.
CHAPTER 13

Troubleshooting and Limitations

This chapter describes how to troubleshoot known issues.

In This Chapter

- Getting Technical Support .................................................................................................... 262
- Reporting a Problem to Parallels Team ................................................................................ 263
- Checking the Build Number .................................................................................................. 264
- Using the F8 Key in Windows Virtual Machines on Mac OS X .......................................... 265
- Upgrading or Installing Parallels Tools in Text Mode in a Linux Guest OS ....................... 266
- Installing the GCC package and kernel sources in Linux ..................................................... 267
- Setting Up Shared Folders in Linux Virtual Machines ......................................................... 268
- Configuring Network in Linux .............................................................................................. 269
- Suspending a Boot Camp Virtual Machine ......................................................................... 270
- Problems With Setting Up Network ..................................................................................... 270
- Problems With Antivirus Software ..................................................................................... 271

Getting Technical Support

If you have problems using Parallels Desktop, please first view Parallels Desktop FAQs http://www.parallels.com/en/support/faq/.

Our friendly technical support team is ready to help. Describe your problem and submit a free support request to the Parallels support team http://www.parallels.com/en/support/desktop/.

To find solutions for common problems, explore Parallels Knowledge Base (http://kb.parallels.com/). This online resource comprises valuable articles about using Parallels Desktop.

Telephone support is available on a per incident fee basis. For more information please, visit the page of the Parallels support team http://www.parallels.com/en/support/desktop/.
To help improve the quality of Parallels Desktop, you can send problem reports to Parallels support team. If a fatal error occurs in a virtual machine, Parallels Desktop automatically opens the Parallels Problem Report window prompting you to send a report. If you notice an unusual virtual machine behavior, you can create a report manually by choosing Report a Problem from the Help menu and filling out the form. Parallels Desktop will create a status report and make a screen shot of the running virtual machine.

**Note:** Parallels team collects error reports and uses them for identifying performance issues, but does not respond to them. If you need assistance in resolving the issue, visit Parallels forum or Support page, or log us a support call.

The Parallels Problem Report window looks as follows:
In the **Specify the problem type** field, you can select the type of your problem from the list. In the next field, you can add a short problem description. These two fields are optional.

The **Technical Data** option includes the .txt status report file that has been generated for the error. The status report contains the product version and activation data, primary and guest OSs information, virtual machine configuration and system data information, processor status, etc. Click the **Technical Data** icon to view the .txt file and to choose the sections that will be added to the report. The file is saved on your Mac. If you want to locate it, click the **Go To File** button.

The **Guest OS Screenshot** option includes the session screen shot of the guest OS in a .png format. This option is available if you create a problem report during the virtual machine session. Click the **Guest OS Screenshot** icon to see the screen shot and the path of its location on your Mac.

The **Primary OS Screenshot** option includes the session screen shot of the primary OS in a .png format. This screen shot is made and put on the primary OS desktop whenever you create a problem report. Click the **Primary OS Screenshot** icon to see the screen shot.

In the **Contact Name** and **Contact e-mail** fields, type your name and e-mail. This information will be used by the Parallels support team to address you for more technical details if needed.

**Sending a Report**

After you revise the problem report components, click **Send Report**. The report will receive its unique id number and will be sent to the Parallels support team.

---

**Checking the Build Number**

If you are not sure what version and build of the Parallels Desktop software you are using, you may check it on the **About Parallels Desktop** dialog.

To check your version and the build number:

1. Choose **About Parallels Desktop** from the **Parallels Desktop** menu.
2. The **About Parallels Desktop** window opens. See your version and the build number in the upper part of the dialog.

**Note:** The **About Parallels Desktop** dialog can also provide you with the useful information about your copy of Parallels Desktop, including the licensing information and a link to the Parallels support web page.
Using the F8 Key in Windows Virtual Machines on Mac OS X

If you have Mac OS X Leopard as a primary operating system, you may encounter problems when trying to use the F8 key or Ctrl+Arrow keys combinations in a Windows virtual machine. It happens, because in Mac OS X Leopard, the F8 key and Ctrl+arrow key combinations are reserved for the Spaces utility.

Possible solutions:

- Click the **Keyboard** icon on the virtual machine's status bar and choose **F8**.
- Change the **Spaces** utility hotkeys settings. To learn how to do it, refer to Mac OS X Leopard documentation.
After upgrading to Parallels Desktop 4, the X Server may fail to start in Linux virtual machines. To fix the problem, you need to install Parallels Tools in text mode.

1. Start the virtual machine.
2. When you see a message about X Server that failed to start, switch to another virtual console using Ctrl+Alt+F1 and enter your login details.
3. Choose **Install Parallels Tools** from the **Virtual Machine** menu to connect the Parallels Tools ISO image to your virtual machine.

**Note:** If the **Install Parallels Tools** option is grayed out, make sure that Parallels Tools can be installed in your guest operating system. To see the list of guest OSs supported by Parallels Tools, refer to the **Parallels Tools Overview** section in **Parallels Desktop User's Guide**.

The `prl-tools-lin.iso` image file will be connected to the virtual machine's CD/DVD-ROM drive.

4. In the virtual machine console, type the following command to gain the *root* privileges:
```bash
su
```

5. Check if the Parallels Tools CD image is mounted by entering:
```bash
mount | grep iso9660
```

   If this command does not return anything, proceed to the next step.

   If this command returns anything like

   ```bash
   /dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0),
   ```

   skip the next step and proceed to the following one.

   If this command returns anything like

   ```bash
   /dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0)
   ```

   with the **noexec** option present in parentheses, you need to unmount the disc using the following command and then proceed to the next step:

   ```bash
   umount /dev/cdrom
   ```

6. To mount the Parallels Tools installation disc image, enter the following:
```bash
mount -o exec /dev/cdrom /media/cdrom
```

**Note:** `/dev/cdrom` is the virtual machine's CD/DVD-ROM drive and `/media/cdrom` is the mount point for this device. In some of the Linux operating systems the virtual CD/DVD-ROM drive may appear as `/dev/hdb` and the mount point `/mnt/cdrom`. Some Linux OSs do not have the CD/DVD-ROM mount point. In this case, you should create the mount point directory manually.

7. When the installation disc image is mounted, change the directory to the CD/DVD-ROM directory using
```bash
cd /media/cdrom/
```

8. In the CD/DVD-ROM directory, enter the following to launch Parallels Tools installation:
```bash
./install
```
Note: You must have the root privileges to run this command.

9 Follow the Parallels Tools Installer instructions to complete the installation.

10 When the installation of Parallels Tools is complete, restart your virtual machine.

For general information about installing Parallels Tools in Linux, refer to Installing Parallels Tools in a Linux Guest OS (p. 94).

Installing the GCC package and kernel sources in Linux

When installing or upgrading Parallels Tools in a Linux virtual machine, you may need to install the gcc package and kernel sources in your Linux guest OS. Kernel sources can be either downloaded from the Internet, or installed from Linux distribution disks.

To install the gcc package and kernel sources in the RHEL/Fedora/CentOS Linux distribution, enter the following command in a terminal:

```
yum install gcc kernel-devel
make
```

To install the gcc package and kernel sources in the Debian/Ubuntu Linux distribution, enter the following command in a terminal:

```
apt-get install gcc make linux-headers-$\{(uname -r)\}
```

For information how to install the gcc package and kernel sources in other Linux distributions, refer to the corresponding Linux distribution documentation.

If you still experiencing problems, try to find a solution in Parallels Knowledge Base (http://kb.parallels.com/) or refer to the Parallels support team http://www.parallels.com/en/support/desktop/.
Setting Up Shared Folders in Linux Virtual Machines

You can experience problems with setting up the Shared Folders Tool in a Linux virtual machine if you have installed one of the following operating systems in it:

- Red Hat Enterprise Linux 5.0
- Fedora Linux 9, 8

In the aforementioned operating systems, Security-enhanced Linux (SELinux) is enabled by default. It blocks shared folders and does not allow them to mount automatically. If you are logged in as a root user, you can mount them manually or boot with the `selinux=0` command. To use the Shared folders Tool under other accounts, disable SELinux or change its permissive mode when having root privileges.

**Note:** If you boot with `selinux=0`, all files you create while SELinux is disabled will have no SELinux context information.

**Setting up User Privileges for Shared Folders**

To change the access rights for shared folders, go to the `/etc/fstab` file and change the settings for shared folders:

```
none /media/psf prl_fs default,share 0 0
```

With the "share 0 0" option set, each user of the virtual machine receives the same rights as the user who mounted the shared folders had. To set up a user or a group of users with certain rights, use the `uid` and `gid` options.
Configuring Network in Linux

When setting up network in Linux, you may need to configure the DHCP client to send the virtual machine's ID in DHCP requests. For information on how to configure your DHCP client, refer to the DHCP client documentation.

For example, in Red Hat Linux guest OSs, you need to edit the DHCP client configuration file.

1. Open the `dhclient.conf` file and make sure that the following lines are present.

```plaintext
interface "eth0" {
    send dhcp-client-identifier 1:<MAC address>;
}
```

2. If there are no such lines, add them manually to the file and save it.

When the `dhclient.conf` file contains these lines, DHCP client sends the virtual machine's ID to the DHCP server. The DHCP server sends an IP address in response.

Tip

To locate the `dhclient.conf` file, in a terminal, enter:

```
strings /sbin/dhclient | grep etc | grep dhclient.conf
```

or:

```
rpm -ql dhclient
```
Suspending a Boot Camp Virtual Machine

Be default, you cannot suspend your Boot Camp virtual machine. Booting the operating system of a suspended Boot Camp virtual machine natively (not through the Boot Camp virtual machine) will seriously damage the Boot Camp partition, making it unusable. As a result, all data on your Boot Camp partition may be lost.

If you still want to be able to suspend your Boot Camp virtual machine, do the following:

1. Open the virtual machine configuration (for example, by choosing Virtual Machine > Configure) and click CPU in the sidebar making sure that the Show advanced settings option is selected in the lower part of the window.

2. Type the following in the System Flags field:

   `disp.allow_to_suspend_bootcamp_vm=1`

3. Click OK to save the settings.

With this system flag in the virtual machine configuration, you will be able to suspend your Boot Camp virtual machine.

**Warning!** Be sure not to use your Windows Boot Camp partition natively when your Boot Camp virtual machine is suspended: this may damage the Boot Camp partition.

If you want to disable this option, modify the system flag as follows:

`disp.allow_to_suspend_bootcamp_vm=0`

---

Problems With Setting Up Network

After the creation of a Parallels virtual machine, you can connect it to the internet or set up the desired mode of the network. You can do that using the Virtual Machine Configuration dialog (p. 146). You can also refer to the Networking in a Virtual Machine section (p. 192) for more details.

However, if you meet difficulties with setting up the desired mode or just unable to access the Internet, you can refer to the Parallels support team http://www.parallels.com/en/support/desktop/ for a qualified assistance.
Problems With Antivirus Software

Because of the close integration with the host operating system, some actions performed by the Parallels Desktop processes may be detected as malicious by the antivirus software installed on your Mac.

However, such actions are necessary to ensure the proper functioning of Parallels Desktop. That is why you should prevent the antivirus software from blocking them. If you do not want the alerts to appear in future, perform a full system scan using the antivirus software and add these processes to the list of trusted ones if no viruses are detected. To find out how to do it, refer to your antivirus software Help.

**Note:** The names of Parallels Desktop processes usually start with `prl` or `parallels`. 
This glossary defines terms and spells out abbreviations used in Parallels Desktop documentation. References to terms defined elsewhere in the glossary appear in italics.

**Administrator.** A user with administration privileges.

**Activation key.** A unique set of symbols that activates the Parallels Desktop application on your Mac and lets you use the Parallels Desktop functionality to its full extent.

**Active operating system.** The operating system where Parallels Transporter Agent is launched.

**Active volume.** The volume of the physical source computer that is used as a boot volume for the active operating system.

**Bootable hard disk.** A disk used by the operating system to boot from, usually a disk that has an operating system installed.

**Boot Volume.** A hard disk partition from which the operating system boots.

**Boot Camp partition.** A partition on the hard disk of your Mac that can be used for installing a Windows operating system on it (for Mac host computers only).

**Bridged networking.** Virtual machine network connection mode that enables the virtual machine to appear as any other computer on the network, with its own IP address and network name.

**Configuration file.** A file specifies the virtual machine's hardware configuration, the devices it uses, and other settings. It is created automatically when you create a new virtual machine. See also *PVS file*.

**CPU.** Stands for central processing unit. It is an internal part of the computer. See also *Processor*.

**Disks in the old format.** Disks of virtual machines that were created in Parallels Desktop 2.5 and earlier or Parallels Workstation 2.2.

**Disks in the new format.** Disks of virtual machines that were created or used in Parallels hardware virtualization products starting from version 3.0.

**Expanding format.** A virtual hard disk format. An expanding virtual hard disk image file resides on your host computer and is small initially. Its size grows as you add applications and data to the virtual machine.

**FireWire connection.** A wired connection that enables a high-speed data transmission between computers.

**Guest operating system (guest OS).** An operating system installed inside your virtual machine.
Host computer: The computer that is used to run virtual machines. In case of Parallels Desktop, it is your Mac. In case of Parallels Desktop, it is the Windows or Linux physical computer where Parallels Desktop is installed. In the Parallels Transporter documentation, this term may define the computer that hosts the result of migration.

Hot key. A user-defined key or combination of keys that provides quick access to applications and commands. See also Shortcut.

HDD file. During the creation, the virtual machine acquires a virtual hard disk file with the .hdd extension. See also virtual hard disk file.

Host-only networking. Virtual machine network connection mode that creates a private network between the host computer and its virtual machines, which makes the virtual machines available from the host computer only.

ISO Image. A special file that contains the entire contents of a CD or DVD disc commonly used to install an operating system.

Image file. A single file containing the complete contents and structure of a data storage medium or device, such as a hard disk drive, CD, or DVD.

IP address. A unique address that is assigned to a physical computer or a virtual machine that participates in computer networking.

Linux computer. A physical computer that has a Linux operating system installed.

Merged disk. A split disk whose parts were merged into a single disk.

Migration. The process of transferring data from a physical computer or a third-party virtual machine into a Parallels virtual machine or virtual disk.

OS. An operating system.

Parallels Desktop. An application that enables you to create, manage, and use virtual machines on your Mac.

Parallels Explorer. An application that enables you to browse and manage the contents of your virtual machines without starting them.

Parallels Image Tool. An application that enables you to manage the capacity and properties of your virtual machine's hard disk.

Parallels Mounter. An application that enables you to browse the contents of your virtual machines and virtual hard disks directly in Mac OS X Finder.

Parallels Tools. A set of Parallels utilities that ensures a high level of integration between the primary and the guest operating systems.

Parallels Transporter. An application that uses data of a physical or virtual computer for creating a Parallels virtual clone of this physical or virtual computer. The resulting virtual machines can be used with Parallels Desktop.

Parallels Transporter Agent. An application that collects data on a physical computer and transfers it to Parallels Transporter installed on your Mac.
**Parallels Desktop.** An application that enables you to create, manage, and use virtual machines on a Windows or Linux computer.

**PCIe device.** A video or network adapter corresponding to the PCI Express computer expansion card standard introduced by Intel in 2004.

**Plain format.** A virtual hard disk format. A plain virtual hard disk image file resides on the host computer and has a fixed size that cannot be changed.

**Preboot Execution Environment (PXE).** An environment to boot computers using a network interface independently of available data storage devices (like hard disks) or installed operating systems.

**Primary operating system (primary OS).** Operating system that controls the I/O devices of the computer and that is loaded when the physical computer is turned on. It is the operating system of the physical computer where the Parallels Desktop application is installed.

**Processor.** The central processing unit, or CPU. It is an internal part of the computer.

**PVS file.** A virtual machine configuration file that contains information about the virtual machine resources, devices and other settings.

**Shared networking.** Virtual machine network connection mode that allows the virtual machine to use the host computer network connections. In this mode, the virtual machine is invisible to other computers on the network the host computer belongs to.

**Shortcut.** A user-defined key or combination of keys that provides quick access to applications and commands. See also Hot key.

**Snapshot.** A copy of the virtual machine state at a particular point of time. The files related to snapshots are stored in a special subfolder in the virtual machine's folder.

**Source computer or source operating system:** The computer that you are going to migrate data from. On physical source computers, Parallels Transporter Agent should be installed.

**System disk.** A floppy disk that allows your computer to load the operating system.

**Split disk.** A split disk is cut into 2 GB pieces, but is stored as a single HDD file. Split disks allow you to transfer the data stored on a split disk piece by piece using a USB drive or other media that have limited space and cannot store a large virtual hard disk image file.

**Terminal.** In Mac OS and GNU/Linux operating systems, a utility that enables you to access the command line.

**Virtual hard disk (virtual disk).** A file or group of files that emulates the virtual machine's hard disk.

**Virtual machine.** The computer emulated using Parallels Desktop. A virtual machine has its own virtual hardware and requires an operating system to control its hardware. The installed operating system and its applications are isolated inside the virtual machine and share physical hardware resources of the host computer.

**Third-party virtual machine.** A virtual machine created in a third-party virtualization product, that can be converted to Parallels virtual machines with the help of Parallels Transporter.
**Virtual Machine Configuration.** Like any physical computer, a *virtual machine* has its own configuration which is set during the creation and can be later modified. The virtual machine configuration settings are stored in a *PVS file*.

**Virtual machine files.** Files stored in a *virtual machine* folder. A virtual machine has at least two files: *configuration file* and *virtual hard disk file*.

**Virtual hard disk file.** During the creation, the *virtual machine* acquires a virtual hard disk file with the *.hdd* extension. This file performs the functions of a real hard disk. See also *HDD file*.

**Virtual machine template.** A virtual machine that can be cloned to multiple virtual machines that will have the same configuration and data that the virtual machine template had.

**VM.** See *Virtual Machine*.

**Windows computer.** A physical computer that has a Windows operating system installed.
Index

3
3D acceleration • 174

A
About Parallels Compressor • 251
About Parallels Desktop • 9, 39
About Parallels Explorer • 250
About Parallels Image Tool • 254
About Parallels Mounter • 250
About Parallels Transporter • 248
Activating Parallels Desktop • 20
Activation key • 20, 272
Active operating system • 272
Active volume • 272
Adaptive hypervisor • 153
Adding
CD/DVD-ROM drive • 204
existing virtual machine • 84
favorite applications • 34
floppy disk • 206
hardware devices • 197, 199
network adapter • 207
new virtual machine • 67
parallel port • 210
Parallels Desktop icon to the Dock • 30
serial port • 209
shared applications • 137
sound device • 211
USB controller • 213
virtual hard disk • 199
web applications • 140, 168
Adding existing virtual machine • 84
Address
IP address • 50
MAC address • 183, 207
MAC address in cloned virtual machine • 216
Adjusting reserved memory • 49
Administrator • 272
Administrator passwords • 74
Alias
for Parallels Desktop • 30
for virtual machines • 77, 79
Allocating resources • 153
Animation
animation speed • 47
on closing the window • 47
on snapshot actions • 47
on suspending and resuming • 47
on switching to Coherence • 47
on switching to full screen • 47
Appearance preferences • 47
Assistant
Add Hardware Assistant • 197, 198
Clone to Template Virtual Machine Assistant • 223
Clone Virtual Machine Assistant • 216
Delete Virtual Machine Assistant • 219
Deploy Virtual Machine Template Assistant • 225
New Virtual Machine Assistant • 67
Automatic snapshots • 166
Automatic update check • 26
B
Backing up virtual machines • 166, 227, 234
Bonjour
setting up a Bonjour printer • 120
Boot Camp partition
booting via Boot Camp • 247
booting via virtual machine • 245
creating virtual machine for • 243
customizing Boot Camp configuration • 242
GPT and MBR partitioning schemes • 242
using as bootable disk • 241, 245
using as data disk • 241
Boot sequence • 85, 149
Bootable hard disk • 272
Bridged Ethernet networking • 183, 192, 194, 272
Browsing virtual disks
in Finder • 144
in Parallels Explorer • 250
Browsing virtual machines • 250
Build number • 264
C
CD/DVD-ROM drive
adding • 204
removing • 214
setting up • 177
Changing
  administrator password • 74
  configuration at runtime • 126
  default folder for virtual machines • 42
  toolbar icons set • 36, 41
  view modes • 109
Changing Mac OS X resolution in the Dock • 47
Checking for updates • 25
Clipboard Synchronization Tool • 89
Cloning virtual machine • 216
Coherence mode
  animated transition • 47
  Coherence settings • 169
  multiple displays mode • 129
  SmartSelect • 129
  switching to Coherence mode • 109, 129
  using Mac OS X trash • 129
Compacting virtual hard disk • 257
Compacting virtual hard disks • 228
Compressing virtual hard disks • 251
Configuration file • 15, 272
Configuration of a virtual machine
  creating configuration • 15, 68
  editing configuration • 146
Connect USB devices automatically • 191
Connecting
  CD/DVD-ROM image • 177
  printer via parallel port • 62, 117
Converting to template • 222
CPU
  emulated in virtual machine • 15
  required on host computer • 17
Creating
  Boot Camp virtual machine • 240
  custom virtual machine • 79
  typical virtual machine • 77
  virtual hard disks • 180, 197
  virtual machine • 31, 34, 61
Custom Boot Camp configuration • 241
Custom virtual machine • 79
adding to virtual machine • 197
configuring virtual machine • 146
emulated in virtual machine • 15
removing from virtual machine • 197
DHCP scope • 50, 192
Disk format
  changing • 254
  checking • 182
Disk size • 251
  reducing • 251
Dock
  adding Parallels Desktop icon to • 30, 47
  using the Dock in Coherence mode • 129
Documentation feedback page • 13
Dragging files
  between OSs • 128
DVD-ROM drive
  adding • 204
  configuring • 177
  removing • 214
E
eComStation
  supported versions • 64
Editing virtual machine configuration • 146
Enabling 3D acceleration • 174
Expanding disks • 254
Explorer • 250
Exploring virtual machines • 250
Exposé
  using with Windows applications • 129
F
F8 key • 265
Favorite applications • 34, 39
FDD • 15, 176
Files
  HDD file • 15, 182, 272
  PVS file • 15, 272
  report with technical data • 263
  SAV file • 15, 107
  sharing files • 133
  snapshot files • 15
  virtual machine files • 15
Finishing compression • 253
Floppy disk drive
  setting up floppy disk • 176
Floppy disk image • 85
  creating blank floppy disk image • 176, 206
  using in virtual machine • 15, 182
Folder • 42, 77, 79

default folder for virtual machines • 42, 77
for cloned virtual machine • 216
for custom virtual machine • 79
sharing folder • 133, 158

FreeBSD
setting up network printer • 121
supported versions • 15

Full Screen mode
animating transition • 47
switching to Full Screen • 36, 43, 109

G
General preferences • 42
Getting info • 13
Getting support • 262, 263
Guest operating system • 9
Custom installation • 79
default installation • 70
definition • 272
installing Parallels Tools • 88
integrating guest and host OSs • 128
supported guest operating systems • 64
Typical installation • 77
Windows Express installation • 74

H
Hard disk
adding hard disk • 199
compacting hard disk • 254
compressing hard disk • 251
configuring hard disk • 180
formats and types • 15, 182
IDE and SCSI interfaces • 180
using Boot Camp as hard disk • 180
viewing hard disk content • 250

Hard disk image
creating new hard disk image • 199
expanding hard disk image • 182, 254
recreating virtual hard disk image • 180
types and formats of hard disk image • 182
using as virtual hard disk • 180

Hardware Assistant • 198
Hardware requirements • 17
HDD file • 15, 182, 272
Help menu • 13, 39
Hidden messages • 42
Host computer
definition • 272
hardware requirements • 17
software requirements • 17
Host-only networking • 195, 272
Hot keys • 43, 112, 272

IDE devices in virtual machine
CD/DVD-ROM • 177
hard disks • 180
Increasing hard disk capacity • 255
Installation modes
custom • 79
default • 70
express • 74
typical • 77

Installing
AC'97 sound driver • 92
guest operating system • 85
operating system • 67
Parallels Compressor • 251
Parallels Desktop • 18
Parallels Explorer • 250
Parallels Image Tool • 254
Parallels Tools • 88
Windows XP • 74

Intel Virtualization Technology (VT-x) • 14
Interface • 33
menubar • 39
status bar • 39
toolbar • 36, 41
virtual machines' list • 34
welcome window • 31

Internet access • 192
IP address • 50, 195

K
Key combinations • 43, 265
Keyboard and mouse
capturing and releasing • 108
F8 key in Windows guest OS • 265
keyboard preferences • 43
keyboard shortcuts • 43, 112
mouse preferences • 43

L
Linux
installing Parallels Tools • 89, 94
printing • 121
supported versions • 64
Local file sharing • 133

M
MAC address
generating address • 183
in cloned virtual machine • 216
in virtual machine • 183
Making screen shots • 116
Making snapshots • 166, 234
Managing hard disk properties • 257
Manual update check • 27
Memory
  in virtual machine • 15, 49, 173, 182
  limit for all virtual machines • 49
  required on host computer • 17
  video memory • 176
Memory allocation • 49
Memory settings • 173
Microphone USB
  connecting • 213
Migration • 248
Modality
  setting up • 171
Motherboard • 15
Mounting
  Windows disks on the Mac OS desktop • 133, 144
Mouse
  Right-click options • 43
  synchronization • 89
Mouse synchronization tool • 89
MS-DOS
  supported versions • 64
N
NAT • 192
Network adapter
  adding network adapter • 207
  networking in virtual machine • 192
  Parallels network adapter • 89, 183, 192
  setting up network adapter • 50, 183
Network driver
  Realtek driver • 50, 89
  network preferences • 50
Network printer • 121
Networking
  Bridged Ethernet • 183, 194, 207
  Host-only • 195
  Shared Networking (NAT) • 50, 183, 192
  WiFi • 196
New format of virtual disks • 24
O
Operating system
  installing in virtual machine • 67, 68, 85
  requirements to guest OSs • 64
  requirements to primary OSs • 17
P
Parallel port
  adding • 210
  configuring • 185
  removing • 214
Parallels Compressor • 251
  automatic mode • 252, 253
  cancelling Parallels Compressor • 253
  manual mode • 252, 253
  running Parallels Compressor • 253
  supported guest OSs • 252
Parallels Desktop
  activating • 20
  installing • 18
  menus • 39
  preferences • 41
  registering • 22
  starting • 30
  toolbar • 36, 41
  uninstalling • 28
  updating • 25
  upgrading to 4 version • 24
Parallels Desktop Preferences • 41, 107
  Appearance preferences • 47
  General preferences • 42
  keyboard and mouse preferences • 43
  memory preferences • 49
  network preferences • 50
  speech preferences • 55
  USB preferences • 53
Parallels download center • 18
Parallels Explorer • 250
Parallels Image Tool
  increasing hard disk capacity • 255
  managing hard disk properties • 257
Parallels network adapter • 89, 183, 192
Parallels Tools
  installing in Linux • 94
  installing in Mac OS X • 97
  installing in Windows • 92
  overview • 89
  uninstalling • 102
  updating • 100
  upgrading • 24
Parallels virtual appliances • 34
Partition
  Boot Camp partition • 240
Passwords • 74
Pausing virtual machines • 107
Permanent activation key • 20
Plain disks • 182
Port forwarding • 50, 192
Preferences • 41
Primary operating system
Index 280

definition • 272

Printer
   setting up a Bonjour printer • 120
   setting up a network printer • 228
   setting up a printer in virtual machine • 117
   setting up a printer via parallel port • 118
   setting up USB printer • 119
   sharing Mac printer • 118

Printing
   printing • 121
   printing in FreeBSD • 121
   printing in Windows • 121
   printing with Bonjour • 120

Processor
   emulated in virtual machine • 15
   required on host computer • 17

PVS file • 15

Q

Quick install of Windows Vista/XP • 70, 74

R

RAM
   allocation for Parallels Desktop • 49
   in virtual machine • 15, 173
   limit for all virtual machines • 49
   RAM settings for virtual machines • 173
   required on host computer • 17

Reducing disk size • 251

Reducing virtual disk size • 260

Registering Parallels Desktop • 22

Releasing keyboard and mouse • 108

Remapping keys • 43

Removing
   devices • 214
   icons from toolbar • 41
   Parallels Compressor • 102
   Parallels Desktop • 28
   Parallels tools • 102
   snapshots • 236
   virtual machine • 219
   virtual machine from list • 218

Reporting problems • 262, 263

Requirements
   system • 17

Reseting virtual machines • 105

Resolution changing tool • 89

Resuming hidden messages • 42

Resuming virtual machines • 105

Right-click options • 43

Running

Parallels Compressor automatically • 251
virtual machines • 104

S

SAV file • 15, 107

Screen animation • 47

Screen shots
   for problem reports • 263
   of guest operating system screen • 116

SCSI devices • 15

Searching Parallels disks • 144, 145, 250

Security settings • 155

SELinux • 268

Serial port
   adding • 209
   configuring • 187

Setting preferences • 41

Setting up a printer • 117

Shared Folders
   mounting in Linux guest OS • 268
   setting up shared folders • 158
   using shared folders • 133

Shared folders tool • 89, 268

Shared networking (NAT) • 192, 272

Shared web applications • 140, 168

Sharing
   files and folders • 133
   Windows disks to Mac OS • 133, 144

Shortcuts
   in virtual machine • 112

Show applications in the Dock • 47

SmartGuard • 166

SmartMount • 165

SmartSelect • 129, 141, 163

Snapshot Manager • 236

Snapshots
   deleting • 236
   making • 235
   managing • 236
   merging • 236
   reverting to the last • 236
   snapshot icons in toolbar • 36, 41
   working with • 234

Socket • 187, 209

Software license agreement • 18

Software requirements • 17

Sound driver • 89

Sound options • 189

Split disks • 15, 254

Spotlight support • 145

Starting
   migration • 248
   Parallels Desktop • 30

Startup mode • 151
Index 281

Status bar
  connecting and disconnecting devices • 39, 126
  usage • 36, 39
Stopping virtual machine • 105
Sun Solaris
  supported versions • 64
Support • 262
Supported file formats and systems • 182
Supported guest operating systems • 64
Suspending virtual machine • 107
Switching between view modes • 109
Synchronizing
  Palm OS device with guest OS • 113
System requirements • 17
T
  Technical support • 262, 263
  Time synchronization between OSs • 89
Toolbar • 36
  changing the icon set • 36, 41
Transporter • 248
Trial activation key • 20
Troubleshooting • 262
Turning off virtual machine • 105
Typical virtual machines
  creating typical virtual machine • 77
U
  Update check • 25
  Updating Parallels Desktop • 25
    automatically • 26
    manually • 27
  Updating Parallels Tools • 100
  Upgrade activation key • 24
  Upgrading Parallels Tools • 24
URL handling • 168
USB
  adding USB controller • 213
  configuring USB • 191
  connecting USB devices • 123
  setting up USB printer • 119
  using USB devices in virtual machine • 123
User registration form • 20
V
  Video driver, Parallels Tools • 89
  Video memory • 173
  Virtual hard disk
    backing up data • 234
    browsing in Mac OS • 144
    configuring • 180
    creating new virtual hard disk • 180, 199
    disk formats • 15
    expanding virtual hard disk • 15
    HDD file • 15, 272
IDE and SCSI interfaces • 180
    increasing capacity • 255
    managing properties • 257
    mounting in Finder • 133
    reducing virtual hard disk size • 260
    split hard disk • 182
    using Boot Camp • 240
  Virtual machine
    adding new devices • 197
    backing up • 227
    booting from Boot Camp • 247
    changing default folder • 42
    cloning • 216
    creating • 61
    deleting • 219
    exploring • 250
    main window • 36
    making snapshots • 234
    name • 77, 79, 147
    networking • 192
    opening • 34
    pausing • 107
    resetting • 105
    resuming • 105
    saving state • 234
    shutting down • 105
    starting • 105
    suspending • 107
    using USB devices • 123, 191
    virtual machine files • 15
  Virtual machine configuration • 146, 197
  Virtual machine technology overview • 14
  VirtualPC virtual machine
    migrating data from • 87, 248
    using in Parallels Desktop • 84
  VMware virtual machine
    migrating data from • 87, 248
    using in Parallels Desktop • 84
W
  Web applications • 140
  Welcome screen • 31
  WiFi • 196
  Window view mode • 109
  Windows
Express installation • 74
printing in Windows • 121
supported versions • 64
Windows applications
  Parallels Tools • 89, 92
  Windows applications folder • 15
Windows disks folder • 15
Windows Vista
  creating virtual machine in Boot Camp • 243
  Express installation • 74
Windows XP
  creating virtual machine in Boot Camp • 243
  Express installation • 74
  using from Boot Camp • 240